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1 Preface 

This Preface provides supporting information for the Oracle Financial Services Market Risk 
Measurement and Management Pack Installation Guide and includes the following topics: 

• Scope of the guide 

• Intended Audience 

• Documentation Accessibility 

• Access to Oracle Support 

• Related Information Sources 

1.1 Summary 

You can find the latest copy of this document in OHC Documentation Library which includes all the 
recent additions/revisions (if any) done till date. 

Before you begin the installation, ensure that you have an access to the Oracle Support Portal with the 
required login credentials to quickly notify us of any issues at any stage. You can obtain the login 
credentials by contacting Oracle Support. 

1.2 Intended Audience 

The Oracle Financial Services Market Risk Measurement and Management Pack Installation Guide is 
intended for Administrators, Business User, Strategists, and Data Analyst, who are responsible for 
installing and maintaining the application pack components.  

Prerequisites for the Audience 

The document assumes that you have experience in installing Enterprise components, and knowledge 
about the following is recommended: 

• Oracle Financial Services Market Risk Measurement and Management Pack components 

• OFSAA Architecture 

• UNIX Commands 

• Database Concepts 

• Web Server/ Web Application Server 

1.3 Documentation Accessibility 

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program 
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc. 

1.3.1 Access to Oracle Support 

Oracle customers have access to electronic support through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info 

https://docs.oracle.com/cd/E99053_01/install.htm
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
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 Or, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs  if you are hearing impaired. 

1.4 Related Information Sources 

This section identifies documents related to OFS MRMM application. You can access Oracle 
documentation online from OHC Documentation Library. 

• Oracle Financial Services Market Risk Measurement and Management User Guide, Release 
8.0.8 

• Oracle Financial Services Market Risk Measurement and Management Release Notes, Release 
8.0.8  

• Oracle Financial Services Analytical Applications Infrastructure Environment Check Utility Guide 
(OHC Documentation library) 

You can access the OFS AAI documentation online from the documentation library for OFS AAAI 8.x: 

• OFS Advanced Analytical Applications Infrastructure (OFS AAAI) Application Pack Installation 
and Configuration Guide  

• OFS Analytical Applications Infrastructure User Guide  

The additional documents are: 

• OFSAA Licensing User Manual, Release 8.0.8.0.0 

• OFS Analytical Applications Infrastructure Security Guide 

• OFSAAI FAQ Document 

• OFS Analytical Applications 8.0.8.0.0 Technology Matrix 

• Oracle Financial Services Data Foundation Technical Documents (MoS Doc ID: 2170313.1). 
Refer the relevant version of the metadata sheet available in the MoS document (For CAS refer 
T2T Metadata Staging, and for SCD components refer SCD Metadata sheet). 

1.5 Conventions and Acronyms 
 

Conventions Description 

AIX Advanced Interactive executive 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
https://docs.oracle.com/cd/E60529_01/mrmmhome.htm
http://docs.oracle.com/cd/E60058_01/install.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E61555_01/licensing.htm
http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAAI%20FAQs/WebHelp/OFSAA_FAQs.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=459063306750782&parent=AWIZ_SUBMIT&id=2170313.1
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Conventions Description 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

JVM Java Virtual Machine 

LDAP Lightweight Directory Access Protocol 

LHS Left Hand Side 

MFA Multi-Factor Authentication 

MOS My Oracle Support 

OFS Oracle Financial Services 

OFSAAI Oracle Financial Services Analytical Application Infrastructure OLAP 

OS Operating System 

OFS MRMM Oracle Financial Services Market Risk Measurement and Management 

RAM Random Access Memory 

RDMS Relational Database Management System 

SFTP Secure File Transfer Protocol 

SID System Identifier 

SSL Secure Sockets Layer 

TDE Transparent Data Encryption 

TNS Transparent Network Substrate 

URL Uniform Resource Locator 

VM Virtual Machine 

Web Archive WAR 

XML Extensible Markup Language 
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2 About OFSAA and OFSAA Application Packs 

This chapter includes the following topics: 

• About Oracle Financial Services Analytical Applications (OFSAA) 

• About Oracle Financial Services Analytical Applications (OFSAA) Applications Pack 

• About Oracle Financial Services Market risk measurement and Management 8.0.8.0.0 
Applications Pack 

• About OFSAA Infrastructure 

2.1 About Oracle Financial Services Analytical Applications 
(OFSAA) 

In today's turbulent markets, financial institutions require a better understanding of their risk-return, 
while strengthening competitive advantage and enhancing long-term customer value. Oracle Financial 
Services Analytical Applications (OFSAA) enable financial institutions to measure and meet risk 
adjusted performance objectives, cultivate a risk management culture through transparency, lower the 
costs of compliance and regulation, and improve insight into customer behavior. 

OFSAA uses industry-leading analytical methods, shared data model and applications architecture to 
enable integrated risk management, performance management, customer insight, and compliance 
management. OFSAA actively incorporates risk into decision making, enables to achieve a consistent 
view of performance, promote a transparent risk management culture, and provide pervasive 
intelligence. 

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of financial 
services analytical applications for both banking and insurance domain.  

2.2 About Oracle Financial Services Analytical Applications 
(OFSAA) Applications Pack 

The following figure depicts the various application packs that are available across the OFSAA Banking 
and Insurance domains: 
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2.3 About Oracle Financial Services Market Risk Measurement 
and Management Application Pack 

Oracle Financial Services Market Risk Measurement and Management: This application delivers 
extensive and robust computations, to enable financial institutions to effectively evaluate and manage 
market risk across the enterprise. OFS MRMM enables financial institutions to accurately measure, 
evaluate, monitor and manage market risk. Additionally, it enables financial institutions to proactively 
comply with the regulatory requirements of capital calculation as per the Internal Models Approach 
(IMA), and the latest market risk capital regulations such as Fundamental Review of Trading Book 
(FRTB). The application comes with pre-built reports and dashboards using OBIEE tool which enables 
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financial institutions to monitor and track risk. It works as starter kit which can be utilized by users to 
further develop their own analytics. 

2.4 About OFSAA Infrastructure 

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial 
Services Analytical Applications family of products to perform the processing, categorizing, selection 
and manipulation of data and information needed to analyze, understand and report on specific 
performance, risk, compliance and customer insight issues by providing a strong foundation for the 
entire family of Oracle Financial Services Analytical Applications across the domains of Risk, 
Performance, Compliance and Customer Insight. 

2.4.1 Components of OFSAAI 

The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the Oracle 
Financial Services Analytical Applications Data Model and form the array of components within the 
Infrastructure. 

The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the metadata 
server and Infrastructure services run on one layer, and the UI and presentation logic runs on the other. 
The UI and presentation layer is deployed on any of the supported J2EE Servers. 

The following figure depicts the various frameworks and capabilities that make up the OFSAA 
Infrastructure: 
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2.4.2 OFSAA Infrastructure High Availability 

The current release of the OFSAA Infrastructure supports only "Single Instance" installation for the 
Infrastructure components. However, the High Availability (HA) for the Database Server and/ or the Web 
Application Server clustering and deployment are supported in this release. 

This release supports Active-Passive model of implementation for OFSAAI components. For more 
information, refer Configuration for High Availability- Best Practices Guide. 

2.5 About Data Security Configurations 

Data Security refers to the protection of data against unauthorized access and data theft. OFSAA 
ensures Data Security with the following features: 

• Multi-Factor Authentication 

• Data Redaction 

• Key Management 

• HTTPS 

• Logging 

See the relevant topics in this guide, and the Data Security and Data Privacy section in the 
Administration and Configuration Guide, for more details on the features in the previous list. 

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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3 Understanding OFS Market Risk Measurement and 
Management Pack Installation 

This chapter includes the following topics: 

• Installation Overview 

• Deployment Topology 

• Hardware and Software Requirements 

• Verifying the System Environment 

• Understanding Installation Modes 

3.1 Installation Overview 

Users/ Administrators who wish to install a new OFS MRMM Application Pack 8.0.8.0.0 instance should 
download this installer. The below figure shows the order of procedures you will need to follow to install 
a new OFS MRMM Pack 8.0.8.0.0 instance.  

. 
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OFS MRMM Application Pack Installation Tasks and Descriptions 

 

Tasks Details and Documentation 

Verify Systems Environment To verify that your system meets the minimum necessary 
requirements for installing and hosting the OFS MRMM Application 
Pack, see Verifying the System Environment 

Obtain the software To access and download the OFS MRMM Application Pack, see 
Obtaining the Software 

Configure and Execute the 
Schema Creator Utility 

For instructions on creating the database schemas, see Configuring 
and Executing the Schema Creator Utility. 

Install OFS MRMM Application 
Pack 

For instructions on Installing OFS MRMM Application Pack see  
Installing OFS MRMM Application Pack 

Configure MRMM Setup See Post Installation Configuration and Post Deployment 
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3.2 Deployment Topology 

The deployment architecture depicts the mapping of a logical architecture to a physical environment. 
The physical environment includes the computing nodes in an intranet or Internet environment, CPUs, 
memory, storage devices, and other hardware and network devices.  

 

 

3.3 Hardware and Software Requirements 

This section describes the various Operating Systems, Database, Web Server, and Web Application 
Server versions, and other variant details on which this release of the OFS MRMM Application Pack has 
been qualified.  

 

NOTE OFS MRMM Application Pack installation can be performed on 

both Virtual and Physical servers. 

 

3.3.1 Configurations supported for Java 8 
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NOTE See Technology Matrix Release 8.0.8.0.0 for details. 

 

Requirement Sub-Category Value 

Operating 
System 
 

Oracle Linux / Red Hat Enterprise Linux 
(x86-64) 

Red Hat Enterprise Linux or Oracle Linux 
Server release 6 update 6 and above 

Red Hat Enterprise Linux or Oracle Linux 
Server release 7 update 1 and above 

Note: Same versions of RHEL is supported 

Shell KORN Shell (KSH) 

Note:  

If the operating system is RHEL, install the package lsb_release using one of the following commands by 
logging in as root user: 

yum install redhat-lsb-core 

yum install redhat-lsb 

Java Runtime 
Environment 

Oracle Linux / Red Hat Enterprise Linux Oracle Java Runtime Environment (JRE) 
1.8.x - 64 bit 

Oracle 
Database 
Server and 
Client 

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0 +) - 64 bit 
RAC/ Non-RAC with/ without partitioning option 

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit 
RAC/Non-RAC with/ without partitioning option, Advanced Security Option**. 

• Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1.0 +) - 64 bit 
RAC/ Non-RAC with/ without partitioning option, Advanced Security Option** 

**Note: See the “Additional Notes” section in the 808 Tech Matrix for details. 

• Oracle Database Server 12c Release 2 (12.2.0.1+) Enterprise Edition  with Oracle 
Database client 12c Release 1 (v12.1.0.1+) 

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit 

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit 

• Oracle Client 12c Release 2 (12.2.0.1.0+) - 64 bit 

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver) 

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver) 

• Oracle 12C Release 2 (12.2.0.1+) JDBC driver (Oracle thin driver) 

http://docs.oracle.com/cd/E55339_01/homepage.htm
https://docs.oracle.com/cd/E55339_01/homepage.htm
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Requirement Sub-Category Value 

Note:  

Ensure that the following patches are applied: 

• Oracle Server 12c, v12.1.0.1 – 17082699 

• Oracle Server 12c, v12.1.0.2 – 20698050 

For Oracle DB Server 12.1.0.1 and 12.1.0.2, download the patches 27010930 and 22205607 from My 
Oracle Support and apply them.  

For Oracle DB Server 11.2.0.4, download the patch 22205607 from My Oracle Support and apply. 

Also for latest information, refer http://support.oracle.com/, 12.1.0.2 Bundle Patches for Engineered 
Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1) 

Note: 

Oracle Hyperion Essbase is required only if you are using the OLAP feature of OFSAAI. 

Web Server/ 
Web 
Application 
Server 
 

Oracle Linux / Red Hat Enterprise Linux • Oracle HTTP Server 11.1.1.7.1+  or 
11.1.1.9.+/ Apache HTTP Server 
2.2.x/ IBM HTTP Server 8.5.5 

• IBM WebSphere Application Server 
8.5.5.9+ (Full Profile) with IBM Java 
Runtime - 64 bit 

• Oracle WebLogic Server 12.2+ with 
jersey 1.18 (64 bit)/ Oracle WebLogic 
Server 12.2.x with jersey 2.25 (64 bit) 

• Apache Tomcat 8.0.25+ (64 bit) 

Note: 

OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle 
JRockit is not supported. 

For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and 
install patch 18729264 from http://support.oracle.com/. 

Desktop 
Requirements 

Operating System MS Windows 7/ Windows 8/ Windows 10 

Browser MS Internet Explorer11.x, Google Chrome 
57.x, Mozilla Firefox 52.x 

Turn on Pop-up blocker settings. For more 
information, refer Internet Explorer Settings. 

Office Tools MS Office 2007/ 2010/2013/2016 

Adobe Acrobat Reader 10 and 11 

Screen Resolution 1024*768 or 1280*1024 

http://support.oracle.com/
http://support.oracle.com/
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Requirement Sub-Category Value 

Other 
Software 

Directory Services OFSAAI is qualified on both OPEN LDAP 
2.2.29+ and Oracle Internet Directory v 
11.1.1.3.0. However, it can be integrated 
with other directory services software like 
MS Active Directory. 

Note: 

Configuration of Directory services software for OFSAAI installation is optional. For more 
information on configuration, see Infrastructure LDAP Configuration. 

Open LDAP needs to be installed on MS Windows Server machine only. 

 

 

NOTE To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, 

refer Appendix P. 

To configure the Oracle Database 19c Server and Client on a 

new installation, see MOS Doc ID: 2691006.1. 

 

 

OFS MRMM application pack recommends the following software combinations for deployment. 

 

Operating System Database 

Web Application 

Server Web Server 

Oracle Linux  6.0 and 
above  

Oracle Database  Oracle WebLogic 
Server /Apache Tomcat 
Server 

Oracle HTTP Server/ 
Apache HTTP Server 

 

3.4 Verifying the System Environment 

To verify if your system environment meets the minimum requirements for the installation, a Pre-Install 
Check utility (Environment Check) is available within the Install Kit archive file. This utility can also be 
obtained separately by contacting Oracle Support. 

Though the system environment verification is an integral and automated part of the installation of this 
software product, Oracle strongly recommends running this utility prior to beginning the installation as 
part of your organization’s "Installation Readiness Verification Process". 

 

NOTE For more details on download and usage of this utility, see 

Oracle Financial Services Analytical Applications Infrastructure 

Environment Check Utility Guide. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2691006.1
https://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAA_envCheck_Utility_Guide_8.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.0.x/8.0.0.0.0/OFSAA_envCheck_Utility_Guide_8.0.pdf
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3.5 Understanding Installation Modes 

OFS MRMM Application Pack supports Silent Mode installation. 

3.5.1 SILENT Mode 

This mode mandates updating the installation configuration files with required details and performs 
installation in a “SILENT” non user interactive format. 
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4 Preparing for Installation 

This chapter provides necessary information to review before installing the OFS MRMM Pack 8.0.8.0.0. 
This chapter includes the following topics: 

• Installer and Installation Prerequisites 

• Obtaining the Software 

• Common Installation Tasks 

4.1 Installer and Installation Prerequisites 
 

NOTE When merging lower version of an application with integrated 

data model, retain the larger size of column length. 

 

Connect to the database as user with DBA privileges. Execute the following grant statement: 

GRANT CREATE TYPE TO [<ATOMIC SCHEMA>]; 

 

NOTE This grant should be executed for all existing Atomic Schemas. 

 

The following table mentions the list of prerequisites required before beginning the installation for OFS 
MRMM application pack. The Installer/ Environment Check utility notifies you if any requirements are not 
met.  

NOTE OFS MRMM Release v8.0.8.0.0 is compatible with WebLogic 

12.2.x and does not support WebLogic 12.1.3. If the WebLogic 

version is 12.1.3, upgrade to WebLogic 12.2.x. 
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Installer and Installation Prerequisites 

 

Requirement Sub-Category Expected Value 

Environment 
Settings 

Java Settings PATH in .profile to be set to include the Java Runtime 
Environment absolute path. The path should include java 
version (java 7 or java 8) based on the configuration. 

Note: Ensure the absolute path to JRE/bin is set at the 
beginning of PATH variable. 

For example, 
PATH=/usr/java/jre1.8/bin:$ORACLE_HOME/bin:$PATH 

Ensure no SYMBOLIC links to JAVA installation is being 
set in the PATH variable. 

Enable unlimited 
cryptographic policy 
for Java 

For more information, see the section Enabling Unlimited 
Cryptographic Policy from the OFS Analytical Applications 
Infrastructure Administration Guide. 

Oracle Database 
Settings 

TNS_ADMIN must be set in .profile pointing to appropriate 
tnsnames.ora file 

Enable Data Redaction** 

** Note: For more information, see Appendix R: Enabling 
Data Redaction and the Corresponding Settings in 
OFSAA. 

OFSAA Processing Server 

ORACLE_HOME must be set in .profile file pointing to 
appropriate Oracle DB Client installation. 

PATH in .profile must be set to include appropriate 
$ORACLE_HOME/bin path.  

Ensure that an entry (with SID/ SERVICE NAME) is added 
in the tnsnames.ora file. 

Oracle Essbase 
Settings 

ARBORPATH, ESSBASEPATH, HYPERION_HOME to be 
set in the .profile pointing to an appropriate Oracle 
Essbase Client installation. 

Note: These settings are required only if you want to use 
Oracle Hyperion Essbase OLAP features. 

OS/ File System 
Settings 

 

File Descriptor 
Settings 

Greater than 15000 

Note: 

The value specified here is the minimum value to be set 
for the Installation process to go forward. For other 
modules, this value may depend on the available 
resources and the number of processes executed in 
parallel. 

Total Number of 
Process Settings 

Greater than 4096 

Note: 

The value specified here is the minimum value to be set 
for the Installation process to go forward. For other 
modules, this value may depend on the available 
resources and the number of processes executed in 
parallel. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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Requirement Sub-Category Expected Value 

Port Settings Default port numbers to be enabled on the system are 
6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, and 
10101. 

.profile permissions User to have 755 permission on the .profile file. 

Installation Directory  A directory where the product files will be installed. 

Set 755 permission on this directory.  

This directory needs to be set as FIC_HOME. 

Temporary Directory Default temporary directory where installation files are 
stored for a short period of time to support faster 
installation. 

• For installation on UNIX OS, your UNIX 
administrator must give you the required read-write 
permissions for the /tmp directory and disable the 
NOEXEC option 

• Configure adequate space on the /tmp directory. It 
is recommended that you allocate more than 10 GB 
of space. 

Note: If NOEXEC is enabled, the extraction of files by the 
installer into the /tmp directory is prevented and the 
binaries will not execute in the directory, which will fail the 
installation. 

Staging Area/ 
Metadata 
Repository  

A directory to hold the application metadata artifacts and 
additionally act as staging area for flat files.  

The directory should exist on the same system as the 
OFSAA Installation. This directory can be configured on a 
different mount or under a different user profile. However, 
the owner of the installation directory that is mentioned in 
the previous row, must have RWX permissions on this 
folder. 

Set 777 permission on this directory. 

Note: This directory is also referred to as FTPSHARE 
folder. 

Download Directory A directory where the product installer files will be 
downloaded/ copied. 

Set 755 permission on this directory. 

OS Locale Linux: en_US.UTF-8 

To check the locale installed, execute the following 
command: 

locale -a | grep -i 'en_US.utf' 

Database Settings 

 

Database Instance 
Settings 

NLS_CHARACTERSET to be AL32UTF8 

NLS_LENGTH_SEMANTICS to be BYTE 

OPEN CURSORS limit to be greater than 1000 
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Requirement Sub-Category Expected Value 

Web Application 
Server 

WebSphere/ 
WebLogic/  
Tomcat 

Web Application Server should be installed and profile 
/domain created. 

You will be prompted to enter the WebSphere Profile path 
or WebLogic Domain path or Tomcat Deployment path 
during OFSAAI installation. 

Note:  

Refer Appendix A for WebSphere Profile Creation and 
WebLogic Domain Creation. 

For deployment on Oracle WebLogic Server 12.1.3+ (64 
bit) with Java 8, download and install patch 18729264 from 
https://support.oracle.com. 

Web Server Apache HTTP 
Server/  
Oracle HTTP 
Server/ 
IBM HTTP Server 

This is an optional requirement. 
HTTP Server Installation to be present.  
You will be required to enter the Web Server IP/ Hostname 
and Port details during installation. 

Note: Refer Appendix A for Web Server installation. 

Patches Mandatory Download the mandatory patch 29887635 from 
support.oracle.com. Refer to the Readme available with 
the patch for further instructions on installing the patch. 

Patches Mandatory Download the mandatory patch 29952285 from 
support.oracle.com. Refer to the Readme available with 
the patch for further instructions on installing the patch. 

Patches Mandatory Download the mandatory OFSAAI patch 30273976 from 
My Oracle Support. 

Patches Mandatory Download the mandatory OFS MRMM patch 31563226 
from My Oracle Support. 

 

NOTE In an environment consisting of multiple OFSAA applications, if 

the October 2020 Critical Patch Update is applied for any one 

application, it is mandatory to apply the respective October 2020 

Critical Patch Updates for all other applications on that OFSAA 

instance, regardless of the application’s version. See the My 

Oracle Support Doc ID 2724021.1 for details. 

 

Following step is applicable only if existing OFSAA setup version is 8.0.5.x.x and Configuration and 
Atomic Schema(s) were restored from exported dumps of other environment:  

Login to Configuration Schema and execute the following SQL statements:  

alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint 

AOM_APP_COMP_ATTR_PK drop index  

/ 

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint 

AOM_APP_COMP_ATTR_PK primary key (APP_COMP_ATTR_MAP_ID)  

/ 

 

https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=439104271525723&_afrWindowMode=0&_adf.ctrl-state=cbhuq6m2p_9
file:///C:/Users/vinemish/AppData/Roaming/Microsoft/Word/support.oracle.com
file:///C:/Users/vinemish/AppData/Roaming/Microsoft/Word/support.oracle.com
support.oracle.com
support.oracle.com
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2724021.1
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NOTE Ensure that the tablespace(s) used for the database user(s) is 

set to AUTOEXTEND ON. 

 

4.2 Obtaining the Software 

This release of OFS MRMM Application v8.0.8.0.0 can be downloaded from My Oracle Support 
(https://support.oracle.com). You need to have a valid Oracle account in order to download the 
software. 

4.3 Performing Common Pre - Installation Tasks 

The common pre-installation activities that you must carry out before installing the OFS MRMM 
Application Pack are. 

• Identifying the Installation, Download and Metadata Repository Directories 

• Download and copy the OFS MRMM Application Pack Installer  

• Copying and Extracting the Software 

• Setting up the Web Server/ Web Application Server 

4.3.1 Identifying the Installation, Download and Metadata Repository 
Directories 

For installation of any OFSAA application pack, the below folders/ directories required to be created. 

• OFSAA Download Directory (Optional) - Create a download directory and copy the OFSAA 
Application Pack Installer File (Archive). This is the directory where the downloaded installer/ 
patches can be copied. 

• OFSAA Installation Directory (Mandatory) – Create an installation directory where the product 
binaries will be installed. Set the variable FIC_HOME in the .profile file to point to the OFSAA 
Installation Directory. 

• OFSAA Staging/ Metadata Repository Directory (Mandatory) – Create a Staging/Metadata 
Repository Directory to copy data files, save data extracts, and so on. Additionally, this directory 
also maintains the OFSAA metadata artifacts. This directory is also referred to as "FTPSHARE". 
This directory must be created on the same host as the OFSAA Installation Directory mentioned 
in the previous point in this list. 

 

NOTE • Assign 755 user permission to the Installation and 

Download Directory. 

• Assign 775 user permission to the Staging Directory. 

• Ensure the OFSAA staging directory is not set to the 

same path as the OFSAA installation directory and is 

not a sub-folder inside the OFSAA installation directory. 

 

https://support.oracle.com/
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4.3.2 Download and copy the OFS MRMM Application Pack Installer 

To download and copy the OFS MRMM Pack Installer, follow these steps: 

• To download the OFS MRMM Applications Pack (Bug Number: 30099203), log in to My Oracle 
Support (https://support.oracle.com) with a valid Oracle account. 

• Copy the downloaded installer archive to the Download Directory (in Binary mode) on the setup 
identified for OFS MRMM installation. 

• You can download the ERWIN data model patch from the bug number 30099075  

4.3.3 Copying and Extracting the Software 

1. Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the 
OFSAA Infrastructure components will be installed. 

 

NOTE You must be logged in to the UNIX operating system as a non-

root user. 

 

1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to the directory 
that is included in your PATH variable. If you already have the unzip utility to extract the contents 
of the downloaded archive, skip to the next step. 

2. Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

 

NOTE In case you notice an error message "uncompress: not 

found [No such file or directory]" when the 

package is not installed, contact your UNIX administrator. 

 

3. Give EXECUTE permission to the file using the command: 

chmod 751 unzip_<os> 

For example, chmod 751 unzip_sparc 

4. Extract the contents of the Oracle Financial Services Market Risk Measurement and 
Management Application Pack 8.0.8.0.0 to Download Directory installer archive file using the 
following command: 

unzip OFS_MRMM_8.0.8.0.0_LINUX.zip 

5. Copy the file ctrlRemove.sh to the installer folder in Text mode. Provide execute privileges and 
execute the file to remove the ^M characters. 

6. Give below permission to the installer folder. Navigate to the Download Directory and execute the 
command:  

chmod –R 755 OFS_MRMM_PACK 

https://support.oracle.com/
https://docs.oracle.com/cd/E92094_01/embedded/ctrlRemove.sh
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4.3.4 Setting up the Web Application Server 

For setting up the environment based on your selected Web Application Server. See Appendix A for 
more information. 
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5 Installing OFS Market Risk Measurement and 
Management Application Pack 

This chapter provides instructions to install the OFS MRMM pack. It includes: 

• Schema creator utility 

• Configuring and Executing the Schema Creator Utility 

• Installing the OFS MRMM Application Pack 

5.1 Schema creator utility 

Creating database users/schemas is one of the primary steps in the complete OFS MRMM installation 
process. Schema Creator utility facilitates you to quickly get started with the installation by creating 
Database User(s)/ Schema(s), assigning the necessary GRANT(s), creating the required entities in 
these schemas and so on.  

 

NOTE The Schema creator job needs to be run first, if you are doing 

MRMM fresh installation in a different infodom. It will append the 

new artifacts in the existing instance. 

 

The schema creator utility should be configured and executed mandatorily prior to installation of OFS 
MRMM application pack. 

This section includes the following topics: 

• About Schema Creator utility 

• Execution Modes in Schema Creator Utility 

• Execution Options in Schema Creator Utility 

5.1.1 About Schema Creator utility 

The schema creator utility should be configured and executed mandatorily every time prior to installation 
of any OFSAA Application Pack. 

The following are the types of schemas that can be configured in the OFSAA: 

• CONFIG – Denotes the unique OFSAA setup configuration schema. It contains entities and other 
objects required for OFSAA setup information.  

 

NOTE There can be only one CONFIG schema per OFSAA instance. 

 

• ATOMIC – Denotes the schema that contains the data model entities. One ATOMIC schema is 
attached to one Information Domain. 
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NOTE There can be multiple ATOMIC schemas per OFSAA instance. 

 

5.1.2 Selecting Execution Modes in Schema Creator Utility 

The Schema Configuration Utility supports the following modes of execution: 

• Online Mode: In the Online mode, the utility connects to the database and executes the DDLs for 
Users, Objects and Grants. If you have the SYSDBA privileges you can execute the Schema 
Creator Utility in Online mode and thereby create the Users, Objects and Grants during the 
execution process. 

 

NOTE To execute the utility in Online mode, you need to connect as 

“<User> AS SYSDBA”. 

 

• Offline Mode:  In the Offline mode, the utility generates SQL script with all the required DDLs for 
Users, Objects and Grants. This script needs to be executed by the DBA on the appropriate 
database identified for OFSAA usage. If you do not have the SYSDBA privileges, you can 
execute the Schema Creator Utility in Offline mode and generate the script file that contains the 
Schemas, Objects and Grants, information. Subsequently, a SYSDBA user can execute the script 
file manually.  

 

NOTE 1. Connect as any database user. 

2. Reconfigure the OFS_MRMM_SCHEMA_IN.xml file and 

execute the utility. For more information on reconfiguring 

these files, see Configuring 

OFS_MRMM_SCHEMA_IN.XML file. To execute the utility 

in Offline mode, you need to connect as any user with 

below grants (alternatively, you can also connect as a user 

with SYSDBA privileges): 

SELECT ON DBA_ROLES 

SELECT ON DBA_USERS 

SELECT ON DBA_DIRECTORIES 

SELECT ON DBA_TABLESPACES 

CREATE SESSION 

 

3. If there are any errors during the SQL script execution, 

reconfigure the OFS_MRMM_SCHEMA_IN.XML file and 

execute the utility. This regenerates the scripts with 

corrected information. For more information, refer 

Configuring OFS_MRMM_SCHEMA_IN.XML 

fileConfiguring OFS_MRMM_SCHEMA_IN.XML file. 

4. Do not modify the OFS_MRMM_SCHEMA_OUT.XML file 

generated after the execution of this utility. 
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5.1.3 Execution Options in Schema Creator Utility 

Depending on the option you choose to run the OFSAA Application Pack Installer, you need to choose 
the schema creator utility execution option. To run the OFSAA Application Pack installer in SILENT 
mode, it is mandatory to execute the schema creator utility with –s option.  

 

NOTE Ensure to execute the schema creator utility with –s option 

 

5.2 Configuring and Executing the Schema Creator Utility 

This section includes the following topics: 

• Prerequisites 

• Configuring the Schema Creator Utility 

• Executing the Schema Creator Utility 

5.2.1 Prerequisites 

The following prerequisites must be ensured before configuring the Schema Creator Utility: 

• You must have the Oracle User ID/Password with SYSDBA privileges (not applicable for offline 
mode). 

• You must have the JDBC Connection URL for RAC/Non RAC database. 

• You must have the HOSTNAME/IP of the server on which OFSAA is getting installed. 

• For Java 8, navigate to OFS_AAAI_PACK/bin/ and modify the value for property 
JAVA_VERSION to 1.8 in the VerInfo.txt file and save the changes. 

• It is recommended to set the PGA_AGGREGATE_LIMIT database-parameter value sufficiently, 
when Oracle 12c is installed. 

• You must add a TNS entry before the installation. 

• The following configuration is required only if you intend to use Oracle Linux/Red Hat Enterprise 
Linux v7.x. 

▪ For Oracle Linux/RHEL 7.x, navigate to OFS_AAAI_PACK/bin/ and modify the value for 
property Linux_VERSION to include 7 in the VerInfo.txt file and save the changes. 

▪ For example, Linux_VERSION=5,6,7 

5.2.2 Configuring the Schema Creator Utility 

This section explains the steps to configure the Schema Creator Utility.  

To configure the Schema Creator Utility, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_MRMM_PACK/schema_creator/conf folder. 

3. Edit the OFS_MRMM_SCHEMA_IN.xml file in a text editor. 
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4. Configure the elements as described in the section Configuring OFS_MRMM_SCHEMA_IN.XML. 

5. Save the OFS_MRMM_SCHEMA_IN.xml file. 

 

NOTE On successful execution of the utility, the entered passwords in 

the OFS_MRMM_SCHEMA_IN.xml file are nullified. 

 

5.2.3 Executing the Schema Creator Utility 

You can execute the schema creator utility either in Online Mode or Offline Mode. This section includes: 

• Executing the Schema Creator Utility in Online Mode 

• Executing the Schema Creator Utility in Offline Mode 

• Executing the Schema Creator Utility with –s option 

• Executing the Schema Creator Utility while Installing Subsequent Application Pack 

5.2.3.1 Executing the Schema Creator Utility in Online Mode 

In Online Mode, the Schema Creator Utility creates all the Schemas, Schema Objects, Tablespaces, 
Grants, and Roles in the database during the execution process.  

To execute the Schema Creator Utility in Online Mode: 

1. Log in to the system as a non-root user. 

2. Navigate to the folder path: OFS_MRMM_PACK/schema_creator/bin/ 

3. Execute the osc.sh file using the command. 

./osc.sh  

The following message is displayed:  

You have chosen ONLINE mode. Triggering the utility in ONLINE mode will execute the DDLs 
directly on the Database. Do you wish to proceed? (Y/y or N/n). 

4. Enter Y/y to proceed with the script generation 

or 

Enter N/n to quit script creation. 

5. Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA. 

6. Enter the User Password. 
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7. The console runs the initial validation checks and then displays the following message:  

You have chosen to install this Application Pack on <Name of the Atomic Schema>ATOMIC 
schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to proceed with the schema creation. 

or 

Enter N/n to quit schema creation. 

The following message is displayed. 
You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to 
proceed? (Y/N). 

 

9. Enter Y/y to start the schema creation. 

Or 

Enter N/n if you want to quit executing the schema creation.  
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10. Make a TNS entry for the new users created. For details, see Add TNS entries in 
TNSNAMES.ORA file. 

 

NOTE • On successful execution of schema creator utility, the 

console displays the following status message: 

Schema Creator executed successfully. Please 

proceed with the installation.  

• Refer log file in 

OFS_MRMM_PACK/schema_creator/logs folder for 

execution status. In case of any errors, contact Oracle 

Support. 

 

5.2.3.2 Executing the Schema Creator Utility in Offline Mode 

In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has to be 
executed manually by logging as database user with SYSDBA privileges. The SQL file will contain the 
scripts for creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles. 

Prerequisites: 

To execute the utility in Offline mode, you need to connect as any user with below grants (alternatively, 
you can also connect as a user with SYSDBA privileges): 

• Database user with below privileges: 

▪ SELECT ON DBA_ROLES 

▪ SELECT ON DBA_USERS 

▪ SELECT ON DBA_DIRECTORIES 

▪ SELECT ON DBA_TABLESPACES 

▪ CREATE SESSION 

 

support.oracle.com
support.oracle.com
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NOTE Explicit Grants to the user are required. Grants assigned 

through Roles are not supported. 

 

To execute the schema creator utility in the offline mode, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_MRMM_PACK/schema_creator/bin 

3. Execute the osc.sh file using the following command: 

./osc.sh –o  

The following message is displayed:  
You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate the script. 
Do you wish to proceed? (Y/y or N/n). 

4. Enter Y /y to generate the script. 

or 

Enter N/n to quit the schema creation 

5. Enter the DB Username with SELECT privileges. 

6. Enter the User Password. 

 

7. The console runs the initial validation checks and displays the following message: 
You have chosen to install this Application Pack on <Name of the Atomic Schema>ATOMIC 
schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to start the script generation. 

Or 

Enter N/n if you want to quit the script generation. 

The following message is displayed. 
You have chosen to install this Application Pack on <Name of the Infodom>. Do you want to 
proceed? (Y/N). 
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9. Enter Y/y to start the script generation.  

Or 

Enter N/n if you want to quit the script generation. 

 
 

NOTE On successful execution of schema creator utility, the console 

displays the following status message:  

Schema Creator executed successfully. Please execute 

scratch/ofsaaapp/OFS_MRMM_PACK/schema_creator/sysdba_out

put_scripts.sql before proceeding with the installation. 

 

10. Navigate to the directory: OFS_MRMM_PACK/schema_creator.  

11. Login to SQLPLUS with a user having SYSDBA Privileges. 

12. Connect to the Oracle DB Server on which the OFSAA Application Pack installation is to be 
performed and execute the sysdba_output_scripts.sql file using the following command: 

SQL>@sysdba_output_scripts.sql 

13. Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts folder 

to a remote server and execute sysdba_output_scripts.sql file, after providing appropriate 

execute permissions. 
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NOTE See log sysdba_output_scripts.log file for execution 

status. In case of any errors, contact Oracle Support. If 

there are no errors in the execution, the log file is empty. 

 

14. Make a TNS entry for the new users created. For details, see Add TNS entries in 
TNSNAMES.ORA file. 

5.2.3.3 Executing the Schema Creator Utility with –s option 

If you intend to run the OFS MRMM Application Pack Installer in SILENT mode, it is mandatory to 
execute the schema creator utility with –s option. 

To execute the utility with –s option, follow these steps: 

1. Edit the file OFS_MRMM_PACK/schema_creator/conf/OFS_MRMM_SCHEMA_IN.xml in text 

editor. 

2. Execute the utility with –s option. 

3. For Example: ./osc.sh –s. 

4. Make a TNS entry for the new users created. For details, see Add TNS entries in 
TNSNAMES.ORA file 

 

NOTE • Ensure to execute the schema creator utility with –s 

option. 

• To execute the utility in OFFLINE mode with SILENT 

option, type. /osc.sh –o –s. 

 

5.2.3.4 Executing the Schema Creator Utility while Installing Subsequent Application 

Pack  

While executing the schema creator utility for subsequent Application Pack, you can choose to install 
the pack either on the same Information Domain/ Atomic Schema or on a new Information Domain/ 
Atomic Schema. 

To execute the schema creator utility while installing OFS MRMM Application Pack over an existing 
Application pack, follow these steps: 

1. Repeat the steps 1 to 9 from Executing the Schema Creator Utility section. 

 

NOTE Ensure to use the same config schema user name as the 

previous Application Pack. 

 

2. The utility identifies the Application Packs that are already installed on the current OFSAA setup 
and displays the following on console: 

▪ Atomic schema of the Existing Application Pack,  

▪ Information Domain Name of the Existing Pack, and the 
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▪ List of Installed Application Packs 

3. Enter Y/y to start the schema creation.  

4. If you enter N/n, the list of Atomic Users is displayed. 

5. You can select the Atomic User, on which you want to install the Application Pack. 

6. Make a TNS entry for the new users created. For details, see Add TNS entries in 
TNSNAMES.ORA file. 

 

NOTE • On successful execution of schema creator utility, the 

console displays the following status message: 

Success. Please proceed with the installation.  

• Refer log file in 

OFS_MRMM_PACK/schema_creator/logs folder for 

execution status. 

• Refer log sysdba_output_scripts.log file for 

execution status, if executed in offline mode. This log 

would be empty if there are no errors in the execution. 

• In case of any errors, contact Oracle Support. 

 

5.3 Installing the OFS MRMM Application Pack 

Follow the instructions in this section to install the OFS MRMM application pack depending on the mode 
of installation.  

 

NOTE • For enabling Right to be Forgotten, see Appendix S. 

• For enabling Data Redaction, see Data Redaction 

section in Appendix R, and Data Redaction section 

under Data Security and Data Privacy chapter in OFS 

Analytical Applications Infrastructure Administration 

Guide 8.0.8.0.0 on OHC Documentation library. 

 

5.3.1 SILENT Mode Installation 

In the Silent mode of installation you must configure the product xml files and follow the instructions in 
command prompt. To install OFS MRMM in silent mode: 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as below: 
FIC_HOME=< OFSAA Installation Directory > 

export FIC_HOME 

3. Add entry for Numerix directory path, and license path in .profile. The default values are as 
follows: 

http://www.support.oracle.com/
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$FIC_HOME/ficdb/bin/Numerix/cas-4.1.0-

4305-linux64/lib/linux64 

export LD_LIBRARY_PATH 

NX_LICENSE_DIR=$FIC_HOME/ficdb/bin/Numerix/license 

export NX_LICENSE_DIR 

LIBPARENTDIR=$FIC_HOME/ficdb/bin/Numerix/cas-4.1.0-4305-linux64 

export LIBPARENTDIR 

4. Execute the user .profile 

5. Navigate to OFS_MRMM_PACK folder. 

6. Edit the OFS_MRMM_PACK/conf/OFS_MRMM_PACK.xml to enable the product licenses. Refer 

file for details on configuring this XML file. 

 

NOTE To install MRMM, ensure to enter "Yes" in ENABLE tag for 

OFS_MRMM/APP_ID and then ensure to enter "Yes" in 

ENABLE tag for OFS_AAAI/APP_ ID. Refer Configuring 

OFS_MRMM_PACK.XML file for details on configuring this XML 

file. 

 

7. Edit the OFS_MRMM_PACK/schema_creator/conf/OFS_MRMM_SCHEMA_IN.xml file to set 

the appropriate attribute values. Include INFODOM = “<Infodom Name>” in 
OFS_MRMM_SCHEMA_IN.xml file 

 

NOTE • Refer Configuring OFS_MRMM_SCHEMA_IN.XML file 

for details on configuring this XML file. 

• Ensure to make a TNS entry for the new users created. 

For details, see Add TNS entries in TNSNAMES.ORA 

file.  

 

8. Edit the OFS_MRMM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the 

appropriate infrastructure installation attribute values. 

 

NOTE This step can be ignored if any pack already exists. Refer 

Configuring OFSAAI_InstallConfig.xml file for details on 

configuring this XML file. 

 

9. Execute the schema creator utility with –s option. 
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NOTE • This step is mandatory and should be executed before 

every OFS MRMM Application Pack installation. 

• Refer Executing the Schema Creator Utility for more 

details. 

 

10. The installer folder (OFS_MRMM_PACK/OFS_MRMM/conf) contains a template file 
“Silent.template”. Create a copy of this file and rename the copy as “Silent.props”. 

11. Edit the file “Silent.props” and specify the parameters as per the requirements. 

SILENT installation is achieved via a properties file [Silent.props] that must be updated with 
proper values, before attempting to install using the silent mode. The following table lists all the 
properties that need to be specified: 

 

Property Name Description of 

Property 

Permissible values  Comments 

LOG_MODE Specify Log Mode 1 = Debug Mode 
0= General Mode 

Password will be printed 
in the log file 
Password will be printed 
in the log file. Default is 
GENERAL 

SEGMENT_1_CODE Specify the MRMM 
Segment Code 

User Input Enter the Segment 
name in UPPERCASE. 

APPFTP_LOG_PATH Specify the Infodom 
Maintenance log 
path(to be created) for 
the new Infodom 
Please ignore if you are 
doing installation on an 
existing information 
domain 

User Input   

DBFTP_LOG_PATH Specify the Infodom 
Maintenance log 
path(to be created) for 
the new Infodom 
Please ignore if you are 
doing installation on an 
existing information 
domain 

User Input   

UPLOAD_MODEL Specify whether you 
want to perform Model 
Upload 

0 = If you have already 
performed Model Upload 
and want to skip model 
upload process 
1 = If you want to perform 
Model Upload 
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Property Name Description of 

Property 

Permissible values  Comments 

MODEL_TYPE Specify whether you 
want to use the 
released data model or 
customized data model 
for model upload 
process 

# 0 = If you want to upload 
the released data model 
# 1 = If you want to upload 
the customized data model 

  

DATAMODEL 
DM_DIRECTORY 

Specify the 
path(DM_DIRECTORY) 
and file(DATAMODEL) 
name for the cutomized 
data model 
Mandatory only if you 
want to upload the 
customized data model 
i.e you have specified 
MODEL_TYPE=1 

User Input   

ETL_APPSRC_TYPE Please specify if you 
want create new ETL 
App/Src pair or use an 
existing one. 

0 = If you want to create a 
new ETL app/src pair 
1 = If you want to use an 
existing pair 

  

ETL_SRC_1_DESC ETL Market Risk Trade 
source description 

STAGE_MR_TRADE Please give description 
for the ETL App/Src pair 
Mandatory if you want 
to create new ETL 
app/src pair 
i.e you have specified 
ETL_APPSRC_TYPE=0 

ETL_SRC_2_DESC ETL Market Risk 
Reference source 
description 

STAGE_MR_REFERENCE Please give description 
for the ETL App/Src pair 
Mandatory if you want 
to create new ETL 
app/src pair 
i.e you have specified 
ETL_APPSRC_TYPE=0 

ETL_SRC_3_DESC ETL Market Risk 
Processing source 
description 

MR_PROCESSING Please give description 
for the ETL App/Src pair 
Mandatory if you want 
to create new ETL 
app/src pair 
i.e you have specified 
ETL_APPSRC_TYPE=0 

ETL_SRC_4_DESC ETL Market Risk 
Processing source 
description 

STAGING Please give description 
for the ETL App/Src pair 
Mandatory if you want 
to create new ETL 
app/src pair 
i.e you have specified 
ETL_APPSRC_TYPE=0 
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Property Name Description of 

Property 

Permissible values  Comments 

ETL_SRC_1_NAME ETL Market Risk Trade 
source name 

STAGE_MR_TRADE Specify the ETL 
Application and Source 
Name into ETL Area 
Definitions will be 
deployed 

ETL_SRC_2_NAME ETL Market Risk 
Reference source 
name 

STAGE_MR_REFERENCE Specify the ETL 
Application and Source 
Name into ETL Area 
Definitions will be 
deployed 

ETL_SRC_3_NAME ETL Market Risk 
Processing source 
name 

MR_PROCESSING Specify the ETL 
Application and Source 
Name into ETL Area 
Definitions will be 
deployed 

ETL_SRC_4_NAME ETL Market Risk 
Processing source 
name 

STAGING Specify the ETL 
Application and Source 
Name into ETL Area 
Definitions will be 
deployed 

 

12. Give a path for installation log file in log4j.xml in OFS_MRMM_PACK/OFS_MRMM/conf. 

13. On successful execution of the schema creator utility, navigate to OFS_MRMM_PACK/bin and 

execute the application pack installer with SILENT option, using the below command: 

 ./setup.sh 

14. Enter the OFSAA Processing Tier FTP/SFTP password value, when prompted at the command 
prompt. 

 

Console Prompts User Inputs 

Please enter OFSAA Processing 
Tier FTP/SFTP password 

Enter the password to access processing tier in the application 
server. 

Note: In case the prompt reads as below, enter the username/ 
password for accessing the product Staging/ Metadata Repository 
FTPSHARE 

• Kerberos username [user] 

• Kerberos password for user: 

 

15. Enter Always when prompted to add host key fingerprint. 

16. The OFS MRMM License Agreement is displayed. 
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17. To accept the License Agreement, enter Y/y. 

 
 

NOTE SYSADMN and SYSAUTH are the two default OFSAAI 

administrative users created. 
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NOTE The installation process continues on the console. Do not close 

the console until the installation process is complete. 

 

18. Once the platform is installed, it proceeds for the MRMM PACK installation. 
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19. After successful MRMM pack installation, WAR file is generated and all the servers are verified 
and the installation complete message is displayed. 

20. The following message is displayed in the console 

Installation completed… 
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21. On completion of installation, refer the installation log files. For more information, refer Verifying 
the Log File. 

22. Download and install the patch 30661419, from https://support.oracle.com. 

23. DMT migration utility is executed during installation of OFS MRMM, to migrate the DMT metadata 
(PLC/Data Source/Data Mapping/Data File Mapping) to be persisted in tables instead of XML. 
You may be required to re-run DMT migration utility in some scenarios. To identify whether to run 
the utility, how to run, and how to handle migration issues, see OFSAA DMT Metadata Migration 
Guide. 

Note: Execute the DMT Migration Utility to manually migrate the DMT metadata of the 
Applications which are not upgraded to 8.0.8.0.0. 

24. For enabling Right to be Forgotten, see Appendix S. 

https://support.oracle.com/
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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25. For enabling Data Redaction, see Data Redaction section under Data Security and Data Privacy 
chapter in OFS Analytical Applications Infrastructure Administration Guide 8.0.8.0.0. Additionally, 
see Data Redaction section in Appendix R. 

 

NOTE Perform steps mentioned in the Post-Installation Configuration 

section. 

 

5.3.2 Verifying the Log File 

Refer the following logs files for more information:  

• Refer OFS_MRMM_Installation_Debug.log and OFS_MRMM_Installation.log located at 

OFS_MRMM_PACK/OFS_MRMM/logs/ folder for OFS MRMM Application Pack installation log 

file.  

• Refer the log file(s) located at OFS_MRMM_PACK/OFS_AAI/logs/ folder for Infrastructure 

installation log.  

• Refer the OFSAAInfrastucture_Install.log located at $FIC_HOME folder for Infrastructure 

installation log. 

 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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6 Post Installation Configuration 

On successful installation of the Oracle Financial Services MRMM application pack, follow the post 
installation steps mentioned below. 

 

NOTE • Download and install the mandatory patches 

29887635, 29952285 and follow the instructions in the 

readme. 

• Install the mandatory OFSAAI patch 30273976. Refer 

to the Readme available with the patch for further 

instructions on installing the patch. 

• Install the mandatory OFSAAI patch 30666547. Refer 

to the Readme available with the patch for further 

instructions on installing the patch. 

 

This chapter includes the following sections: 

• Configuring Resource Reference 

• Start OFSAA Infrastructure Services 

• Add TNS entries in TNSNAMES.ORA file 

• Configuration for Oracle R distribution and Oracle R Enterprise (ORE) 

• Configuring Tomcat 

• Updating OBIEE URL 

• Data Source Configuration 

• Transfer the ownership of batches to the required User 

• Create and Deploy the Application Pack Web Archive 

• Access the OFSAA Application 

• Perform Post Deployment Configurations 

• Installing Numerix 

• Starting Numerix Servers 

 

 

NOTE Ensure to clear the application cache prior to the deployment of 

Application Pack Web Archive. This is applicable to all Web 

Servers (WebSphere, WebLogic, Tomcat). For more 

information, refer Clearing Application Cache section. 
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6.1 Configure Resource Reference 

Configure the resource reference in the Web Application Server configured for OFSAA Applications. 
Refer Appendix B for details on configuring the resource reference in WebSphere, WebLogic, and 
Tomcat Application Servers.  

6.2 Start OFSAA Infrastructure Services 

Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA Applications. 

Refer Appendix D for details on Start/ Stop OFSAA Services. 

6.3 Add TNS entries in TNSNAMES.ORA file 

Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack 

To find the tnsname for the entries, follow these steps: 

1. Login to the application using System Administrator privileges. 

2. Navigate to System Configuration & Identity Management tab. 

3. Click Administration and Configuration >> System Configuration >> Database Details. 

4. Expand the dropdown list for Name to get the list of TNS entry names. 

5. Alternatively, you can connect to the CONFIG schema and execute the below query: 

select dbname from db_master where dbname !='CONFIG' 

6.4 Configuration for Oracle R distribution and Oracle R 
Enterprise (ORE) 

This section is applicable only if OFS Enterprise Modeling is licensed and enabled in your OFSAA 
instance. 

1. Install OFSAAIRunner Package. For more information, refer Installing OFS AAAI Runner 
Package. If you have already installed OFSAAIRunner package (as part of a previous 
installation), uninstall it (For more information, refer Uninstalling OFS AAAI Runner Package 
section), and reinstall the latest available OFSAAIRunner package. 

2. Log in to the database with dba privileges and provide the following privilege to Configuration 
Schema: 

▪ RQADMIN by executing the command: 

GRANT RQADMIN TO <config_schema>; 

3. Log in to the database with dba privileges and provide the following privileges to Atomic Schema: 

▪ CREATE MINING MODEL privilege (to execute the Data Mining models) by executing the 

command: 

▪ GRANT CREATE MINING MODEL TO <atomic_schema>; 



POST INSTALLATION CONFIGURATION 

CONFIGURATION FOR ORACLE R DISTRIBUTION AND ORACLE R ENTERPRISE (ORE) 

OFS MARKET RISK MEASUREMENT AND MANAGEMENT APPLICATION PACK  |  53 

6.4.1 Installing OFS AAAI Runner Package 

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a prerequisite for 
executing models developed using R scripts. This package helps in: 

• Initializing inputs 

• Mapping framework variables to R objects 

• Configuring possible outputs of the script 

• Storing results back to the Database 

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_HOME/lib. 

6.4.1.1 Prerequisite 

Oracle R & ORE should be installed on the Oracle Database server before installing OFSAAIRunner 
package. 

Refer to the following instructions to install OFSAAIRunner package: 

1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib. 

2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database Server. 

3. Log in to the Oracle Database Server with the user using which Oracle Database Server 
installation is done. 

4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied. 

5. Install the package by executing the command: 

ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz 

6. Successful installation is indicated in the installation log as: 

* DONE (OFSAAIRunner) 

Making packages.html ... done 

 

NOTE The OFSAAIRunner package is installed in /usr/lib64/R/library. 

 

7. Navigate to the directory $ORACLE_HOME/R/library and check whether OFSAAIRunner 

package is listed there by executing the command: 

>library(OFSAAIRunner) 

>OFSAAIRunner:: and press TAB twice. 

This lists out all the functions. 

6.4.2 Uninstalling OFSAAIRunner Package 
 

NOTE This procedure is required only if you are uninstalling OFSAAI 

Runner Package. 
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Refer to the following instructions to uninstall the OFSAAIRunner package: 

1. Log in to the Oracle Database Server with the same username, using which Oracle Database 
Server installation is done. 

2. Enter ORE in command prompt and execute the command: 

#ORE 

>remove.packages("OFSAAIRunner") 

3. To save workspace image, enter the command: 

>q() 

4. Enter y when prompted to save the workspace image. 

5. Save workspace image? [y/n/c]: y 

6. Navigate to the directory $ORACLE_HOME/R/library and verify the package is not listed there by 
executing the command: 

ls –l 

6.4.3 Configuring ORE Execution 

Perform the following step: to configure ORE execution: 

1. Add a TNS entry in tnsnames.ora file with tns name same as that of value set for ORACLE_SID 
in database server. 

 

NOTE For RAC database, follow the preceding configuration in all 

machines. 

 

6.5 Configuring Tomcat 

To stop generating static content with one print statement per input line, you need to configure the 
web.xml file. 

To configure web.xml file, perform the following steps: 

1. Navigate to tomcat/conf directory. 

2. Edit web.xml file as follows: 

3. Set the mapped file parameter to False in the servlet tag mentioned with 

<servlet-name>jsp</servlet-name>. 

<init-param> 

<param-name>mappedfile</param-name> 

<param-value>false</param-value> 

</init-param> 
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6.6 Updating OBIEE URL 

To access the respective Business Intelligence Analytics Application, you need to update the OBIEE url 
in the table 'AAI_MENU_B', once the OBIEE environment is up and running. 

UPDATE AAI_MENU_B 

SET V_MENU_URL = '&obieeURL' 

WHERE V_MENU_ID IN ('OFS_LRM_BI') 

/  

COMMIT 

/ 

6.7 Data Source Configuration 

• Create a connection pool in the Information Domain. For more information refer to the OFSAAI 
Installation manual. 

• JNDI name of the connection pool must be <res-ref-name> as mentioned in the web.xml. For 
example : "jdbc/OFSLRMINFO" 

• Create and deploy the web components into webserver. For more information on deploying the 
web components refer to the OFSAAI Installation manual. 

• The following tag must be added manually in web.xml if not already present in web.xml. 

<resource-ref> 

<!-- description>DB Connection OFSLRMINFO</description --> 

<res-ref-name>jdbc/OFSLRMINFO</res-ref-name> 

<res-type>javax.sql.DataSource</res-type> 

<res-auth>Container</res-auth> 

</resource-ref> 

6.8 Transfer the ownership of batches to the required User 

To transfer the ownership of batches to the required User, follow these steps: 

1. Login to config use. 

2. Execute the Following anonymous pl/sql block to execute procedure "AAI_OBJECT_ 
ADMIN.TRANSFER_BATCH_OWNERSHIP". 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP 

('fromUser','toUser','infodom'); end; 

OR 

begin AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP 

('fromuser','touser'); end; 

fromUser: - indicates the user who currently owns the batch, 
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toUser:-indicated the user to which the ownership has to be transerred. 

Infodom:- optional parameter , if specified the ownership of batches 

pertaining to that Infodom will be changed. 

 

NOTE Henceforth batches are available in the Batch Maintenance 

window in the MRMM application and the same can be edited. 

 

 

6.9 Create and Deploy the Application Pack Web Archive  

On successful installation of the OFSAA Application Pack, the web archive file is automatically 
generated. However, you need to deploy the generated web archive file on the Web Application Server.  

For identifying the location of the generated web archive file and for generating and deploying the web 
archive file at any time later, refer Appendix C. 

 

NOTE Refer the Oracle Financial Services Forms Manager User Guide 

for instructions on Creating and Deploying the Forms Manager 

Web Archive. 

 

6.10 Access the OFSAA Application 

Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured. 

Refer to Appendix E for details on accessing the OFSAA Application on successful deployment of the 
application web archive. 

6.11 Perform Post Deployment Configurations 

Prior to using the OFSAA Application perform the Post Deployment Configuration steps detailed in 
Appendix F. 

6.12 Installing Numerix 

NOTE Download and install the patch 30661419, from 

https://support.oracle.com. 

6.12.1 Configuring Numerix directory 

The default Numerix directory is $FIC_HOME/ficdb/bin/Numerix/cas-4.1.0-4305-linux64 

 

https://support.oracle.com/
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NOTE Ensure to grant 777 permission to the Numerix directory. 

 

1. Update the following files in <Numerix_Directory>/conf/ 

• cas-server.properties 

▪ Modify the database settings "UseBackingStore=true" to "UseBackingStore=false" 

• cas-common.properties 

▪ Check the port number availability for “brokeruri” port. By default, brokeruri port is 

14900 

▪ To point the numerix to a different broker already running, update the IP and port of 
“brokerlocation” value as 
brokerlocation=ssl://<broker_machine_ip>:<broker_machine_port> 

 

 

NOTE If you move the Numerix files to a new location, update the 

Numerix path in the .profile file (as mentioned in Step 3 of Silent 

Mode Installation), and execute the .profile 

 

6.12.2 Configuring CHLS 

1. Copy the CHLS directory to the Unix machine which will be hosting CHLS. Default CHLS 
directory path is $FIC_HOME/ficdb/bin/Numerix/CHLS/Numerix-CHLS-2.1.0 

2. Update the configurations 

• Update the CATALINA_HOME  variable in file  <CHLS_Directory> /bin/catalina.sh to 
<CHLS_Directory>/Numerix-CHLS-2.1.0 

• Check the port number availability for Connector port value defined 
in  <CHLS_Directory>/conf/server.xml. Default connector port value is 8080. If the port 

is already being used, update with a free port number. 

3. Start CHLS by executing the file startup.sh located at <CHLS_Directory>/bin/ 

4. The CHLS URL will be as below: 

http://<CHLS_IP>:<Port>/nxchls/chlslogin.jsp  

For example: http://localhost:8080/nxchls/chlslogin.jsp   

 

http://localhost:8080/nxchls/chlslogin.jsp


POST INSTALLATION CONFIGURATION 

INSTALLING NUMERIX 

OFS MARKET RISK MEASUREMENT AND MANAGEMENT APPLICATION PACK  |  58 

NOTE < CHLS_IP > : IP of the Unix machine hosting CHLS 

<Port> : Connector port mentioned in 

<CHLS_Directory>/conf/server.xml 

There are two user logins available: 

• sysadmin/sysadmin1 

• admin/admin1 

 

5. Login to CHLS URL as sysadmin user 

 

Login Screen 

6. Select Configure Client URL tab. Update the hostname from ‘localhost’ to name of the machine 
hosting CHLS. Alternatively, you can also provide <CHLS_IP>. Also, update the port number to 
the value provided in server.xml 

7. Click Submit. 

 

Client URL Configuration 

6.12.3  Generating Licenses Using CHLS 

1. Login to CHLS URL as admin user. The domain list will be displayed. 
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Domain List 

2. Select the domain from the Domain list. The generated license details and status will be 
displayed 

 

 

Domain Details 

3. To generate a new license, click the ‘.nxcfg’ button. License will be generated and downloaded.  

 

NOTE Rename the saved license file name to remove blank spaces, if 

any. 
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6.12.4 Activating Numerix Trial Licenses 

1. Copy the license generated using CHLS to the Unix machine where Numerix_Directory is 
present. By default, ‘$FIC_HOME/ficdb/bin/Numerix/license’ folder is provided for 

copying the generated license 

2. Navigate to the Numerix lib directory path in putty: <Numerix_directory>/lib/linux64 

3. Install the license by executing the following command 

./nxlm --install <license_path>/<license_file> 

4. Check the status of installed license executing the command : 

./nxlm --list all 

The license status will be shown as inactive.  

5. Start the Numerix processes (Broker, Server, Compute). The license status will become active. 
The same is reflected in CHLS UI also. 

6. To uninstall license, execute the command: 

./nxlm --install <license_name>  

▪ <license_name> is the name of the license displayed when ‘./nxlm --list all’ command is 

executed. 

 

 

NOTE The machine in which CHLS is hosted and the machine where 

Numerix is installed should be in the same network 

Before the CHLS License Key expires, contact My Oracle 

Support for the new CHLS License patch. Details about the 

license validity period is available in the Domain Details section 

of the CHLS Hosted URL. 

If the CHLS is to be re-located to a new location, all the licenses 

should be uninstalled before the CHLS directory is moved. 

 

6.12.5 Setting up Multiple Compute Nodes 

Follow the below steps to set up multiple compute nodes: 

1. Copy the Numerix CAS folder from the primary machine to the secondary machine. The CAS 
folder is located in the below path: 

$FIC_HOME/ficdb/bin/Numerix. 

2. Configure the CAS licenses in the secondary machines. See section Configuring CHLS for 
details. 

3. Navigate to the location:$FIC_HOME/ficdb/bin/Numerix/cas-4.1.0-4305-

linux64/conf and open the file "cas-common.properties". Change the broker location setting 

for each secondary machines to the same broker location that is running the Broker process in 
the primary machine (including the port number) 

https://support.oracle.com/
https://support.oracle.com/
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For example, if the primary machine named "Comp1" is in the "domain" listening to port 14900, 
then modify the broker location in each of the secondary machines as in the primary machine 
such as: brokerlocation=ssl://Comp1.domain:14900 

4. Navigate to the location:$FIC_HOME/ficdb/bin/Numerix/cas-4.1.0-4305-linux64/bin 

and Run the runCompute.sh on each secondary machine that is designated as a compute 

node. 

 

NOTE Ensure that all the Numerix servers are running in the primary 

machine before configuring multiple compute nodes on 

secondary machines. 

 

6.13 Starting Numerix Servers 

On the machine in which Numerix is installed, navigate to <Numerix_Directory>/bin and start the 
services in the following order: 

1. Start Broker by executing the following command 

./RunBroker.sh & 

2. Once Broker is started successfully, start Server by executing the following command 

./RunServer.sh & 

3. Once Server is started successfully, start Compute node by executing the following command 

./RunCompute.sh & 
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7 Appendix A: Configuring Web Server 

This appendix includes the following sections: 

• Configuring Web Server 

• Configuring Web Application Server 

7.1 Configuring Web Server 

This step assumes an installation of a Web Server exists as per the prerequisites. 

Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web Server. If 
an installation already exists, skip and proceed to the next step. 

 

NOTE • Make a note of the IP Address/ Hostname and Port of 

the web server. This information is required during the 

installation process. 

• Refer Oracle Financial Services Analytical Applications 

Infrastructure Security Guide in Documentation Library 

for OFSAAI  for additional information on securely 

configuring your Web Server. 

• Ensure to enable sticky session/ affinity session 

configuration on the web server. Refer the respective 

product specific Configuration Guide for more details. 

Additionally, you also need to enable the sticky 

session/ affinity session configuration at Load Balancer 

level if you have configured a Load Balancer in front of 

the web server(s). 

 

7.2 Configuring Web Application Server 

This step assumes an installation of a web application server exists as per the prerequisites. To 
configure the Web Application Server for OFSAA Deployment refer the sections below.  

This section includes the following topics: 

• Configuring WebSphere Application Server for Application Deployment 

• Configuring WebLogic for Application Deployment 

• Configuring Apache Tomcat Server for Application Deployment 

 

https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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NOTE Make a note of the IP Address/ Hostname and Port of the web 

application server. This information is required during the 

installation process (required if Web Server is not configured). 

Add umask 0027 in the .profile of the UNIX account which 

manages the WEB server to ensure restricted access 

permissions. 

Refer OFSAA Secure Configuration Guide/ Security Guide 

mentioned in the Related Documents section for additional 

information on securely configuring your Web Server. 

 

7.2.1 Configuring WebSphere Application Server for Application 
Deployment 

You can deploy multiple OFSAA applications on different profiles of a WebSphere application server. To 
create multiple WebSphere "Profiles" in a stand-alone server, use the command line option as explained 
in the following section. A profile is the set of files that define the runtime environment. At least one 
profile must exist to run WebSphere Application Server. 

This section includes the following topics: 

• Creation of New Profile in WebSphere 

• Manage Applications in WebSphere 

• Delete WebSphere Profiles 

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x Libraries 

• WebSphere HTTPS Configuration 

• WebSphere Memory Settings 

• Configuring WebSphere for REST Services Authorization 

• Configuring Application Security in WebSphere 

7.2.1.1 Creation of New Profile in WebSphere 

The Profile is created in WebSphere through command line using the manageprofiles.sh which resides 
in <WebSphere Install directory>/AppServer/bin. 

The command to create a profile without admin security through command line is as follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath 

<profile_path> -templatePath <template_path> -nodeName <node_name> -

cellName <cell_name> -hostName <host_name>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default -

nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 

ipa020dor 

The command to create a profile with admin security through command line is as follows: 

https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf


APPENDIX A: CONFIGURING WEB SERVER 

CONFIGURING WEB APPLICATION SERVER 

OFS MARKET RISK MEASUREMENT AND MANAGEMENT APPLICATION PACK  |  64 

"manageprofiles.sh -create -profileName <profile> -profilePath 

<profile_path> -templatePath <template_path> -nodeName <node_name> -

cellName <cell_name> -hostName <host_name> -enableAdminSecurity true -

adminUserName <Admin User Name> -adminPassword < Admin User Password> -

samplespassword <sample User Password>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix -

profilePath/websphere/webs64/Appserver/profiles/mockaix -

templatePath/websphere/webs64/Appserver/profileTemplates/default -

nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 

ipa020dor -enableAdminSecurity true -adminUserName ofsaai -

adminPassword ofsaai -samplespassword ofsaai" 

 

NOTE While using the manageprofiles.sh command to create a 

New Profile in WebSphere, you can also use "-validatePorts" to 

validate if the specified ports are not reserved or in use. 

Additionally, you can specify new ports with "-startingPort 

<base port>" which specifies the starting port number to 

generate and assign all ports for the profile. For more 

information on using these ports, refer WebSphere 

manageprofiles command. 

 

7.2.1.2 Managing IBM WebSphere SDK Java Technology Edition Versions 

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must upgrade to Java 
7.X SDK or JAVA 8.X SDK. 

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 1.7.X_64 or 
1.8.X_64. 

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK: 

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_NUMBER/ibm/console (use 
https if SSL is enabled.). For example, http://192.168.1.0:9000/ibm/console. 

2. Login with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu. 

4. Click Server Types to expand the menu further and then click WebSphere Enterprise Application 
Servers to view the Application servers window. 

5. On Application servers window, click the required Application Server link. For example, server1 in 
the following illustration: 

https://www.ibm.com/support/knowledgecenter
https://www.ibm.com/support/knowledgecenter
http://HOST_NAME:PORT_NUMBER/ibm/console
http://192.168.1.0:9000/ibm/console
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Application Server - Java SDKs 

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs. 

 

Application Server - List of Java SDKs 

7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to install OFSAA or 
have installed with. 

8. Click Make Default button and save to master repository. 

9. Restart the WebSphere Application Server to apply the changes to the IBM application profile. 
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7.2.1.3 Manage Applications in WebSphere 

To manage the installed applications in WebSphere, do the following: 

1. Open the administrator console using the following URL: 

http://<ipaddress>:<Administrative Console Port>/ibm/console 

Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled) 

 

NOTE Administrative Console Port value is available in 

serverindex.xml file within <WebSphere Profile 

Directory>/config/cells/<Node Cell>/nodes/<Node 

Name> directory. 

 

2. The Integrated Solutions Console Login window is displayed. 

 

3. Integrated Solutions Console Login 

4. Log on with the User ID provided with the admin rights. 

5. From the LHS menu, expand the Applications > Application Type> WebSphere Enterprise 
Applications. 

The Enterprise Applications screen is displayed. 
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6. Enterprise Applications 

7.  This Enterprise Applications screen helps you to: 

▪ Install new application 

▪ Uninstall existing applications 

▪ Start or Stop the installed applications 

7.2.1.4 Configuring WebSphere Application Server to Use a Load Balancer or Proxy 

Server 

The configuration prevents the process server from redirecting to an internal port when using a load 
balancer or proxy server. The following steps describe the configuration:  

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_ NUMBER/ibm/console 

(use https if SSL is enabled.). For example, http://192.168.1.0:9000/ibm/console.  

2. Login with your administrator user ID and password.  

3. From the LHS menu, click Servers to expand and view the menu.  

4. Click Server Types to expand the menu further and then click WebSphere Enterprise 
Application Servers to view the Application servers window.  

5. On Application servers window, click the required Application Server link. For example, server1 in 
the following illustration: 

  

Application Servers - Load Balancer Proxy Server 
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6. Click Web Container Settings > Custom Properties.  

7. Add the following properties:  

• Name: trusthostheaderport  

Value: true  

• Name: com.ibm.ws.webcontainer.extractHostHeaderPort  

Value: true  

8. Restart the WebSphere Application Server to apply the changes. 

7.2.1.5 Delete WebSphere Profiles 

To delete a WebSphere profile, do the following: 

1. Select the checkbox adjacent to the required application and click Stop. 

2. Stop the WebSphere profile to be deleted. 

3. Navigate to WebSphere directory: 

<WebSphere_Installation_Directory>/AppServer/bin/ 

4. Execute the command: 

manageprofiles.sh -delete -profileName <profile_name> 

5. Delete profile folder. 

Example: <WebSphere_Installation_Directory>/AppServer/profiles/<profile_name> 

6. Execute the command: 

manageprofiles.sh –validateAndUpdateRegistry 

7.2.1.6 Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x 

Libraries 

Perform the following configuration to set WebSphere shared library to support jersey 2x and Jackson 
2.9x libraries.  

1. Click Environment from the menu on the left to expand and view the list. Click Shared Libraries to 
open the Shared Libraries window. 
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2. Enter details as shown in the following:  

▪ Name: Enter a unique identifiable name. 

▪ Description: Enter a valid description. 

▪ Classpath: Enter the absolute path where the JARs related to Jersey 2.x and Jackson 2.9x 
are copied. These jars are available in the <OFSAA_HOME>/utility/externallib/WEB-INF/lib 
directory after creation of the EAR file. 

3. Select Use an isolated class loader for this library. 

4. Click OK to save to master configuration.  

5. Select the application or module and map the shared libraries. Click OK. In the following 
illustration, ofsa is selected.  

 

6. From the Shared Library Mapping window, move the required shared libraries from Available to 
Selected. In the following illustration, JERSEY2x is selected. 
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7. Click OK.  

8. Similarly, select the next application or module and repeat the procedure from steps 5 to 7. 

 

9. Disable the built-in JAX-RS via JVM property.  

10. Go to WebSphere admin console in Servers > WebSphere Application Servers > 
yourServerName.  

11. In Server Infrastructure section, go to Java and Process Management > Process Definition > 
Java Virtual Machine > Custom properties. 

12. Add the following property: 

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true 

13. Restart the application. 

7.2.1.7 WebSphere HTTPS Configuration 

Following are the steps for configuring an HTTPS Transport on WebSphere: 

1. Create a profile using the Profile Creation Wizard in WebSphere. 
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NOTE Note down the https port specified during this process and use 

the same as servlet port or web server port during OFSAAI 

installation. 

 

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in 
OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation. 

7.2.1.8 WebSphere Memory Settings 

To configure the WebSphere Memory Settings: 

1. Navigate to Websphere Applications Server > Application Servers > server1 > Process 
Definition > Java Virtual Machine. 

2. Change the memory setting for Java Heap: 

Initial heap size = 512 

Maximum heap size = 3072 

7.2.1.9 Configuring WebSphere for REST Services Authorization 

Configure the following in WebSphere to enable REST API authorization by OFSAA: 

1. Log on to WebSphere console with the User ID provided with the admin rights. 

2. Expand Security menu in the LHS and click Global security > Web and SIP security > General 
settings.  

 

3.  De-select the Use available authentication data when an unprotected URI is accessed checkbox. 

4. Click OK. 
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5.  Click Save to save the changes to master configuration. 

7.2.1.10 Configuring Application Security in WebSphere 

This is a mandatory security procedure for WebSphere to restrict the unauthorized access of 
configuration files in directories. For detailed information, see the Oracle Financial Services Analytical 
Applications Infrastructure Security Guide. 

7.2.2 Configuring WebLogic for Application Deployment 
 

NOTE Applicable only if the web container is WebLogic. 

 

You can deploy multiple Infrastructure applications on different domains of a stand-alone WebLogic 
application server. To create multiple WebLogic "Domains" in a stand-alone server you can use the 
Domain Creation wizard. A domain is the set of files that define the runtime environment. At least one 
domain must exist to run WebLogic Application Server. 

Following configuration is required only if OFS Big Data Processing is licensed and enabled in your 
OFSAA instance and OFSAA is deployed on Oracle WebLogic Server version 12.2.x: 

The jersey-server-1.9.jar file should be copied to <HIVE_LIB_ PATH> path. 

This section includes the following topics: 

• Creating Domain in WebLogic Server 

• Deleting Domain in WebLogic 

• Configuring WebLogic Memory Settings 

• Configuring WebLogic for REST Services Authorization 

7.2.2.1 Creating Domain in WebLogic Server 

To create a new domain using Configuration Wizard in WebLogic, do the following: 

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the command: 

./config.sh 

http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
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The Configuration Type window of the Configuration Wizard is displayed. 

 

2. Configuration Type 

3. Select Create a new domain option and click Next. The Templates window is displayed. 

 

4. Templates 

5. Select the Create Domain Using Product Templates option and click Next. 

The Administrator Account window is displayed. 
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Administrator Account 

6. Enter the user name to be assigned to the administrator, the password and confirm the password. 
Click Next. 

The Domain Mode and JDK window is displayed. 

 

Domain Mode and JDK 

7. Select from the following options: 
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In the Domain Mode section, select the required mode (Development or Production). 

In the JDK section, select the required option. If you select Other JDK Location, click Browse, 
navigate to the JDK location, and select. Click Next. 

The Advanced Configuration window is displayed. 

 

Advanced Configuration 

8. Select Administration Server. A WebLogic Server domain must have an Administration Server. 
You can also select Manages Servers, Clusters and Machines and RDBMS Security Store, if 
required. Click Next. 

The Administration Server window is displayed. 
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Administration Server 

9. Enter Administration Server details such as the Server Name, Listen address, Listen Port, Enable 
SSL(for secure login using https, select this check box), and SSL listen port. Click Next. 

The Configuration Summary window is displayed. 

 

NOTE Make a note of the Listen Port or SSL Listen Port value (for 

example: 7007), since the same has to be re-entered in the 

Servlet port field during Infrastructure installation. 
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Configuration Summary 

10. Verify the configuration details of the WebLogic domain and click Create. 

The Configuration Progress window is displayed with the status indication of the domain creation 
process. 
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Creating Domain 

11. Click Next when 100% of the activity is complete. The End of Configuration  window is displayed 

 

12. Click Finish. The domain server is created enabling the deployment of multiple Infrastructure 
applications on a single WebLogic. 
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13. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ "setDomainEnv.sh" file 
(Required only if self signed certificate is used). 

 

NOTE • Note down the HTTPS port specified during this 

process and use the same as servlet port or web 

server port during OFSAAI Installation. 

• To enable https configuration on Infrastructure, assign 

value 1 to "HTTPS_ENABLE" in 

OFSAAI_InstallConfig.xml for silent mode OFSAAI 

installation 

 

7.2.2.2 Delete Domain in WebLogic 

1. Navigate to the following directory: 

<WebLogic Installation directory>/user_projects/domains/<domain 

name>/bin 

2. Execute stopWebLogic.sh to stop the WebLogic domain. 

3. Delete the WebLogic domain. 

7.2.2.3 WebLogic Memory Settings 

To configure the WebLogic Memory Settings: 

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in setDomainEnv.sh file, 
which resides in the folder <DOMAIN_HOME>/bin and in CommEnv.sh file which resides in the 
folder common/bin. 

2. Edit this file for customizing memory settings and garbage collector settings depending on the 
available hardware configuration. 

Example 1: 

if [ "${JAVA_VENDOR}" = "Sun" ] ; then 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

else 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

Example 2: 

JAVA_VM= 

MEM_ARGS="-Xms256m -Xmx1024m" 
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7.2.2.4 Configuring WebLogic for REST Services Authorization 

To enable REST API authorization by OFSAA in WebLogic, perform the following steps: 

1. Open the config.xml file located in the domain where OFSAA is deployed, that is 
<domain_home>/config/config.xml 

2. Add the following in the security-configuration tag: 

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-

credentials> 

7.2.3 Configuring Apache Tomcat Server for Application Deployment 

This section is applicable only when the Web Application Server type is Tomcat. 

This section includes the following topics: 

• Tomcat User Administration 

• Configure Tomcat to use JAVA 64 bit Executables 

• Configure Servlet Port 

• SSL Port Configuration 

• Apache Tomcat Memory Settings 

• Configuration for Axis API 

• Configuring tomcat for User Group Authorizations and Data Mapping 

• Uninstalling WAR Files in Tomcat 

7.2.3.1 Tomcat User Administration 

The Tomcat administration and manager application does not provide a default login. You are required 
to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below. 

This file contains an XML tag <user> for each individual user, which will display the username and 
password used by admin to log on to Tomcat, and the role names to which the admin user is associated 
with. For example, <user name="admin" password="admin" roles="standard,manager"/> 

1. Add the manager role to any one of the existing username/password combination as shown in the 
aforementioned example. 

2. Use the same username/password to which the manager role has been assigned to access the 
Tomcat Application Manager. 

3. If the Tomcat server is already running, it requires a re-start after the aforementioned 
configuration is done. 

7.2.3.2 Configure Tomcat to use JAVA 64 bit Executables 

1. Navigate to the "$CATALINA_HOME/bin" folder. 

2. Edit the setclasspath.sh as explained below: 

3. Replace the following block of text: 

# Set standard commands for invoking Java. 

RUNJAVA="$JRE_HOME"/bin/java 
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if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_HOME"/bin/jdb 

With: 

# Set standard commands for invoking Java. 

RUNJAVA="$JAVA_BIN"/java 

if [ "$os400" != "true" ]; then 

RUNJDB="$JAVA_BIN"/jdb 

4. If the Tomcat server is already running, it requires a re-start after the aforementioned 
configuration is done. 

 

NOTE In case tomcat is installed under different Unix profile, set 

JAVA_BIN environment variable in .profile to include the Java 

Runtime Environment absolute path. 

 

For example: 

export JAVA_BIN /usr/java7_64/jre/bin 

export JAVA_BIN = /usr/java7_64/jre/bin//sparcv9 for Solaris Sparc 

7.2.3.3 Configure Servlet Port 

The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you need to 
use the default port. 

If you need to use a different port number, you must first configure the port in the "server.xml" in the 
"conf" directory of Tomcat Installation directory. To configure the Servlet Port, follow these steps: 

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag: 

"Define a non-SSL HTTP/1.1 Connector on port 8080"  

2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value to the new 
port number that will be used during the installation process.  

3. Verify the Context path. 

4. Update the config schema and atomic schema name in Resource auth 

5. Save your changes in "server.xml". 

 

NOTE Make a note of the servlet port configured. This information is 

required during the installation of OFSAA Application Pack. 

7.2.3.4 SSL Port Configuration 

If you need to configure and access your OFSAA setup for HTTPS access, ensure that the following 
connect tag under "Define a SSL HTTP/1/1 Connector on port 8443" in 

"<Tomcat_installation_folder>/conf/server.xml" file is uncommented for SSL 

Configuration. (By default, it is commented). 
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<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" 

 

NOTE Make a note of the servlet port configured. This information 

would be required during the installation of OFSAA Application 

Pack. To enable https configuration on Infrastructure, assign 

value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for 

SILENT mode OFSAAI installation. 

 

For more information related to SSL Configuration on Tomcat, refer to http://tomcat.apache.org/. 

7.2.3.5 Apache Tomcat Memory Settings 

To configure the Apache Tomcat Memory Settings: 

1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin. 

2. Edit this file for customizing the memory settings and garbage collector settings depending on the 
available hardware configuration. 

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m. 

Example: 

if [ -z "$LOGGING_MANAGER" ]; then 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m 

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager" 

else 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER" 

fi 

7.2.3.6 Configuration for Axis API  

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-

1_4/webapps/axis/WEB-INF/lib and place it in under <Tomcat Installation 

Directory>/lib and restart the Tomcat Server 

7.2.3.7 Configuring Tomcat for User Group Authorization and Data Mapping 

Users with system authorization roles can access User Group Authorization. However, to make it 
available on Tomcat web server, you have to perform the following configuration steps: 

1. Navigate to the $CATALINA_HOME/conf folder and open web.xml file. 

2. Enter the following in the web.xml file. 

<init-param> 

<param-name>mappedfile</param-name> 

<param-value>false</param-value> 

http://tomcat.apache.org/
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</init-param> 

3. Save and close the file. 

7.2.3.8 Uninstalling WAR Files in Tomcat 

To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat 
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8 Appendix B: Configuring Resource Reference in Web 
Application Servers 

8.1 Configuring Resource Reference in Web Application Server 

This appendix includes the following topics: 

• Configure Resource Reference in WebSphere Application Server  

• Configure Resource Reference in WebLogic Application Server 

• Configure Resource Reference in Tomcat Application Server 

8.1.1 Configure Resource Reference in WebSphere Application Server 

This section is applicable only when the Web Application Server type is WebSphere. 

This section includes the following topics: 

• Create JDBC Provider 

• Create Data Source 

• J2C Authentication Details 

• JDBC Connection Pooling  

8.1.1.1 Create JDBC Provider 

1. Open the WebSphere admin console in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is displayed.  

2. Login with the user ID that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The JDBC 
Providers window is displayed. 
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4. JDBC Providers 

5. Select the Scope from the drop-down list. Scope specifies the level at which the resource 
definition is visible. 

6. Click New to add new JDBC Provider under the Preferences section. The Create new JDBC 
provider window is displayed. 

 

7. Create a new JDBC Provider 

8. Enter the following details: 
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a. Database Type - Oracle 

a. Provider Type- Oracle JDBC Driver 

b. Implementation Type- Connection pool data source 

c. Name- The required display name for the resource 

d. Description - The optional description for the resource 

9. Click Next.  

Enter database class path information 

10. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the trailing 
slash file separators.  

11. The Oracle JDBC driver can be downloaded from the following Oracle Download site: 

• Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers 

• Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers 

12. Once downloaded, you need to copy the file in the required folder on the server. 

 

NOTE Refer Appendix O for identifying the correct 

“ojdbc<version>.jar” version to be copied. 

 

13. Click Next. The Summary window is displayed. 

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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Summary 

14. Verify the details and click Finish to create the JDBC Provider. 

15. The options to Save and Review are displayed. Click Save. 

8.1.1.2 Create Data Source 

The steps given below are applicable for both CONFIG and ATOMIC data source creation. 

1. Open this URL in the browser window: http://<ipaddress>:<administrative console 
port>/ibm/console. (https if SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > Data sources option. The Data 
sources page is displayed. 
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Data Sources 

4. Select the Scope from the drop down list. Scope specifies the level at which the resource 
definition is visible. 

5. Click New. The Create a Data Source window is displayed. 

 

Create a data source 

6. Specify the Data Source name and JNDI name for the new "Data Source". 

7. The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as the 
"Information Domain" name.  

8. Click Next. The Select JDBC provider window is displayed. 
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Select JDBC provider 

9. Select the option Select an Existing JDBC Provider and select the required JDBC provider from 
the drop-down list. Click Next. 

 

10. Enter database specific properties 

11. Specify the database connection URL. 

For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID> 

12. Select Data Store Helper Class Name from the drop-down list and ensure that the checkbox 
Use this data source in container managed persistence (CMP) is selected.  

 

NOTE For RAC configuration, provide the RAC URL specified during 

installation 

 

For Example: 
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HO

ST=10.11.12.13)(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.14)(PO

RT=1521))(LOAD_BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pq

adb))) 

13. Click Next. 
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Setup security aliases 

14. Map the J2C authentication alias, if already created. If not, you can create a new J2C 
authentication alias by accessing the link given (Global J2C authentication alias) or you can 
continue with the data source creation by clicking Next and then Finish. 

 

Summary 

15. You can also create and map J2C authentication alias after creating the data source. 

16. You must create another Data source by following the aforementioned procedure with 
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure. 

8.1.1.3 J2C Authentication Details 

The steps given below are applicable for creating both config and atomic J2C Authentication. 

To create J2C Authentication details: 

1. Select the newly created Data Source and click JAAS - J2C authentication data link under 
Related Items.  



APPENDIX B: CONFIGURING RESOURCE REFERENCE IN WEB APPLICATION SERVERS 

CONFIGURING RESOURCE REFERENCE IN WEB APPLICATION SERVER 

OFS MARKET RISK MEASUREMENT AND MANAGEMENT APPLICATION PACK  |  91 

 

JAAS- J2C authentication data 

2. Click New under the Preferences section. 

 

JAAS- J2C authentication data- New 

3. Enter the Alias, User ID, Password, and Description. Ensure the following: 

▪ User ID is the Oracle user ID created for the respective CONFIG and ATOMIC Schema for 
the “Information Domain”. 

▪ Specify the CONFIG database user ID and password information for the jdbc/FICMASTER 
data source, and specify the ATOMIC database user ID and password information for the 
ATOMIC schema data source that you created earlier. 

4. Click Apply and save the details. 

8.1.1.4 JDBC Connection Pooling 

To define the JDBC connection pooling ensure that you have created JDBC Provider and Data source 
to access the data from the database. 
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1. Expand the Resources option in the LHS menu and click JDBC > Data sources option. The Data 
sources page is displayed. 

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools. 

 

Connection Pools 

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the aforementioned 
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as required. 
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8.1.2 Configure Resource Reference in WebLogic Application Server 

This section is applicable only when the Web Application Server is WebLogic. 

This section includes the following topics: 

• Create Data Source 

• Create GridLink Data Source 

• Configure Multi Data Sources 

• Advanced Settings for Data Source 

• JDBC Connection Pooling 

In WebLogic, you can create "Data Source" in the following ways: 

• For a Non RAC Database instance, Generic Data Source has to be created. See Create Data 
Source. 

• For a RAC Database instance, Gridlink Data Source has to be created. See Create GridLink Data 
Source. 

• When Load Balancing/Fail over is required, Multi Data Source has to be created. See Configure 
Multi Data Sources. 

8.1.2.1 Create Data Source 

The steps given below are applicable for both config and atomic data source creation. 

1. Open WebLogic Admin Console in the browser window: http://<ipaddress>:<administrative 
console port>/console. (https if SSL is enabled). The Welcome window is displayed.  

2. Login with the Administrator Username and Password.  

 

Welcome 

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary of JDBC 
Data Sources window is displayed. 
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Summary of JDBC Data Sources 

4. Click New and select Generic Data Source option. The Create a New JDBC Data Source 
window is displayed. 

5. You can also select GridLink Data Source or Multi Data Source while creating a Data Source. 
For more information, see Create GridLink Data Source or Configure Multi Data Sources. 

 

Create a New JDBC Data Source 

6. Enter JDBC data source Name, JNDI Name, and select the Database Type from the drop-down 
list. Click Next. 

7. Ensure the following: 

▪ The JNDI Name field should be in the format "jdbc/informationdomain" 

▪ Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.  
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▪ JNDI Name is the same as mentioned in web.xml file of OFSAAI Application. 

▪ Required "Database Type" and "Database Driver" should be selected. 

 

JDBC Data Source Properties 

8. Select the Database Driver from the drop-down list. You need to select the Database Driver 
depending on database setup, that is, with or without RAC. Click Next. 

 

Transaction Options 

9. Select the Supports Global Transactions checkbox and the One-Phase Commit option. 

10. Click Next. The Connection Properties window is displayed. 
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Connection Properties 

11. Enter the required details such as the Database Name, Host Name, Port, Oracle User Name, 
and Password.  

12. Click Next. The Test Database Connection window is displayed. 
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Test Database Connection 

13. Verify the details and click Test Configuration and test the configuration settings. 

A confirmation message is displayed stating "Connection test succeeded." 

14. Click Finish. The created "Data Source" is displayed in the list of Data Sources. 

 

NOTE "User ID" is the Oracle user ID that is created for the respective 

CONFIG and ATOMIC schema of the respective "Information 

Domain". 

 

"User ID" to be specified for data source with "FICMASTER" as 

"JNDI" name should be the Oracle user ID created for the 

CONFIG schema. 

 

15. Select the new Data Source and click the Targets tab.  
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Select Targets 

16. Select the AdminServer option and click Finish. 

8.1.2.2 Create GridLink Data Source 

If you have selected the option, New > GridLink Data Source while creating the "Data Source", you 
can directly specify the JDBC URL as indicated. 

 

Create a New JDBC GridLinkData Source 

1. Enter Data Source Name, and JNDI Name. 

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the XA 
Driver checkbox is not selected. Click Next. 
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JDBC GridLinkData Source- Connection Properties 

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The created 
"Data Source" is displayed in the list of Data Sources. 

8.1.2.3 Configure Multi Data Sources 

A JDBC multi data source is an abstraction around a group of data sources that provides load balancing 
and failover between data sources. As with data sources, multi data sources are also bound to the JNDI 
tree. Applications can look up a multi data source on the JNDI tree and then reserve a database 
connection from a data source. The multi data source determines from which data source to provide the 
connection. 

When the database used is Oracle RAC (Real Application Clusters) which allows Oracle Database to 
run across a set of clustered servers, then group of data sources can be created for instances running 
on a set of clustered servers and a JDBC multi data source can be created so that applications can look 
up a multi data source on the JNDI tree to reserve database connection. If a clustered server fails, 
Oracle continues running on the remaining servers. 

1. Open WebLogic Admin Console in the browser window: http://<ipaddress>:<administrative 
console port>/console. (https if SSL is enabled). The Login window is displayed.  

2. Login with the "User ID" that has admin rights. 

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources. The 
Summary of JDBC Multi Data Sources window is displayed.  
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Summary of JDBC Multi Data Sources 

4. Click New. The New JDBC Multi Data Source screen is displayed. 

 

NOTE Ensure that the Data Sources which needs to be added to new 

JDBC Multi Data Source has been created. 

 

 

Configure the  Multi Data Source 

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the drop-down 
list. Click Next. 
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NOTE • The JNDI Name has to be specified in the format 

jdbc/infodomname.  

• JNDI Name of the Data Sources that will be added to 

new JDBC Multi data source should be different from 

the JNDI name specified during Multi Data Source.  

Same steps needs to be followed to create a 

mandatory data source pointing to the "configuration 

schema" of infrastructure with jdbc/FICMASTER as 

JNDI name for Data Source.  

• Same steps needs to be followed to create a 

mandatory data source pointing to the "configuration 

schema" of infrastructure with jdbc/FICMASTER as 

JNDI name for Data Source. 

• JNDI Name provided in multi data source should be the 

same name that will be mentioned in the web.xml file of 

OFSAAI Application. 

• You can select the Algorithm Type as Load-Balancing. 

 

 

Select Targets 

6. Select the AdminServer check box and click Next. 

 

Select Data Source Type 

7.  Select the type of data source which will be added to new JDBC Multi Data Source. Click Next. 
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Add Data Sources 

8.  Map the required Data Source from the Available Data Sources. Click Finish. 

9. The New JDBC Multi Data Source is created with added data sources. 

8.1.2.4 Advanced Settings for Data Source 

1. Click the new Data Source fromt the Summary of JDBC Data Sources window. The Settings for 
<Data Source Name> window is displayed. 

2. Select the Connection Pooling tab given under Configuration. 

3. Go to the Advanced option at the bottom of the page, and check the Test Connection of 
Reserve checkbox (Enables WebLogic Server to test a connection before giving it to a client). 

4. To verify if the data source is valid, select "Data Source name". For example, FICMASTER. 

 

Settings for <Data Source Name> 

5. Select the server and click Test Data Source. 

A message is displayed indicating that the test was successful. 

6.  Once the "Data Source" is created successfully, the following messages are displayed: 

▪ All changes have been activated. No restart is necessary. 

▪ Settings updated successfully.  
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7. If not, follow the steps given above to recreate the data source.  

8.1.2.5 JDBC Connection Pooling 

To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data source 
to access the data from the database. 

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home 
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source-
<INFODDOM_NAME> 

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment by 1, 
Statement Cache Type to LRU, and Statement Cache Size to 10. 

3.  Click Save. 

8.1.3 Configure Resource Reference in Tomcat Application Server 

This section is applicable only when the Web Application Server is Tomcat. 

This section includes the following topics: 

• Create Data Source 

• JDBC Connection Pooling 

• Class loader configuration for Apache Tomcat 

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/lib and place it in 

<Tomcat Home>/lib.  

 

NOTE Refer Appendix O for identifying the correct 

ojdbc<version>.jar version to be copied. 

 

8.1.3.1 Create Data Source 

To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the following 
block of text by replacing the actual values in server.xml. 

 

NOTE The User-IDs for configuration/ atomic schemas have the prefix 

of SETUPINFO NAME depending on the value set for 

PREFIX_SCHEMA_NAME in <<APP 

Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. For 

example:  if the value set for SETUPINFO NAME is DEV and 

PREFIX_SCHEMA_NAME is Y and the schema name was 

mentioned as ofsaaconf, then the actual schema created in 

the database would be DEV_ofsaaconf. 

 

<Context path ="/<context name>" docBase="<Tomcat Installation 

Directory>/webapps/<context name>" debug="0" reloadable="true" 

crossContext="true"> 
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<Resource auth="Container"  

name="jdbc/FICMASTER" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the configuration schema>"  

password="<password for the above user id>"  

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxTotal="100"  

maxIdle="30" 

maxWaitMillis="10000"/> 

<Resource auth="Container" 

name="jdbc/< INFORMATION DOMAIN NAME >" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the atomic schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxTotal="100" 

maxIdle="30" 

maxWaitMillis="10000"/> 

</Context> 

 

NOTE The <Resource> tag must be repeated for each Information 

Domain created. After the above configuration, the "WAR" file 

has to be created and deployed in Tomcat. 

 

8.1.3.2 JDBC Connection Pooling 

To define the JDBC connection pooling, do the following: 

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path 

$TOMCAT_DIRECTORY/lib/. 

 

NOTE Refer Appendix O for identifying the correct “ojdbc<version>.jar” 

version to be copied. 

 

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the below 
changes, which is required for connection pooling. 
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<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " 

debug="0" reloadable="true" crossContext="true"> 

<Resource auth="Container" 

name="jdbc/ $INFODOM_NAME$" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username=" $ATOMICSCHEMA_USERNAME$" 

password="$ATOMICSCHEMA_PASSWORD$" 

url="$JDBC_CONNECTION_URL" 

maxTotal="100"  

maxIdle="30" 

maxWaitMillis="10000"/> 

removeAbandoned="true" removeAbandonedTimeout="60" 

logAbandoned="true"/> 

</Context> 

 

NOTE • $APP_DEPLOYED_PATH$ should be replaced by 

OFSAAI application deployed path. 

• $INFODOM_NAME$ should be replaced by Infodom 

Name. 

• $ATOMICSCHEMA_USERNAME$ should be replaced 

by Atomic schema database user name. 

• $ATOMICSCHEMA_PASSWORD$ should be replaced 

by Atomic schema database password. 

• $JDBC_CONNECTION_URL should be replaced by 

JDBC connection string 

jdbc:Oracle:thin:<IP>:<PORT>:<SID>.  

• For example, jdbc:oracle:thin 10.80.50.53:1521:soluint 

Note: If you use Oracle Wallet for database password 

configuration, see Creation of Oracle Wallet on OFSAA 

Server. 

• The User-IDs for configuration/ atomic schemas have 

the prefix of SETUPINFO NAME depending on the 

value set for PREFIX_SCHEMA_NAME in <<APP 

Pack>>_SCHEMA_IN.XML file of Schema Creator 

Utility.  

• For example: if the value set for 

PREFIX_SCHEMA_NAME is DEV and the schema 

name was mentioned as ofsaaconf, then the actual 

schema created in the database would be 

DEV_ofsaaconf. 
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8.1.4 Class loader configuration for Apache Tomcat 

1. Edit the server.xml available in $TOMCAT_HOME/conf/ folder. 

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the <Resource> 

tag. This is applicable only when the web application server is Apache Tomcat 8. 

3. Add tag <Loader delegate="true" /> within the <Context> tag, above the <Resource> tag in 
server.xml file.  

 

NOTE This configuration is required if Apache Tomcat version is 8. 
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9 Appendix C: Creating and Deploying EAR/ WAR File 

9.1 Creating and Deploying EAR/WAR File 

This appendix includes the following topics: 

• Creating EAR/WAR File  

• Deploying EAR/WAR File 

9.1.1 Creating EAR/WAR File 

To create EAR/WAR File, follow these steps: 

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server. 

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file.  

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken" message 
is displayed and you will be returned to the prompt. 

 

Creating EAR/ WAR File 

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.  
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NOTE The <contextname> is the name given during installation.  

This process overwrites any existing version of EAR file that 

exists in the path. 

In case of OFSAA configured onTomcat installation, 

<contextname>.war will be created. 

ANT warning for tools.jar can be ignored while executing 

./ant.sh 

 

9.1.2 Deploying EAR/WAR File 

The OFSAA Application EAR/ WAR file is generated at $FIC_WEB_HOME on the OFSAA Installed 
server. Locate the <contextname>.ear/ .war file for deployment. 

This section includes the following topics: 

• Deploying WebSphere EAR/WAR Files 

• Deploying WebLogic EAR/WAR Files 

• Deploying Tomcat WAR Files 

 

NOTE Ensure to clear the application cache prior to the deployment of 

Application Pack Web Archive. This is applicable to all Web 

Servers (WebSphere, WebLogic, and Tomcat). For more 

information, refer Clearing Application Cache section. 

 

9.1.2.1 Deploying EAR/WAR Files on WebSphere 

To deploy WebSphere EAR/WAR File, follow these steps: 

1. Start WebSphere Profile by navigating to the path 
"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<

Profile_Name>/bin/" and execute the command: 

./startServer.sh server1 

2. Open the following URL in the browser: http://<ipaddress>:<Administrative Console 

Port>/ibm/console. (https if SSL is enabled). The login screen is displayed.  
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3. Login Window 

4. Enter the user credentials with admin privileges and click Log In. 

5. From the LHS menu, select Applications and click New Application. The New Application 
window is displayed. 

 

6. New Application 

7. Click New Enterprise Application. The Preparing for the application installation window is 
displayed.  
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Preparing for the application installation 

8. Select Remote File System and click Browse. Select the EAR file generated for OFSAA to 
upload and install. Click Next.  

 

Installation Options 

9. Select the Fast Path option and click Next. The Install New Application window is displayed. 
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Install New Application 

10. Enter the required information and click Next. The Map Modules to Servers window is displayed. 
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Map Modules to Servers 

11.  Select the Web Application and click Next. The Map Resource References to Resources window 
is displayed. 

 

Map Resource References to Resources 

12. Map each resource defined in the application to a resource JNDI name defined earlier. 

13. Click Modify Resource Authentication Method and specify the authentication method created 
earlier.  

14. You can specify "config" for FICMASTER resource or "atomic" for atomic resource as the 
authentication method. 

15. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts for Web 
Modules window is displayed. 
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Map Virtual host for Web Modules 

16. Select the Web Application check box and click Next. The Summary page is displayed. 

 

Summary 

17. Click Finish and deploy the Infrastructure Application on WebSphere. 

On successful installation, a message is displayed.  

18. Click Save and save the master file configuration. The details are displayed in the Master File 
Configuration window. 
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9.1.2.1.1 Start the Application 

1. Expand Applications > Application Type > WebSphere enterprise applications. The 
Enterprise Applications window is displayed. 

 

Enterprise Applications 

2. Select the installed application and click Start. 

 

NOTE <profile name> is the profile name given while creating the 

WebSphere profile. 

<cell name > is the cell name given during profile creation  

<contextname> is the context name given during installation 

 

9.1.2.1.2 .Explode EAR – Weblogic Deployment 

To explode EAR, follow the below steps: 

1. Create the "applications" folder under domain name. For example, 
/Bea/user_projects/domains/ <Domain _name>/applications. 

2. Create <context_name>.ear folder under "applications" folder.  

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to 
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<cont
ext_name>.ear. 

4. Explode the <context_name>.ear file by executing the command: 

jar -xvf <context_name>.ear 

5. Delete the <context>.ear and < context >.war files (recently created) 
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<cont
ext_name>.ear. 

6. Create a directory <context_name>.war under 
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<cont
ext_name>.ear./<context.war> 
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7. Copy <$FIC_WEB_HOME/<context_name>.war file to 
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<cont
ext_name>.ear//<context_name>.war. 

8. Explode the <context_name>.war file by executing the following command to get the directory 
structure: 

jar -xvf <context_name>.war 

9.1.2.2 Deploying EAR/WAR files on WebLogic 

Following are the steps for deploying Infrastructure application that would be created during installation: 

1. Navigate to the path <WebLogic Installation 

directory>/user_projects/domains/<domain name>/bin in the machine in which 

WebLogic is installed. 

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 

3. Open the URL in the browser window: http://<ipaddress>:<admin server port>/console. (https if 
SSL is enabled). The Sign in window of the WebLogic Server Administration Console is 
displayed. 

 

NOTE Ensure that you have started Infrastructure Server by 

executing "./startofsaai.sh" as mentioned in Start 

Infrastructure section 

 

4. Log on to the WebLogic Server by entering the user credentials having privileges to deploy the 
EAR file. 

5. From the Domain Structure LHS menu, click Deployments. The Summary of Deployments 
window is displayed. 

 

Summary of Deployments 
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6. Click Install. The Install Application Assistant window is displayed. 

7. Select the Exploded EAR directory after browsing to the directory where it is saved and click 
Next. 

9.1.2.2.1 Install Application 

To install Application, follow these steps: 

1. Open the Install Application Assistant.  

 

Install Application Assistant 

2. Click Next.  

 

Install Application Assistant 

3. From the Choose targeting style section, select the Install this deployment as an application 
option and click Next. The Optional Settings window is displayed. 
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Optional Settings 

4. Enter a Name for the deployment if required. 

5. Under the Security section, select the DD only option to specify that only roles and policies that 
are defined in the deployment descriptors should be used. 

6. Select I will make the deployment available from the following location option under the 
Source accessibility section.  

7. Click Next to continue. The Deployment Summary window is displayed. 
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Deployment Summary 

8. Select the Yes, take me to the deployment's configuration screen option and click Finish. The 
Settings for <Deployment Name> window is displayed. 

 

Settings for <Deployment Name> 
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9. Review the general configuration details of the deployment. You can also update the 
configuration of the deployment in this window. In the Overview tab you can view the complete 
deployment configuration. 

10. Click Save to update the changes, if any. 

11. For Weblogic 12.2.x versions, On LHS menu, click Domain Name, and navigate to Web 
applications tab to select the checkbox for “Archived Real Path Enabled”. 

 

12. From the LHS menu, click Deployments. The Summary of Deployments window is displayed. 

 

Summary of Deployments 

13. Select the newly deployed Infrastructure application and click Start > Servicing all requests. 
Ensure that the Infrastructure server is up and running. 
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Summary of Deployments 

14. The State of the deployed application is displayed as Active if started successfully. 

9.1.2.3 Deploying Tomcat WAR Files on Tomcat 

Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure are 
uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to uninstall 
the previously deployed Infrastructure war files. 

On the machine that hosts Tomcat, follow the below steps outlined to deploy Infrastructure application: 

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to <Tomcat 

Installation Directory>/webapps/ directory.  
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2. Click Manager App. The Connect to dialog box is displayed.  

3. Enter the User Id and Password that has admin rights and click OK. (For user creation in 
tomcat, see Tomcat User Administration. The Tomcat Web Application Manager window is 
displayed with the list of all the applications deployed. 

 

4. In the Deploy section, enter the Context Path provided during the installation as "/<context-

name>". Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_ 

HOME/<context-name>.war") in the WAR or Directory URL field and click Deploy.  
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5. On successful application deployment, a confirmation message is displayed. Start the Tomcat 
server. Refer Starting Web Application Servers for more details. 
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10 Appendix D: Starting / Stopping Services  

10.1 Start/Stop OFSAA Infrastructure Services 

This chapter details on how to start and stop OFSAA Infrastructure services. This chapter includes the 
following sections: 

• Starting Infrastructure services 

• Starting Web Application Servers 

• Stopping Infrastructure Services 

• Stopping Web Application Servers 

10.1.1 Starting Infrastructure Services 

Once the installation of Infrastructure has been completed successfully and the post-installation steps 
are completed, the servers must be started. Log on to each machine and run the .profile file. All servers 
mentioned must be started from the same shell encoding. The servers mentioned below are dependent 
on each other. It is mandatory to maintain the order in which the servers are started. Allow each of the 
servers to initialize completely before starting the next server. 

1. On the machine in which Infrastructure Application components have been installed, navigate to 
$FIC_APP_HOME/common/FICServer/bin and execute the following command to start the 

Infrastructure Server. 

./startofsaai.sh  

 

NOTE You can also start the Infrastructure Server by executing the 

command "nohup ./ startofsaai.sh &". Starting the 

process using "nohup" and "&" will return the command prompt 

without having to wait till the process completes. However, this 

command cannot be used when you are starting the server for 

the first time or starting after changing user password in the 

configuration database schema. You can also start the 

Infrastructure Server by executing the command "nohup ./ 

startofsaai.sh &". Starting the process using "nohup" and 

"&" will return the command prompt without having to wait till the 

process completes. However, this command cannot be used 

when you are starting the server after changing user password 

in the configuration database schema. 

 

2. Select the required webserver start up option from the table. 
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Start up Option Description 

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and 

execute the command: ./startServer.sh server1. 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to 
<WebLogic Installation 

directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh 

-d64. 

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop and start the application <context name>.ear. 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the 

command: ./catalina.sh run 

 

3. Start ICC server: 

▪ On the machine in which Infrastructure default Application components have been installed, 
navigate to $FIC_HOME/ficapp/icc/bin and execute the command. 

▪ ./iccserver.sh 

 

NOTE Only Infrastructure Default Application Server would hold ICC 

component. 

 

4. Start Back-end Services: 

▪ On the machine on which Infrastructure Database components have been installed, navigate 
to $FIC_DB_HOME/bin and execute the command to start "Agent server": 

./agentstartup.sh  

Or 

▪ Start Back-end services using the command: 

nohup ./agentstartup.sh & 

 

NOTE This agent internally starts the Router, Message Server, OLAP 

data server and AM services. 

 

10.1.2 Starting Web Application Servers 

Start the Web Application Server depending on the type from the following table. 
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Start up Option Description 

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and 

execute the command: ./startServer.sh server1. 

Starting WebLogic Domain On the machine in which WebLogic is installed navigate to 
<WebLogic Installation 

directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh 

-d64. 

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop and start the application <context name>.ear. 

Starting Tomcat Application On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the command: 
./catalina.sh run 

 

10.1.3 Stopping Infrastructure Services 

To stop Infrastructure services: 

1. On the machine in which Infrastructure Application components have been installed, navigate to 
$FIC_APP_HOME/common/FICServer/bin and execute the command: 

./stopofsaai.sh 

2. To stop ICC server, on the machine in which Infrastructure default Application components have 
been installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the command: 

./iccservershutdown.sh 

 

NOTE Only Infrastructure Default Application Server would hold ICC 

component. 

 

3. To stop Back-end server, on the machine in which Infrastructure database components have 
been installed, navigate to $FIC_DB_HOME/bin and execute the command: 

./agentshutdown.sh 

10.1.4 Stopping Web Application Servers 

Stop the Web Application Server depending on the type from the following table. 

 

Stop Option Description 

Stopping WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and 

execute the command: ./stopServer.sh server1 
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Stop Option Description 

Stopping WebLogic Domain On the machine in which WebLogic is installed navigate to 
<WebLogic Installation 

directory>/user_projects/domains/<domain 

name>/bin and execute the command: startWebLogic.sh 

-d64. 

Note: If WebLogic is already running, access the WebLogic Admin 
Console. Stop the application <context name>.ear. 

Stopping Tomcat Application On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the 

command: ./shutdown.sh 
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11 Appendix E: Accessing OFSAA Application 

This appendix gives details about the steps to be performed to access OFSAA Application. 

11.1 Accessing OFSAA Infrastructure 

1. From your desktop, open the browser and enter the URL in below format: 

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp 

For example, https://111.222.333.444:5555/ofsaa/login.jsp 

The OFSAA login screen is displayed. 

 

2. With installation of every OFSAA Application Pack, there are two seeded user profiles configured 
in the system: 

▪ SYSADMN – System Administrator 

▪ SYSAUTH – System Authorizer 

 

NOTE For SYSADMN and SYSAUTH, the default password is 

password0. 

 

3. Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the 
SYSADMN login USER ID). Enter the password that was provided during installation. On the first 
login, you will be prompted to change the password. 

11.1.1 OFSAAI Login 

While accessing Oracle Financial Services Analytical Applications Infrastructure, the Splash screen is 
as displayed: 

You can select the required language from the Language drop-down list. The language options 
displayed in the drop down are based on the license. Based on the selection of Language, the 
appropriate language login screen is displayed. 

Enter the User ID and Password provided by the System Administrator and click Login. You will be 
prompted to change your password on your first login. Alternatively, you can also choose to change 
your password any time. 

 



APPENDIX E: ACCESSING OFSAA APPLICATION 

ACCESSING OFSAA INFRASTRUCTURE 

OFS MARKET RISK MEASUREMENT AND MANAGEMENT APPLICATION PACK  |  128 

 

In the Change Password screen, enter a new password, confirm it and click OK to view the Splash 
screen. Refer to the following guidelines for Password Creation: 

• Passwords are displayed as asterisks (stars) while you enter. This is to ensure that the password 
is not revealed to other users. 

• Ensure that the entered password is at least six characters long. 

• The password must be alphanumeric with a combination of numbers and characters. 

• The password should not contain spaces. 

• Passwords are case sensitive and ensure that the Caps Lock is not turned ON. 

• By default the currently used password is checked for validity if password history is not set. 

• New password should be different from previously used passwords based on the password 
history which can be configured. 

• If you encounter any of the following problems, contact the System Administrator: 

▪ Your user ID and password are not recognized. 

▪ Your user ID is locked after three consecutive unsuccessful attempts. 

▪ Your user ID has been disabled. 

▪ Guest user cannot change the password. 
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12 Appendix F: Post Deployment Configurations 

12.1 Post Deployment Configuration 

This chapter covers the following topics: 

• Deploying the Application 

• Logging as System Administrator  

• Creating Application Users 

• Mapping Application User(s) to User Group 

12.2 Deploying the Application 

12.2.1 OBIEE Configuration Steps to Deploy OFS MRMM Analytics 

The OFS MRMM Analytics application release 8.0.8.0.0 is based upon a dedicated reporting mart built 
from the new Fusion Financial Services Data Model. OFS MRMM Analytics 8.0.8.0.0 leverages several 
components of Oracle Business Intelligence Enterprise Edition (OBIEE) technology including 
Dashboards and Answers. 

Following are the steps to configure OFS MRMM Analytics: 

1. Make sure Oracle Business Intelligence (Version 12.2.1.2.0) installation is completed and 
available.  

2. Start OBIEE services and login  

a. Log in to Linux server 

b. Navigate to the path <OBIEE_HOME>/user_projects/domains/bi/bitools/bin 

c. Run ./start.sh 

3. Deploy RPD and webcat file(s). 

a. Navigate to folder $FIC_HOME/MRMM_BI/RPD/ which contains MRMM_BI.rpd and 

$FIC_HOME/MRMM_BI/catalog/ which contains MRMM_BI.catalog. 

b. RPD Deployment: 

i. Navigate to folder $FIC_HOME/MRMM_BI/RPD/ which contains MRMM_BI.rpd and 

$FIC_HOME/MRMM_BI/catalog/ which contains MRMM_BI.catalog. then copy into 

local system 

ii. Log in to Linux. 

iii. Copy the rpd from local system to the below path 
<OBIEE_HOME>user_projects/domains/bi/tmp 

iv. Navigate to the path: 
<OBIEE_HOME>/user_projects/domains/bi/bitools/bin 

v. Replace the <rpdLocationPath> with the rpd location where the rpd.(for example : 
<OBIEE_HOME>/user_projects/domains/bi/tmp/ MRMM_BI.rpd) 

vi. Provide the analytics username/ password, and execute the below command: 
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./datamodel.sh  uploadrpd -I <rpdLocationPath>  -SI ssi -U 

username -P password 

vii. Enter the RPD Password ‘Administrator1’. The RPD deployment is complete.  

c. Web catalog Deployment: 

i. Copy the catalog file from the path $FIC_HOME/MR_BI/catalog/ to your local system. 

ii. Open the catalog manager, navigate to the File menu and open the catalog online (File-
>Open catalog) by giving the necessary credentials based on your setup (Type - 
(online), URL - (http://<ipaddress>:<port>/analytics-ws) 

iii. Once the catalog is opened, it will display a folder structure on left hand side. Select the 
catalog root ->Shared folder in the LHS tree structure. Go to 'File' menu and select 'Un 
archive'. It will ask for the path for a file. 

iv. Browse the path of the archived catalog file saved in your local folder using the 'Browse' 
button and click 'OK'. 

v. The catalog must be unarchived in the shared folder for the reports to display. A pop up 
for successful operation is displayed. 

vi. Restart the presentation services once again. 

vii. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) 

Login with credentials based on your setup, and verify that catalog is available. 

⎯ Click on catalog in OBIEE application right top menu list 

⎯ In LHS Navigate to shared folders and verify all the folders are available 

4. Configure tnsnames.ora. 

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin. 

b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA 
application. 

c. Save the tnsnames.ora. 

5. Configure ODBC data source to connect to Oracle BI Server. 

a. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 

b. Select the ‘System DSN’ tab and click ‘Add’ Button. 

c. Select a driver specific to (Oracle BI Server 12g) and click ‘Finish’ Button. 

d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of the BI Server and 
click ‘Next’). 

e. Enter Oracle BI Server login id and password (Enter User Name and Password created at the 
time of OBIEE installation). Click ‘Next’. 

f. Click ‘Finish’. 

6. Modify connection pool and set the properties.  

a. Open the OBI Administration tool. 

b. Select Start > Programs > Oracle Business Intelligence > BI Administration. 

c. Select File > Open > Online and select ‘MRMM_BI.rpd’ file. 

d. In the Open dialog box, select and open ‘MRMM_BI.rpd’ file. 

e. Enter Repository password as ‘Administrator1’. 
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f. In the "Physical" layer, double-click the Connect Pool: “MRMM” to open its properties. 

g. In the ‘General’ tab, edit / check the following entries: 

i. Call Interface: (OCI 10g/11g). 

ii. Data source name: <tnsnames.ora entry created in the step 8.b connecting to OFSAA 
atomic schema>. 

iii. User name: <enter atomic db user name>. 

iv. Password: <enter atomic db user password>. 

v. Confirm password and Click 'OK' to close the window. 

vi. Similarly, configure the connection pools for ‘MRMM_IB’. 

vii. Click 'Save' to save the RPD file. 

h. Click 'No' for the Global Consistency Message. 

i. Close the RPD file (File / Exit). 

7. Login into OFSMRMM Application using the URL: 
http://<Host_IP_Address>:<webport>/analytics.(Replace the port number based on 

your setup). 

12.2.2 Enabling the Auto-Complete Prompt Functionality 

1. Log in to Linux 

2. Navigate to the path 
<OBIEE_HOME>/user_projects/domains/bi/config/fmwconfig/biconfig/OBIPS 

3. Open instanceconfig.xml file (make a backup of the file prior to making any changes). 

4. Add the following code between the <ServerInstance> ... </ServerInstance> tags: 

<Prompts> 

<MaxDropDownValues>256</MaxDropDownValues> 

<AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues> 

<AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox> 

<AutoCompletePromptDropDowns> 

<SupportAutoComplete>true</SupportAutoComplete> 

<CaseInsensitive>true</CaseInsensitive> 

<MatchingLevel>MatchAll</MatchingLevel> 

<ResultsLimit>50</ResultsLimit> 

</AutoCompletePromptDropDowns> 

</Prompts> 

5. Restart the OBIEE Services. 

12.2.3 Increasing Maximum Visible Rows in the Table 

1. Log in to Linux 

2. Navigate to the path 
<OBIEE_HOME>/user_projects/domains/bi/config/fmwconfig/biconfig/OBIPS 
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3. Open instanceconfig.xml file (make a backup of the file prior to making any changes). 

4. Add the following code between the <ServerInstance> ... </ServerInstance> tags: 

<Table>                

<DefaultRowsDisplayedInDelivery>75</DefaultRowsDisplayedInDelivery>                

<DefaultRowsDisplayedInDownload>2500</DefaultRowsDisplayedInDownload> 

<MaxCells>1000000</MaxCells> 

<MaxVisiblePages>2500</MaxVisiblePages> 

<MaxVisibleRows>500000</MaxVisibleRows> 

<MaxVisibleSections>5000</MaxVisibleSections> 

  </Table> 

5. Restart the OBIEE Services. 

12.2.4 Increasing Number Formats to Five Decimals 

1. Backup and edit the _datatype_format file located at the below location: 

<OBIEE_HOME>user_projects/domains/bi/bidata/service_instances/ssi/metad

ata/content/catalog/root/system/metadata 

2. Modify the below from  

<saw:dataFormat minDigits="0" maxDigits="0" commas="true" 

negativeType="minus" xsi:type="saw:number"/> 

To, 

<saw:dataFormat minDigits="5" maxDigits="5" commas="true" 

negativeType="minus" xsi:type="saw:number"/> 

3. Save and exit the file 

4. Restart the OBIEE Services 

12.2.5 Post Installation Changes in instanceconfig.xml File  

Perform the following modifications in the instanceconfig.xml file as post installation changes:  

1. Backup and edit the instanceconfig.xml file located at: 
$ORACLE_HOME/user_projects/domains/bi/config/fmwconfig/biconfig/OBIPS 

 

Tag to be changed  Changes 

<Views> <Views> 

<Charts> 

<DefaultWebImageType>flash</DefaultWebImageType> 

</Charts> 

</Views> 
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Tag to be changed  Changes 

<Security> <Security> 

<CheckUrlFreshness>false</CheckUrlFreshness> 

<EnableSavingContentWithHTML>true</ 

EnableSavingContentWithHTML> 

</Security> 

 

2. Save and exit the file. 

3. Restart the presentation server for the changes to take effect. 

12.3 Logging as System Administrator 

12.3.1 Role of an Administrator 

There are two types of Administrators as defined by the OFS Analytical Applications Infrastructure: A 
User Administrator and System Administrator. 

• System Administration: refers to a process of managing, configuring, and maintaining confidential 
data in a multi-user computing environment. A System Administrator in creates functions, roles, 
and mapping functions to specific roles. A System Administrator also maintains segment 
information, holiday list, and restricted passwords to ensure security within the application. The 
following are the activities of a System Administrator: 

▪ Function Maintenance 

▪ Role Maintenance 

▪ Function-Role Mapping 

• User Administration: is one of the core functions of Security Management which involves 
administrators to create user definitions, user groups, maintain profiles, authorize users and 
usergroups, and map users to groups, domains and roles. A User Administrator controls the user 
privileges in accessing the application and is based on business requirements to provide access 
to view, create, edit, or delete confidential data. 

A User Administrator grants permissions based on user roles and requirements. 

The respective roles must be mapped to administrative user SYSADMN: 

12.3.2 Function Maintenance 

Functions define the privileges to access modules or components in the OFS Market Risk Measurement 
and Management Application and define or modify associated metadata information. Function 
maintenance allows you to create functions for users to ensure only those functions are executed which 
are specific to the user's role.  

For details, see the System Administrator section in OFS Analytical Applications Infrastructure User 
Guide. 

12.3.3 Role Maintenance 

A role is a collection of functions defined for a set of users to execute a specific task. You can create 
roles based on the group of functions to which users are mapped. 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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For details, see the System Administrator section in OFS Analytical Applications Infrastructure User 
Guide. 

See Appendix M for details on the user roles in OFS MRMM. 

12.3.4 Function - Role Mapping  

Function Role Map facilitates you to view and map a set of function(s) to a specific role within the OFS 
Market Risk application. Functions can only be mapped to a defined set of roles to ensure effective 
system security. The system administrator can create new roles and assign the functions as required 
instead of using the default roles.  

For details, see the System Administrator section in OFS Analytical Applications Infrastructure User 
Guide. 

12.3.5 User Group Role Map 

User Group Role Map facilitates System Administrators to map Role(s) to specific User Group(s). Each 
role has a defined function and any user(s) mapped to the role has to perform only those functions. For 
example, the table below lists the user group mapped to a specific role. 

For details, see the User Group Role Map section in OFS Analytical Applications Infrastructure User 
Guide. 

12.4 Creating Application Users 

Create the application users in the OFSAA setup prior to use. 

For details, see User Administrator section from the Oracle Financial Services Analytical Applications 
Infrastructure User Guide. 

12.5 Mapping Application User(s) to User Group 

For details, see User Administrator section from the Oracle Financial Services Analytical Applications 
Infrastructure User Guide. 

With the installation of MRMM Application Pack, preconfigured Application user groups are seeded. 
These user groups are unique to every OFSAA Application Pack and have application roles pre-
configured. 

For more information on seeded User Groups, refer to Appendix M. 

Map the application user (s) to the respective Application User Group (s) and subsequently authorize 
the entitlements by logging in as SYSAUTH (System Authorizer) user. 

For more information, see Mapping/Unmapping Users section from the Oracle Financial Services 
Analytical Applications Infrastructure User Guide. 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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13 Appendix G: Cloning OFSAA Instance 

There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance 
for further project developments, that is, setting up OFSAA instances that are exact copies of the current 
OFSAA instance. For more information on cloning, refer OFSAA Cloning Reference Guide. 

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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14 Appendix H: OFSAA Landing Page 

This appendix includes the following topics: 

• OFSAA Landing Page 

• Enabling a Product within an Application Pack 

14.1 OFSAA Landing Page 

On successful authentication, the OFSAA Landing Page is displayed. This is a common landing page 
for all users until a preferred application landing page is set by the user in the preferences. 

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or 
Application modules. The tabs and links are displayed based on the OFSAA Application accessed and 
the access roles mapped to the logged in user. 

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree 
structure. The RHS Menu holds link(s) to modules in a navigational window format. 

The following tabs are available in the Landing Page: 

• Applications Tab 

• Object Administration Tab 

• System Configuration and Identity Management Tab 

14.2 Applications Tab 

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select 
Application drop-down list displays the OFSAA Applications, based on the logged in user and mapped 
OFSAA Application User Group(s). Links to related modules within Applications and Infrastructure are 
grouped appropriately to maintain a unified experience. 

14.3 Object Administration Tab 

This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select 
Information Domain drop-down list displays the OFSAA Information Domains based on the logged in 
user and mapped OFSAA Application User Group(s). Links to modules that enable object traceability 
and migration of objects are grouped in this tab. 

14.4 System Configuration and Identity Management Tab 

This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules. These 
modules work across Applications/ Information Domains and hence there are no Application and 
Information Domain drop-down lists in this tab. Links to modules that allow the maintenance of setup 
installation and identity management tasks are grouped together in this tab. 

 

NOTE The navigation path differs from Application to Application. That 

is, based on the selected Application, the navigation varies. 

For more details on how to operate on each tab, see OFSAAI 

User Guide available in OTN. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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14.4.1 OFSAA Landing Page for MRMM Administrator 

On successful authentication, the OFSAA 8.0.8 Landing Page is displayed. This is a common landing 
page for all users until a preferred application landing page is set by the user in his preferences.  

 

The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure and/or 
Application modules. The tabs and links are displayed based on the OFSAA Application accessed and 
the access roles mapped to the logged in user. 

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree 
structure. The RHS Menu holds link(s) to modules in a navigational panel format. 

The following tabs are available in the Landing Page: 

• Applications tab 

• Object Administration tab 

• System Configuration and Identity Management tab 

 

NOTE Refer the User Manual for more details on how to operate on 

each tab. 

 

14.5 Enabling a Product within an Application Pack 

You can also enable a product/ application within an application pack post installation at any point of 
time.  

To enable a product through the application UI, follow these steps: 

1. Login to the application as SYSADMN user or any user with System Administrator privileges. 

2. Navigate to System Configurations & Identity Management tab, expand Administration and 
Configuration and select System Configuration. 

3. Click Manage OFSAA Product License(s). The Manage OFSAA Product License(s) window is 
displayed. 
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4. Select an Application pack to view the products in it. The products are displayed in the Products 
in the Application Pack grid.  

5. Select the checkbox to enable a product within the Application Pack which is not enabled during 
installation. 

6. Click VIEW LICENSE AGREEMENT to view the license information. The License Agreement 
section is displayed. 

 

7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE. A pop-up 
message confirmation is displayed showing that the product is enabled for the pack. 

 

NOTE • To use the newly enabled product, you need to map 

your application users to the appropriate product 

specific User_ Group(s) and authorize the actions by 

logging in as System Authorizer. 

• For more information refer to Mapping/Unmapping 

Users section in the Financial Services Advanced 

Analytical Applications Infrastructure User Guide 

available in OTN. 

• To identify the newly enabled product specific 

UserGroups/ Application Pack specific User_Groups, 

refer to the respective Application Pack specific 

Installation and Configuration Guide/ User Manual. 

 

8. This page includes the following sections: 

• INSTALLED APPLICATION PACKS 

• PRODUCTS IN THE APPLICATION PACK 

9. The following fields are displayed in the INSTALLED APPLICATION PACKS section: 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Field Description 

Application Pack ID 

Displays a unique Application Pack ID related to the 

application pack.  

Select the appropriate Pack id using the radio button. The Products 
in the application pack will be displayed below in the PRODUCTS IN 
THE APPLICATION PACKS section. 

Application Pack Name Displays the name of the Application Pack. 

Description Displays the description of the Application Pack. 

Install Date Displays the date when the Application Pack was installed. 

 

10. The following fields are displayed in the PRODUCTS IN THE APPLICATION PACK section: 

 

Field Description 

Enable Select the checkbox to enable a product within an Application Pack. 

Product ID Displays a unique product id for the product. 

Product Name Displays the name of the Product 

Description Displays the description of the product. 

Enable Date Displays the date when the product was enabled. 

 

11. Select an Application Pack by clicking the radio button next to the Application Pack ID field. 

12. Selecting an Application Pack will display below the products within the Application Pack. 

13. Products which were enabled at the time of installation will have the checkbox “ENABLE” 
disabled. You can enable any product within the selected Application Pack by clicking the 
“ENABLE” checkbox against the respective Product ID. 

14. Click on RESET button to cancel the operation and refresh the screen. 

15. Click VIEW LICENSE AGREEMENT button. 

16. The License Agreement section is displayed. 

17. Select the option I ACCEPT THE LICENSE AGREEMENT. 

18. Click ENABLE. 

19. An appropriate pop-up message confirmation is displayed showing that the product is enabled for 
the pack. 
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NOTE To use the newly enabled product, you need to map your 

application users to the appropriate product specific 

User_Group(s) and subsequently, authorize the actions by 

logging in as System Authorizer. 

For more information refer to Mapping/Unmapping Users 

section in the Oracle Financial Services Analytical Applications 

Infrastructure User Guide  

To identify the newly enabled product specific User Groups/ 

Application Pack specific User Groups, refer to the respective 

Application Pack specific Installation and Configuration Guide/ 

User Manual. 

 

https://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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15 Appendix I: Additional Configurations 

15.1 Additional Configurations 

The following sections provide detailed module specific post installation configurations. 

This section includes the following topics: 

• FTP/SFTP Configuration for File Transfer 

• Configuring Infrastructure Server Memory 

• Internet Explorer Settings 

• Retrieving Patch Information 

• OLAP Data Server Configuration 

• Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance 

• OFSAAI Setup Information Fetching Tool 

• Encryption Changer 

• Infrastructure LDAP Configuration 

• Configuration to Enable Parallel Execution of DML statements 

• Configuring Message Details in Forms Designer 

• Clearing Application Cache 

• Configuring Password changes 

• Configuring Java Virtual Machine 

• Configuring Internal Service (Document Upload/ Download) 

15.1.1 FTP/SFTP Configuration for File Transfer 

In OFSAA, certain modules require transfer of files from the web application server to the OFSAA server 
over SSH. 

Follow these steps to ensure the OFSAA server recognizes the web application server during file 
transfers. 

1. Login to the web application server. 

2. Type sftp <user>@<OFSAA Server> 

3. Specify Yes when prompted for permission. 

Are you sure you want to continue connecting (Yes/No)? 

4. This will add an entry into the "known_hosts" file. 

5. A  confirmation message is displayed: 

Permanently added <OFSAA Server> RSA) to the list of known hosts. 

15.1.2 Configure Infrastructure Server Memory 

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic can be 
edited for customizing memory settings and garbage collector settings depending on the available 
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hardware configuration as explained below. These settings are base minimum and has to be 
incremented considering the deployment metrics into account. The increments are usually handled in 
multiples of 128mb for heap and 64mb for stack. 

15.1.2.1 Infrastructure Application Server Memory Settings 

You can configure the Infrastructure Application Memory settings as follows: 

1. Locate .profile file. 

2. Edit X_ARGS field in this file for customizing memory settings and garbage collector settings 

depends on the hardware configuration. 

3. This has a default value X_ARGS_APP ="-Xms200m" 

X_ARGS_APP =" "$X_ARGS" $DELIM -Xmx2048m" 

 

NOTE Modify X_ARGS_APP variable in the .profile file to customize 

Java Memory Settings for Model Upload based on the Data 

Model size. 

For Run and Rule executions, the following value is 

recommended:  

X_ARGS_RNEXE="-Xms1g -Xmx1g -

XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M 

-XX:+UseParallelOldGC -XX:+DisableExplicitGC"  

X_ARGS_RLEXE="-Xms1g -Xmx1g -

XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M 

-XX:+UseParallelOldGC -XX:+DisableExplicitGC" 

 

15.1.3 Internet Explorer Settings 
 

NOTE OFSAAI supports only default zoom setting in Internet Explorer, 

that is, 100%.cookies should be enabled. 

 

The following browser settings have to be specified at every client machine prior to accessing the 
Infrastructure application. 

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window is 
displayed. 

2. Click the Settings button. The Settings window is displayed. 

3. Select the option Everytime I Visit the webpage and click OK. 
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4. In the Internet Options window, select the Security tab and select the Internet option under 
Select a zone to view or change the security settings. 

5. Click Default Level under Security level for this zone. 
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6. Click OK to save. 

7. Click Internet Explorer >> Tools >> Compatibility View Settings. 

8. Enter the OFSAA setup URL in the Add this website field. 

9. Click Add. 

10. Ensure the URL is listed under Websites you've added to Compatibility View. 

11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up Blocker 
option under Pop-up Blocker settings. 
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12. Click Settings. The Pop-up Blocker Settings window is displayed. 

13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field. 

14. Click Add. The OFSAA URL is displayed in the Allowed Sites section. 

15. Click Close. 

16. Click OK in the Internet Options window. 

15.1.4 Retrieve Patch Information 

To identify the list of patches installed on your OFSAA setup, follow these steps: 

1. Login to the OFSAA application as a user with Object AdminAdvanced Role. 

2. Navigate to Object Administration tab, expand Utilities and click Patch Information. 

3. The window displays the list of patches installed on the OFSAA setup across Applications/ 
Platform. 

15.1.5 OLAP Data Server Configuration 

This section is applicable if you are using the OLAP feature of OFSAAI. 

The following parameters must be set to ensure that the system limitations are not exceeded at any 
stage. The values for these OS parameters should be specified based on the expected load at each 
implementation site. 

Example: 

Process Memory Limit 

Max Thread Stack Size 
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Max Number of Threads per Process 

• Sort Buffer settings: This must be set at the Essbase application level appropriate to the 
anticipated load. 

• Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data Services 
that is communicating with an OLAP Data Server, it is imperative to ensure that the cleanup of 
the old instance is completed on the OLAP Data Server before restarting the OFSAAI Server. 
Pause for a period of time based on the load the system was subjected to, before restarting the 
Data Services subsystem. 

15.1.6 Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA 
Instance  

For information on this section, refer OFS Analytical Applications Infrastructure Administration User 
Guide in OTN. 

15.1.7 OFSAAI Setup Information Fetching Tool 

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the related 

information about the OFSAAI Set up such as Operating System Name and version, Database Type 
and Version, OFSAAI architecture, Log file locations and so on. 

To execute "SetupInfo.jar" in console: 

1. Navigate to the path $FIC_HOME. 

2. Enter the command: 

java -jar SetupInfo.jar 

After execution, the output file location is displayed in the console. 

15.1.8 Encryption Changer 

For more information on Encryption Changer, see Key Management section in OFSAAI Administration 
Guide. 

15.1.9 Infrastructure LDAP Configuration 

For more information on LDAP configuration, see OFSAAI Administration Guide. 

15.1.10 Configuration to Enable Parallel Execution of DML statements 

A configuration file, OracleDB.conf has been introduced to accommodate any configurable parameter 

related to operations on oracle database. If you do not want to set a parameter to a specific value, then 
the respective parameter entry can be removed/commented off form the OracleDB.conf file which 

resides in the path $FIC_DB_HOME/conf. 

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_PARALLELISM. 

This parameter indicates the degree of parallelism to be used for a DML operation if parallel DML is 
explicitly enabled in the session with the ENABLE PARALLEL DML clause of the ALTER SESSION 

statement. The default mode of a session is DISABLE PARALLEL DML. If 

CNF_DEGREE_OF_PARALLELISM is not set, then the default degree, as decided by Oracle will be used. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
https://docs.oracle.com/cd/E60058_01/homepage.htm
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15.1.11 Configure Message Details in Forms Designer 

You can configure the Message Details in Forms Designer under Data Entry Forms and Queries module 
by updating the details of mail server in the "NotificationConfig.cfg" file which resides in the path 

$FIC_APP_HOME/common/FICServer/conf. 

Ensure that the "authorized User details" for whom you need to configure the Message details are 
included in Administration > Security Management > User Administrator > User Maintenance window. 

Update the following parameters in the "NotificationConfig.cfg" file: 

 

Parameter Description 

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server. 

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 'true', otherwise 
set value to 'false'. 

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be authenticated, 
otherwise set to 'false'. 

SMTP_USERNAME Username required for logging into SMTP server, if authentication is 
not required use a dummy value. 

SMTP_PASSWORD Password required for logging into SMTP server, if authentication is 
not required use a dummy value. 

SMTP_MAILID If the Messages has to go from a Particular ID that ID need to be 
added. Exchange server forces you set a valid ID that is there in the 
exchange server. (Based on Security settings) 

 

NotificationConfig.cfg File 

Ensure that the authorized User details are included in Administration > Security Management > 
User Administrator > User Maintenance window. 

15.1.12 Clearing Application Cache 

This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).  

Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate to the 
following path depending on the WebServer configured and clear the cache: 

• Tomcat:  

<Tomcat installation folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp 

• WebLogic:  

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

• WebSphere:  

<Websphere installation directory>/AppServer/profiles/<Profile 

name>/temp/<Node name>/server1/<Application name>/<.war file name> 
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15.1.13 Configuring Password changes 

This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic 
Schema passwords. 

15.1.13.1 OFSAA Infrastructure Config Schema password modification 

To change the Config Schema password, perform the following steps: 

1. Change the Config schema User Password in the database. 

2. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

3. Shutdown the OFSAAI App service: 

cd $FIC_APP_HOME/common/FICServer/bin 

./stopofsaai.sh  

4. Start the Infrastructure Server in foreground directly on the server or through X-Windows software 
using the command: 

./startofsaai.sh 

5. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 

details in Server.xml file from the $CATALINA_HOME/conf directory. For Tomcat, both 

Config Schema (FICMASTER resource) and Atomic Schema (<INFODOM_NAME> resource) 
exist.. 

6. If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on 
the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config 
and Atomic data sources will need to be modified). 

7. If you are using WebLogic as Web server: 

a. Login to the WebLogic Administration Console, from the left side menu 

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > 
JDBC >Data Sources. A list of data sources will be populated on the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config 
and Atomic data sources need to be modified). 

8. At the prompt, enter System Password. Enter the "new Config schema" password. The service 
will start and initialize itself if it is able to successfully connect to the DB. 

9. Post successful startup of the service, if required, the Infrastructure server may be shut down and 
restarted in the background using nohup mode. 

15.1.13.1.1 OFSAA Infrastructure Atomic Schema password modification 

To change the Atomic Schema password, perform the following steps: 

1. Change the Atomic schema User Password in the database. 

2. Login to the application from the browser using SYSADMN account or any user id, which has 
System Administrator role mapped. 

3. Navigate to System Configuration > Database Details window. Modify the password as 
explained in the following steps: 
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a. From the Database Master window, select the connection whose password you want to 

modify and click  button from the toolbar. 

b. Click  button corresponding to the Alias Name. The Alias Details window is displayed. 

c. Modify the password in the Auth String field.  

4. If you are using Apache Tomcat as Web server, update the <Context> -> Resource tag 

details in Server.xml file from the $CATALINA_HOME/conf directory. For Tomcat, both 

Config Schema (FICMASTER resource) and Atomic Schema (<INFODOM_NAME> resource) 
exist.. 

5. If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on 
the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config 
and Atomic data sources will need to be modified). 

6. If you are using WebLogic as Web server: 

a. Login to the WebLogic Administration Console, from the left side menu 

b. Under Domain Structure list box, expand the appropriate Domain and navigate to Services > 
JDBC >Data Sources. A list of data sources will be populated on the right side.  

c. Select the appropriate Data Source and edit the connection details. (In this case, both Config 
and Atomic data sources need to be modified). 

7. Restart the OFSAAI services. 

15.1.14 Configuring Java Virtual Machine 

While running several database intensive tasks in parallel, fetching the database connection from 
connection pool may face an error. To ensure no such error is encountered, add the line 
securerandom.source=file:/dev/./urandom in the java.security configuration 

file available in $JAVA_HOME/jre/lib/security/ path. 

This needs to be configured on all the machines or virtual machines where the OFSAAI database 
components (ficdb layer) are installed. 

15.1.15 Configure Internal Service (Document Upload/ Download) 

This step can be ignored if it has already been configured as part of any previous IR/ML installation.  

The Document Upload /Download feature has undergone a change and can now be configured to use 
Internal service for document upload / download instead of the earlier ExeWebService.  

To facilitate Internal service for document upload/ download, perform the following configurations: 

1. Create the folders download, upload, TempDocument and Temp in the local path of Web 
application server and provide Read/Write permission. 

▪ To find the exact location, execute the following query in CONFIG schema:  

select localpath from web_server_info 

▪ To create folders with Read/Write permission, execute the command: 

mkdir -m 777 download upload TempDocument Temp 
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2. Create DocStorage folder in the FTPSHARE location of APP tier and provide Read/Write 
permission. 

▪ To find the exact location, execute the query in CONFIG schema: 

select ftpdrive from app_server_info 

▪ To create folder with Read/Write permission, execute the command: 

mkdir -m 777 DocStorage 
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16 Appendix J: Grants for Atomic/ Config Schema 

This Appendix includes the following sections: 

• Grants for Atomic Schema 

• Grants for Config Schema 

• Grants for Config Schema Entities for Atomic Users 

16.1 Grants for Atomic Schema 

Atomic Schema creation requires certain grants for object creation. This can be located in 
$FIC_HOME/privileges_atomic_user.sql file  

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/ 

grant create SEQUENCE to &database_username 

/ 

grant create TABLE to &database_username 

/ 

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/ 

grant create MATERIALIZED VIEW to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

 

NOTE If you intend to use Oracle OLAP feature, execute the below 

grant on all  ATOMIC schema(s):  grant olap_user to 

&database_username 

 

16.2 Grants for Config Schema 

Config Schema creation requires certain grants for object creation. This can be located in 
$FIC_HOME/privileges_config_user.sql file  

The following are the Grants for Config Schema: 
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grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/  

grant create SEQUENCE to &database_username 

/  

grant create TABLE to &database_username 

/  

grant create TRIGGER to &database_username 

/  

grant create VIEW to &database_username 

/  

grant create MATERIALIZED VIEW to &database_username 

/  

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 

16.3 Grants on Config Schema Entities for Atomic Users 

Atomic Schema creation requires certain grants for config schema object access. This can be located in 
$FIC_HOME/config_table_privileges_for_atomic_user.sql file.  
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17 Appendix K: Configuring MRMM Pack XML Files 

17.1  OFS_MRMM_PACK.XML file 

The OFS_MRMM_PACK.xml file holds details on the various products that are packaged together in 
MRMM Application Pack.  

This section details the various tags/ parameters available in the file and the values that need to be 
updated. Prior to installing the MRMM Application Pack in SILENT mode, it is mandatory to update this 
file.  

 

17.1.1 Configuring OFS_MRMM_PACK.XML file 

The OFS_MRMM_PACK.xml file holds details on the various OFSAA products that are packaged in a 

particular Application Pack.  

The following table gives details about the various tags/ parameters available in the file and the values 
that need to be updated. Prior to installing the OFSAA Application Pack in SILENT mode, it is 
mandatory to update this file. 

 

 

Tag Name/ Attribute Name Description Mandatory  

(Y/ N) 

Default Value/ 

Permissible Value 

Comments 

APP_PACK_ID Unique 
Application 
Pack Identifier 

Y Unique Seeded 
Value  

DO NOT modify 
this value. 

APP_PACK_NAME Unique 
Application 
Pack Name 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

APP_PACK_DESCRIPTION Unique 
Application 
Pack 
Description 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

VERSION Unique release 
version 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

APP Unique 
Application 
Entries 

Y Unique Seeded 
Value 

DO NOT remove 
these tags. 
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Tag Name/ Attribute Name Description Mandatory  

(Y/ N) 

Default Value/ 

Permissible Value 

Comments 

APP_ID Unique 
Application 
Identifier 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

APP_ID/ PREREQ Prerequisite 
Application/ 
Product 

Y Unique Seeded 
Value 

For most 
applications 
Infrastructure 
would be the 
prerequisite set. 
For certain other 
applications, an 
appropriate 
Application ID 
would be set. 
DO NOT modify 
this value. 

APP_ID/ DEF_SEL_FLAG Default Selected 
Flag 

Y Default - YES In all Application 
Packs, 
Infrastructure 
would have this 
value set to 
“YES”. DO NOT 
modify this value. 

APP_ID/ ENABLE Enable 
Application/ 
Product 

YES if 
installing in 
SILENT 
mode. 

Default –  
YES for 
Infrastructure 
NO for Others 

Permissible -  YES 
or NO 

Set this attribute-
value to YES 
against every 
APP_ID which is 
licensed and 
should be 
enabled for use. 
 
Note: 
Application/ 
Product once 
enabled cannot 
be disabled. 
However, 
Application/ 
Product not 
enabled during 
installation can 
be enabled later 
through the 
Administration 
UI. 

APP_NAME Unique 
Application/ 
Product Name 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

APP_DESCRIPTION Unique 
Application/ 
Product Name 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 

VERSION Unique release 
version 

Y Unique Seeded 
Value 

DO NOT modify 
this value. 
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17.2 OFS_MRMM_SCHEMA_IN.xml 

The OFS_MRMM_SCHEMA_IN.XML file contains details on the various application schemas that 
should be created prior to the MRMM Application Pack installation.  

This section details the various tags/ parameters available in the file and the values that need to be 
updated. Prior to executing the schema creator utility, it is mandatory to update this file. 

 

 

17.2.1 Configuring OFS_MRMM_SCHEMA_IN.XML file 

Creating database schemas, object within schemas and assigning appropriate grants are the primary 
steps in the installation process of OFSAA Applications.  The MRMM_SCHEMA_IN.xml file contains 
details on the various application schemas that should be created prior to the Application Pack 
installation.  

The following table gives details about the various tags/ parameters available in the file and the values 
that need to be updated. Prior to executing the schema creator utility, it is mandatory to update this file. 

 

Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<APP_PACK_ID> Unique 
Application Pack 
Identifier 

Y Unique Seeded Value  DO NOT modify 
this value. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<JDBC_URL> Enter the JDBC 
URL. 

Note: You can 
enter RAC and 
NON-RAC 
enabled database 
connectivity URL. 

Y Example,  

jdbc:oracle:thin:@< 
DBSERVER 
IP/HOST>:<PORT>:<SID
> 

or 

jdbc:oracle:thin:@//[HOS
T][:PORT]/SERVICE 

or 

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_LI
ST=(ADDRESS=(PROT
OCOL=TCP)(HOST=[HO
ST])(port=[PORT]))(ADD
RESS=(PROTOCOL=TC
P)(HOST=[HOST])(POR
T=[PORT]))(LOAD_BALA
NCE=yes)(FAILOVER=y
es))(CONNECT_DATA=(
SERVICE_NAME=[SER
VICE])))  

For example, 
jdbc:oracle:thin:@//dbhos
t.server.com:1521/servic
e1  

or 

jdbc:oracle:thin:@//dbsho
st.server.com:1521/scan-
1 

or 

jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_LI
ST=(ADDRESS=(PROT
OCOL=TCP)(HOST=dbh
ost1.server.com)(port=15
21))(ADDRESS=(PROT
OCOL=TCP)(HOST=dbh
ost2.server.com)(PORT=
1521))(LOAD_BALANCE
=yes)(FAILOVER=yes))(
CONNECT_DATA=(SER
VICE_NAME=service1))) 

Ensure to add an 
entry (with SID/ 
SERVICE NAME) 
in the 
tnsnames.ora file 
on the OFSAA 
server. The entry 
should match 
with the SID/ 
SERVICE NAME 
used in the JDBC 
URL. 

<JDBC_DRIVER> By default this 
driver name is 
seeded.  

Note: Do not edit 
this attribute 
value. 

Y Example,  

oracle.jdbc.driver.Oracle
Driver 

Only JDBC Thin 
Driver is 
supported. 
DO NOT modify 
this value. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<HOST> Enter the 
Hostname/ IP 
Address of the 
system on which 
you are installing 
the OFSAA 
components. 

Y  

Host Name/ IP Address 

 

 

 

<SETUPINFO>/ 
NAME 

Enter the acronym 
for the type of 
implementation. 
This information 
will be displayed 
in the OFSAA 
Home Page. 

Note: On 
executing the 
schema creator 
utility, this value 
will be prefixed 
with each schema 
name. For 
example: 
dev_ofsaaconf, 
uat_ofsaaatm. 

Y Accepts strings with a 
minimum length of two 
and maximum of four. 

Example,  

DEV, SIT, PROD 

This name would 
appear in the 
OFSAA Landing 
Page as 
“Connected To: 
xxxx” 

The schemas 
being created 
would get this 
prefix. For E.g. 
dev_ofsaaconf, 
uat_ofsaaconf 
etc. 

<SETUPINFO>/ 
PREFIX_SCHEM
A_NAME 

Identifies if the 
value specified in 
<SETUPINFO>/ 
NAME attribute 
should be prefixed 
to the schema 
name. 

N  YES or NO Default value is 
YES. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<PASSWORD>/ 
APPLYSAMEFOR
ALL 

Enter as Y if you 
want to apply the 
password 
specified in 
DEFAULT 
attribute for all the 
schemas.  

If you enter as N, 
you need to 
provide individual 
passwords for all 
schemas. 

Note: In case you 
have entered Y in 
APPLYSAMEFOR
ALL attribute and 
also have 
specified 
individual 
passwords for all 
the schemas, then 
the specified 
individual 
passwords will 
take precedence. 

Y Default – N 
Permissible – Y or N 

Note: Setting this 
attribute value is 
mandatory, If 
DEFAULT 
attribute is set. 

<PASSWORD>/ 
DEFAULT* 

Enter the 
password if you 
want to set a 
default password 
for all schemas. 

Note: You also 
need to set 
APPLYSAMEFOR
ALL attribute as Y 
to apply the 
default password 
for all the 
schemas. 

N The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<SCHEMA>/ 
TYPE 

The different 
types of schemas 
that are supported 
in this release are  
ATOMIC, 
CONFIG, 
SANDBOX, and 
ADDON. 

By default, the 
schemas types 
are seeded based 
on the Application 
Pack.  

Note: Do not edit 
this attribute 
value. 

 

Y ATOMIC/CONFIG/SAND
BOX/ADDON 

 

Note:  

SANDBOX AND ADDON 
schemas are not 
applicable for OFS AAAI 
Application Pack. 

Only One 
CONFIG schema 
can exist in the 
file. 
This schema 
identifies as the 
CONFIGURATIO
N schema that 
holds the OFSAA 
setup details and 
other metadata 
information. 

Multiple ATOMIC/ 
SANDBOX/ 
ADDON schemas 
can exist in the 
file. 

ATOMIC schema 
refers to the 
Information 
Domain schema. 
SANDBOX 
schema refers to 
the SANDBOX 
schema. ADDON 
schema refers to 
other 
miscellaneous 
schema (not 
applicable for this 
Application 
Pack).  

<SCHEMA.>/ 
NAME 

By default, the 
schemas names 
are seeded based 
on the Application 
Pack. 

You can edit the 
schema names if 
required.  

Note: 

The Schema 
Name will have a 
prefix of the 
SETUPINFO/ 
NAME attribute. 

SCHEMA NAME 
must be same for 
all the ATOMIC 
Schemas of 
applications within 
an Application 
Pack. 

Y The permissible length is 
15 characters and only 
alphanumeric characters 
allowed. No special 
characters allowed 
except underscore ‘_’. 

SETUPINFO/ 
NAME attribute 
value would be 
prefixed to the 
schema name 
being created. 
For E.g. if name 
is set as 
‘ofsaaatm’ and 
setupinfo as ‘uat’ 
then schema 
being created 
would be 
‘uat_ofsaaatm’.  

NAME should be 
same where 
APP_GRP=1 for 
all SCHEMA tags 
(Not applicable 
for this 
Application 
Pack). 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<SCHEMA>/ 
PASSWORD* 

Enter the 
password of the 
schema to be 
created.  

Note:  

If this attribute is 
left blank, then the 
password 
specified in the 
<PASSWORD>/D
EFAULT attribute 
is applied as the 
Schema 
Password. 

 

N 

 

The maximum length 
allowed is 30 characters. 
Special characters are 
not allowed. 

Note: You need 
to mandatorily 
enter the 
password if you 
have set the 
<PASSWORD>/ 
APPLYSAMEFO
RALL attribute as 
N. 

<SCHEMA>/ 
APP_ID 

By default, the 
Application ID is 
seeded based on 
the Application 
Pack.  

Note: Do not edit 
this attribute 
value. 

Y Unique Seeded Value Identifies the 
Application/ 
Product for which 
the schema is 
being created. 

DO NOT modify 
this value. 

<SCHEMA>/ 
DEFAULTTABLE
SPACE 

Enter the 
available default 
tablespace for DB 
User. 

Note:  

If this attribute is 
left blank, then 
USERS is set as 
the default 
tablespace. 

N Default – USERS 
Permissible – Any 
existing valid tablespace 
name.  

Modify this value 
to associate any 
valid tablespace 
with the schema. 

<SCHEMA>/ 
TEMPTABLESPA
CE 

Enter the 
available 
temporary 
tablespace for the 
DB User.  

Note:  

If this attribute is 
left blank, then 
TEMP is set as 
the default 
tablespace. 

N Default – TEMP 
Permissible – Any 
existing valid temporary 
tablespace name. 

Modify this value 
to associate any 
valid tablespace 
with the schema. 
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Tag Name/  

Attribute Name 

Description Mandatory 

(Y/N) 

Default Value/  

Permissible Value 

Comments 

<SCHEMA>/ 
QUOTA 

Enter the quota to 
be set on 
DEFAULTTABLE
SPACE attribute 
for the schema/ 
user. By default, 
the quota size is 
set to 500M. 
Minimum: 500M 
or Unlimited on 
default 
Tablespace 

N Example,  

600M/m 

20G/g 

UNLIMITED/unlimited 

 

Modify this value 
to grant the 
specified quota 
on the mentioned 
tablespace to the 
user.  

<SCHEMA>/ 
INFODOM 

Enter the name of 
the Information 
Domain to 
associate this 
schema. 
The schema 
creator utility 
automatically 
derives an 
Information 
Domain Name 
based on the 
Application Pack if 
no value is 
specified for this 
attribute. 

N 

(Optional for 
Atomic and 
mandatory 
for sandbox ) 

Permissible length is 16 
characters and only 
alphanumeric characters 
allowed. No special 
characters allowed. 

Enter this field in 
UPPERCASE. 

<ADV_SEC_OPTI
ONS> 

Parent tag to hold 
Advance Security 
Options.  

  

N  Uncomment the 
tag and edit if you 
want to add 
security options. 
For example, 
TDE and Data 
Redact. 

 

For details, see 
the example 
following the 
table. 

<ADV_SEC_OPTI
ONS>/TDE 

Tag to 
enable/disable 
TDE. 

N Default is FALSE.  Ensure this tag is 
not commented if 
you have 
uncommented 
<ADV_SEC_OPT
IONS>/ 

<ADV_SEC_OPTI
ONS>/ 
DATA_REDACT 

Tag to 
enable/disable 
Data Redaction 
feature. 

N Default is TRUE. To 
disable DATA_REDACT, 
set this to FALSE 

Ensure this tag is 
not commented if 
you have 
uncommented 
<ADV_SEC_OPT
IONS>/ 
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NOTE *On successful execution of the utility, the entered passwords in 

the OFS_MRMM_SCHEMA_IN.xml file are nullified. 
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18 Appendix L: OFSAAI_InstallConfig.xml file 

18.1.1 Configuring OFSAAI_InstallConfig.xml file 

1. Navigate to OFS_MRMM_PACK/OFS_AAI/conf/ 

2. Open the file OFSAAI_InstallConfig.xml in text editor. 

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below table: 

You need to manually set the InteractionVariable parameter values as mentioned in the table. If a value 
is not applicable, enter NA and ensure that the value is not entered as NULL. 

 

InteractionVariable 

Name 

Significance and Expected Value Mandatory 

<Layer name="GENERAL"> 

InteractionGroup name="WebServerType" 

WEBAPPSERVERT
YPE 

Identifies the web application server on which the 
OFSAA Infrastructure web components would be 
deployed. 

The below numeric value should be set depending 
on the type: 

• Apache Tomcat = 1 

• IBM WebSphere Application Server = 2 

• Oracle WebLogic Server = 3 

For example,  <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionV
ari able> 

Yes 

InteractionGroup name="OFSAA Infrastructure Server Details" 

DBSERVER_IP Identifies the hostname or IP address of the 
system on which the Database Engine is hosted. 

Note: For RAC Database , the value should be 
NA. 

For example, <InteractionVariable 
name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> or 

<InteractionVariable name="DBSERVER_ 
IP">dbhost.server.com</InteractionVariable 

> 

Yes 

InteractionGroup name="Database Details" 

ORACLE_SID/SERV
ICE_ NAME 

Identifies the Oracle DB Instance SID or 
SERVICE_NAME 

Note: The Oracle_SID value should be exactly the 
same as it is mentioned in JDBC_URL. 

For example, <InteractionVariable 
name="ORACLE_SID/SERVICE_ 

NAME">ofsaser</InteractionVariable> 

Yes 
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InteractionVariable 

Name 

Significance and Expected Value Mandatory 

ABS_DRIVER_PAT
H 

Identifies the directory where the JDBC driver 
(ojdbc<version>.jar) exists. This would typically be 
the 

$ORACLE_HOME/jdbc/lib 

For example, <InteractionVariable 
name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle 

</InteractionVariable> 

Note: Refer Appendix O for identifying the correct 
“ojdbc<version>.jar” version to be copied. 

Yes 

InteractionGroup name="OLAP Detail" 

OLAP_SERVER_ 
IMPLEMENTATION 

Identifies if the OFSAA Infrastructure OLAP 
component needs to be configured depending on 
whether you intend to use the OLAP feature. The 
below numeric value should be set depending on 
the choice: 

• YES - 1 

• NO – 0 

No 

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment 
variables are set in .profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH. 

InteractionGroup name="SFTP Details" 

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer 
Protocol) feature is to be enabled. The following 
numeric value should be set depending on the 
choice: 

• For SFTP, set this field to 1  

• For FTP, set this field to 0 

Yes 

Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle 
recommends using SFTP instead of FTP because SFTP is considered more secure. However, a client 
may choose to ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. You can 
change this selection later by using the OFSAAI administration interface.  

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI 
server.  

FILE_TRANSFER_P
ORT 

Identifies the port used for the file transfer service. 
The default value specified is 22 (SFTP). Specify 
default value as 21 (FTP) if SFTP_ENABLE is 0.  
Alternatively, this value can be any Port configured 
by System Administrators to support SFTP/FTP. 

For example, <InteractionVariable 
name="FILE_TRANSFER_ 
PORT">21</InteractionVariable> 

Yes 

InteractionGroup name="Locale Detail" 

LOCALE 

 

Identifies the locale information to be used during 
the installation. This release of the OFSAA 
Infrastructure supports only US English. 

For example, <InteractionVariable 
name="LOCALE">en_US</InteractionVariable> 

Yes 
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InteractionVariable 

Name 

Significance and Expected Value Mandatory 

InteractionGroup name="OFSAA Infrastructure Communicating ports" 

Note: The below ports are used internally by the various OFSAA Infrastructure services. The default 
values mentioned below are set in the installation. If you intend to specify a different value, update the 
parameter value accordingly and ensure this port value is in the range of 1025   to 65535 and the 
respective port is enabled. 

JAVAPORT 9999 Yes 

NATIVEPORT 6666 Yes 

AGENTPORT 6510 Yes 

ICCPORT 6507 Yes 

ICCNATIVEPORT 6509 Yes 

OLAPPORT 10101 Yes 

MSGPORT 6501 Yes 

ROUTERPORT 6500 Yes 

AMPORT 6505 Yes 

InteractionGroup name="Web Details" 

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted 
CA and the same is configured on your web application server.  

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP 
or HTTPS scheme. The default value set is 0. The 
below numeric value should be set depending on 
the choice: 

YES - 1 

NO - 0 

For example, <InteractionVariable 
name="HTTPS_ENABLE">0</InteractionVariable> 

Yes 

WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web 
Application Server IP/ Hostname, to be used for 
accessing the UI. This IP would typically be the 
HTTP Server IP. 

If no separate HTTP Server is available, the value 
should be Web Application Server IP/Hostname. 

For example, <InteractionVariable 
name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_ 
IP">myweb.server.com</InteractionVariable> 

No 

WEB_SERVER_PO
RT 

Identifies the Web Server Port. This would typically 
be 80 for non SSL and 443 for SSL. If no separate 
HTTP Server exists, the value should be the port 
configured for Web Server. 

Note: The port value will not be accepted as 80 if 
HTTPS_ENABLE is 1 and as 443, if 
HTTPS_ENABLE is 0. 

For example, <InteractionVariable name="WEB_ 
SERVER_PORT">80</InteractionVariable> 

No 
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InteractionVariable 

Name 

Significance and Expected Value Mandatory 

CONTEXT_NAME Identifies the web application context name which 
will be used to build the URL to access the OFSAA 
applications. The context name can be identified 
from a URL as below: 

<scheme>://<host>:<port>/<context-name>/lo 
gin.jsp 

Sample URL: 

https://myweb:443/ofsaadev/login.jsp 

For example, <InteractionVariable 
name="CONTEXT_ 
NAME">ofsaadev</InteractionVariable> 

Yes 

WEBAPP_CONTEX
T_PATH 

Identifies the absolute path of the exploded .ear 
file on the web application server. 

For Tomcat, specify the Tomcat directory path till 

/webapps, such as 

/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as 

<WebSphere profile directory>/installedApps/ 

<NodeCellName>. For example, 

/data2/test//WebSphere/AppServer/profiles/ 

<Profile_ 

Name>/installedApps/aix-imfNode01Cell. Where 
aix-imf is Host name. 

For WebLogic, provide the WebLogic home 
directory path as /<WebLogic home directory 
path>/bea/wlserver_10.3 

Note: For WebLogic, value specified for this 
attribute is ignored and value provided against 
attribute WEBLOGIC_DOMAIN_HOME is 
considered. 

Yes 

WEB_LOCAL_PATH Identifies the absolute path to any directory on the 
web application server that can hold temporary 
files being uploaded as part of the applications 
usage. 

Note: In case of a clustered deployment, ensure 
this path and directory is same on all the nodes. 

Yes 

InteractionGroup name="Weblogic Setup Details" 

WEBLOGIC_DOMAI
N_HOME 

Identifies the WebLogic Domain Home.  

For example, <InteractionVariable 
name="WEBLOGIC_DOMAIN_ 

HOME">/home/weblogic/bea/user_ 
projects/domains/mydomain 

</InteractionVariable> 

Yes Specify the value only 
if WEBSERVERTYPE is set 
as 3 (WebLogic) 

InteractionGroup name="OFSAAI FTP Details" 
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InteractionVariable 

Name 

Significance and Expected Value Mandatory 

OFSAAI_FTPSHAR
E_PATH 

Identifies the absolute path to the directory 
identified as file system stage area. 

Note:  

The directory should exist on the same system on 
which the OFSAA Infrastructure is being installed 
(can be on a separate mount). 

The user mentioned in APP_SFTP_USER_ID 
parameter below should have RWX permission on 
the directory. 

For example, <InteractionVariable 
name="APP_FTPSHARE_PATH">">/oradata6/rev
wb7/ftpshare</InteractionVariable> 

Yes 

OFSAAI_SFTP_US
ER_ID 

Identifies the user who has RWX permissions on 
the directory identified under parameter 
APP_FTPSHARE_PATH above. 

Yes 

OFSAAI_SFTP_PRI
VATE_KEY 

Identifies the SFTP private key for OFSAAI.  

For example, 

<InteractionVariable 
name="OFSAAI_SFTP_PRIVATE_KEY">/home/of
saapp/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates 
password will be prompted for the user 
<OFSAAI_SFTP_USER_ ID> for authentication. 

For more information on generating SFTP Private 
key, see the Setting Up SFTP Private Key section. 

No 

OFSAAI_SFTP_PAS
SPHRASE 

Identifies the passphrase for the SFTP private key 
for OFSAAI. 

For example, 

InteractionVariable 
name="OFSAAI_SFTP_PASSPHRASE">enter a 
pass phrase here</InteractionVariable> 

By default, the value is NA. 

If OFSAAI_SFTP_PRIVATE_KEY value is given 
and this is kept as NA, then it is assumed as 
empty passphrase. 

No 

InteractionGroup name="Hive Details" 

The default value set for the interaction variables under this group is set as NA. These are required only 
for Hive Configuration. 

HIVE_SERVER_PO
RT 

Identifies the port used for the file transfer service. 
The default value set is 

22 (SFTP). Set this value as 21 for FTP. 

For example, 

InteractionVariable 
name="HIVE_SERVER_PORT">22</InteractionV
ariable> 

Yes, only for HIVE 
Configuration 
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InteractionVariable 

Name 

Significance and Expected Value Mandatory 

HIVE_SERVER_FT
PDRIVE 

Identifies the absolute path to the directory 
identified as file system stage area of HIVE server. 

For example, 

InteractionVariable 
name="HIVE_SERVER_FTPDRIVE">/scratch/ofsa
a/ftpshare</InteractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SERVER_FT
P_USERID 

Identifies the user who has RWX permissions on 
the directory identified under the preceding 
parameter HIVE_SERVER_FTPDRIVE. 

For example, 

InteractionVariable 
name="HIVE_SERVER_FTP_USERID">ofsaa</In
teractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SERVER_FT
P_PROTOCOL 

If the HIVE_SERVER_PORT is 21, then set value 
as FTP, else set it as SFTP. 

For example, 

InteractionVariable 
name="HIVE_SERVER_FTP_PROTOCOL">SFTP
</InteractionVariable> 

Yes, only for HIVE 
Configuration 

HIVE_SFTP_PRIVA
TE_KEY 

Identifies the SFTP private key for the HIVE 
server. 

For example, 

<InteractionVariable 
name="HIVE_SFTP_PRIVATE_KEY">/scratch/tes
tuser/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates 
password will be prompted for the user 
<HIVE_SERVER_FTP_USERID> for 
authentication. 

For more information on generating SFTP Private 
key, see the Setting Up SFTP Private Key section. 

Yes, only for HIVE 
Configuration 

HIVE_SFTP_PASSP
HRASE 

Identifies the passphrase for the SFTP private key 
for HIVE. 

For example, 

<InteractionVariable name="HIVE_SFTP_ 

PASSPHRASE">NA</InteractionVariable> 

By default, the value is NA. 

If HIVE_SFTP_PRIVATE_KEY value is given and 
this is kept as NA, then it is assumed as empty 
passphrase. 

Yes, only for HIVE 
Configuration 

 

18.1.2 Setting Up SFTP Private Key 

Log in to OFSAA Unix user using Putty tool, where you plan for installation and generate a pair of 
authentication keys using the ssh-keygen command. If required, set passphrase. Otherwise 
OFSAAI_SFTP_PASSPHRASE tag should be set to NA. 

To generate private key, enter the commands as shown: 
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ssh-keygen -t rsa 

Generating public/private rsa key pair. 

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa):  

Created directory '/home/ofsaapp/.ssh'. 

Enter passphrase (empty for no passphrase):  

Enter same passphrase again:  

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa. 

Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub. 

The key fingerprint is: 

3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4  

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> 

/home/ofsaapp/.ssh/authorized_keys 

Ensure the following permissions exist for the given folders: 

• permissions of .ssh should be 700 

• permissions of .ssh/authorized_keys should be 640 

• permission  of .ssh/id_rsa should be 400 

• Permission  of Unix User created should be 755 
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19 Appendix M: MRMM Pack User Group Names 

User Group names seeded as part of the media pack: 

To access the MRMM and MRMM Analytics application, created users can be mapped to the following 
user groups. 

• MRMMADMINGRP - Market Risk Measurement and Management Admin Group 

• MRMMANALYSTGRP - Market Risk Measurement and Management Analyst Group 

• MRMMAPPROVERGRP - Market Risk Measurement and Management Approver Group 

The roles defined in OFS MRMM application are as follows: 

19.1 MRMM Group Codes 

Group Code Group Name Group Description 

MRMMADMINGRP Market Risk Measurement and Management 
Admin Group 

Group for administrator 

MRMMAPPROVERGRP Market Risk Measurement and Management 
Approver Group 

Group for approvers 

MRMMANALYSTGRP Market Risk Measurement and Management 
Analyst Group 

Group for business 
analysts 

19.2 MRMM Role Codes 

Role Code Role Name Role Description  

MRMMADMIN    MRMM Administrator Administrator role 

MRMMVALNAPROVER MRMM Inst Valn 
Approver 

Instrument Valuation business definition 
approval role 

MRMMVALNANALYST MRMM Inst Valn Analyst Instrument Valuation business analyst role 

MRMMHISTSMLNAPROVER MRMM Hist Sim 
Approver 

Historical Simulation business definition 
approval role 

MRMMHISTSMLNANALYST MRMM Hist Sim Analyst Historical Simulation business analyst role 

MRMMMDLVALDNAPROVER MRMM Mdl Vldn 
Approver 

Model Validation business definition approval 
role 

MRMMMDLVALDNANALYST MRMM Mdl Vldn Analyst Model Validation business analyst role 

MRMMMNTCARLOANALYST MRMM MC Sim Analyst MRMM Monte Carlo Simulation Analyst roles 

MRMMMNTCARLOAPROVER MRMM MC Sim Approver MRMM Monte Carlo Simulation Approver roles 

19.3 MRMM Function Codes 

Function Code Function Name Function Description 

MRPROCESS MRMM Business Processes Function to access the business processes 
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Function Code Function Name Function Description 

MRCONFIGR MRMM Business Configuration Function to access the business configuration 

MRPRE MRMM Application Preferences Function to access the application preference 

MRIVADD Add New MRMM Inst Valn Function to add a new business approach for 
instrument valuation 

MRIVDEL Delete MRMM Inst Valn Function to delete a business approach for 
instrument valuation 

MRIVEXP Export MRMM Inst Valn Function to export a  business approach for 
instrument valuation 

MRIVNEWBD Add New MRMM  Inst Valn 
Business Definition  

Function to add a  new business definition for 
instrument valuation 

MRIVSAVE Save MRMM Inst Valn Business 
Definition  

Function to save an instrument valuation 
business definition 

MRIVSBMT Submit MRMM Inst Valn Business 
Definition  

Function to submit an instrument valuation 
business definition for approval 

MRIVAPR Approve MRMM Inst Valn Business 
Definition  

Function to approve an instrument valuation 
business definition 

MRIVRJCT Reject MRMM Inst Valn Business 
Definition  

Function to reject an instrument valuation 
business definition 

MRIVEXE Execute MRMM Inst Valn Business 
Definition  

Function to execute an instrument valuation 
business definition 

MRHSADD Add New MRMM Hist Sim Function to add a new business approach for 
historical simulation 

MRHSDEL Delete MRMM Hist Sim Function to delete a business approach for 
historical simulation 

MRHSEXP Export MRMM Hist Sim Function to export a business approach for 
historical simulation 

MRHSNEWBD Add New MRMM Hist Sim Business 
Definition  

Function to add a new business definition for 
historical simulation 

MRHSSAVE Save MRMM Hist Sim Business 
Definition  

Function to save a historical simulation 
business definition 

MRHSSBMT Submit MRMM Hist Sim Business 
Definition  

Function to submit a historical simulation 
business definition for approval 

MRHSAPR Approve MRMM Hist Sim Business 
Definition  

Function to approve a historical simulation 
business definition 

MRHSRJCT Reject MRMM Hist Sim Business 
Definition  

Function to reject a  historical simulation 
business definition 

MRHSEXE Execute MRMM Hist Sim Business 
Definition  

Function to execute a historical simulation 
business definition 

MRHSRSFTCH Fetch MRMM Hist Sim Reduced 
Set Data 

Function to fetch reduced set of risk factor in 
historical simulation business definition 

MRHSRSSAVE Save MRMM Hist Sim Reduced Set 
Data 

Function to save a reduced set of risk factor in 
historical simulation business definition 

MRHSRSVAL Validate MRMM Hist Sim Reduced 
Set Data 

Function to validate a reduced set of risk factor 
in historical simulation business definition 
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Function Code Function Name Function Description 

MRHSSPEXE Execute MRMM Hist Sim Stress 
Period Identification 

Function to execute a stress period 
identification process in historical simulation 
business definition 

MRMVADD Add New MRMM Mdl Valdn Function to add a new business approach for 
model validation 

MRMVDEL Delete MRMM Mdl Valdn Function to delete a business approach for 
model validation 

MRMVEXP Export MRMM Mdl Valdn Function to export a business approach for 
model validation 

MRMVNEWBD Add New MRMM Mdl Valdn 
Business Definition  

Function to add a new business definition for 
model validation 

MRMVSAVE Save MRMM Mdl Valdn Business 
Definition  

Function to save a model validation business 
definition 

MRMVSBMT Submit MRMM Mdl Valdn Business 
Definition  

Function to submit a model validation business 
definition for approval 

MRMVAPR Approve MRMM Mdl Valdn 
Business Definition  

Function to approve a model validation 
business definition 

MRMVRJCT Reject MRMM Mdl Valdn Business 
Definition  

Function to reject a model validation business 
definition 

MRMVEXE Execute MRMM Mdl Valdn 
Business Definition  

Function to execute a model validation 
business definition 

MRPDNEW Add New MRMM Portfolio 
Definition 

Function to add a portfolio definition 

MRPDDEL Delete MRMM Portfolio Definition Function to delete a portfolio definition 

MRPDEXP Export MRMM Portfolio Definition Function to export a portfolio definition 

MRPDEDIT Edit MRMM Portfolio Definition Function to edit a portfolio definition 

MRPDCOPY Copy MRMM Portfolio Definition Function to copy a portfolio definition 

MRPDSAVE Save MRMM Portfolio Definition Function to save a portfolio definition 

MRPDSBMT Submit MRMM Portfolio Definition  Function to submit a portfolio definition for 
approval 

MRPDAPR Approve MRMM Portfolio Definition  Function to approve a portfolio definition 

MRPDRJCT Reject MRMM Portfolio Definition  Function to reject a portfolio definition 

MRMDLSETRL Set Rules MRMM Modellable Non-
Modellable 

Function for setting rules for modellable and 
non-modellable risk factors 

MRMDLSAVE Save MRMM Modellable Non-
Modellable 

Function to save a risk factor identified as 
modellable and non-modellable 

MRMDLEXE Execute MRMM Modellable Non-
Modellable 

Function to execute modellable and non-
modellable risk factor identification process 

MRMDLAPLF Apply Filters MRMM Modellable 
Non-Modellable 

Function allows the user to apply filters to 
modellable and non-modellable risk factor 

MRMDLRSTF Reset Filters MRMM Modellable 
Non-Modellable 

Function allows user to reset the apply filters to 
modellable and non-modellable risk factor 

MRCONFUPD Update MRMM Default 
Configuration 

Function to update default configurations 
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Function Code Function Name Function Description 

MRMCSADD Add New MRMM Monte Carlo 
Simulation 

The user group mapped to this function can 
add new Monte Carlo Simulation 

MRMCSDEL Delete MRMM Monte Carlo 
Simulation 

The user group mapped to this function can 
delete Monte Carlo Simulation 

MRMCSEXP Export MRMM Monte Carlo 
Simulation 

The user group mapped to this function can 
export Monte Carlo Simulation 

MRMCSNEWBD Add New MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
add new Monte Carlo Sim Business Definition 

MRMCSSAVE Save MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
save Monte Carlo Sim Business Definition 

MRMCSSBMT Submit MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
submit Monte Carlo Sim Business Definition 

MRMCSAPR Approve MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
approve Monte Carlo Sim Business Definition 

MRMCSRET Retire MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
retire Monte Carlo Sim Business Definition 

MRMCSAPRET Approve Retire Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
approve retire Monte Carlo Sim Business 
Definition 

MRMCSRJCT Reject MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
reject Monte Carlo Sim Business Definition 

MRMCSEXE Execute MRMM Monte Carlo Sim 
Business Def 

The user group mapped to this function can 
execute Monte Carlo Sim Business Definition 

MRSSSAVE Save MRMM Stress Scenario 
details 

The user group mapped to this function can 
save Stress Scenarios details 

MRSSSBMT Submit MRMM Stress Scenario 
details 

The user group mapped to this function can 
submit Stress Scenarios details 

MRSSAPR Approve MRMM Stress Scenario 
details 

The user group mapped to this function can 
approve Stress Scenarios details 

MRSSRJCT Reject MRMM Stress Scenario 
details 

The user group mapped to this function can 
reject Stress Scenarios details 

MRSSDEL Delete MRMM Stress Scenario 
details 

The user group mapped to this function can 
delete Stress Scenarios details 

MRSSCOPY Copy MRMM Stress Scenario 
details 

The user group mapped to this function can 
copy Stress Scenarios details 

MRSSEXP Export MRMM Stress Scenario 
details 

The user group mapped to this function can 
export Stress Scenarios details 

MRSSNEW Add New MRMM Stress Scenario 
details 

The user group mapped to this function can 
Add New Stress Scenarios details 

MRHMADDMDL Add New MRMM Hybrid model The user group mapped to this function can 
Add New Hybrid Model 

MRHMDELMDL delete MRMM Hybrid model The user group mapped to this function can 
delete Hybrid Model 

MRHMADDRUL Add New MRMM Hybrid model 
Rule 

The user group mapped to this function can 
add new rules to Hybrid Model 
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Function Code Function Name Function Description 

MRHMEDTRUL Edit saved rules in MRMM Hybrid 
model 

The user group mapped to this function can 
edit the rules which are already saved for 
Hybrid Model 

MRHMDELRUL Delete MRMM Hybrid model Rules The user group mapped to this function can 
delete Hybrid Model Rules 

MRHMGENXML Generate xml in MRMM Hybrid 
model setup 

The user group mapped to this function can 
generate xml in MRMM Hybrid model setup 

MRTECHADD Add entries for technical 
configuration screen 

The user group mapped to this function can 
add entries for technical configuration  

19.4 MRMM Group Code – Role Code Mapping 

Group Code Role Code 

MRMMADMINGRP MRMMADMIN    

MRMMAPPROVERGRP MRMMVALNAPROVER 

MRMMAPPROVERGRP MRMMHISTSMLNAPROVER 

MRMMAPPROVERGRP MRMMMDLVALDNAPROVER 

MRMMANALYSTGRP MRMMVALNANALYST 

MRMMANALYSTGRP MRMMHISTSMLNANALYST 

MRMMANALYSTGRP MRMMMDLVALDNANALYST 

MRMMANALYSTGRP MRMMMNTCARLOANALYST 

MRMMAPPROVERGRP MRMMMNTCARLOAPROVER 

19.5 MRMM Role Code – Function Code Mapping 

Role Code Function Code 

MRMMADMIN    MRPROCESS 

MRMMADMIN    MRCONFIGR 

MRMMADMIN    MRPRE 

MRMMADMIN    MRIVADD 

MRMMADMIN    MRIVDEL 

MRMMADMIN    MRIVEXP 

MRMMADMIN    MRIVNEWBD 

MRMMADMIN    MRIVSAVE 

MRMMADMIN    MRIVSBMT 

MRMMADMIN    MRIVAPR 

MRMMADMIN    MRIVRJCT 

MRMMADMIN    MRIVEXE 
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Role Code Function Code 

MRMMADMIN    MRHSADD 

MRMMADMIN    MRHSDEL 

MRMMADMIN    MRHSEXP 

MRMMADMIN    MRHSNEWBD 

MRMMADMIN    MRHSSAVE 

MRMMADMIN    MRHSSBMT 

MRMMADMIN    MRHSAPR 

MRMMADMIN    MRHSRJCT 

MRMMADMIN    MRHSEXE 

MRMMADMIN    MRHSRSFTCH 

MRMMADMIN    MRHSRSSAVE 

MRMMADMIN    MRHSRSVAL 

MRMMADMIN    MRHSSPEXE 

MRMMADMIN    MRMVADD 

MRMMADMIN    MRMVDEL 

MRMMADMIN    MRMVEXP 

MRMMADMIN    MRMVNEWBD 

MRMMADMIN    MRMVSAVE 

MRMMADMIN    MRMVSBMT 

MRMMADMIN    MRMVAPR 

MRMMADMIN    MRMVRJCT 

MRMMADMIN    MRMVEXE 

MRMMADMIN    MRPDNEW 

MRMMADMIN    MRPDDEL 

MRMMADMIN    MRPDEXP 

MRMMADMIN    MRPDSAVE 

MRMMADMIN    MRPDEDIT 

MRMMADMIN    MRPDCOPY 

MRMMADMIN    MRPDSBMT 

MRMMADMIN    MRPDAPR 

MRMMADMIN    MRPDAPRRET 

MRMMADMIN    MRPDRJCT 

MRMMADMIN    MRMDLSETRL 

MRMMADMIN    MRMDLSAVE 

MRMMADMIN    MRMDLEXE 

MRMMADMIN    MRMDLAPLF 
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Role Code Function Code 

MRMMADMIN    MRMDLRSTF 

MRMMADMIN    MRCONFUPD 

MRMMADMIN    MRPRPOLICY 

MRMMADMIN    MRPPNEW 

MRMMADMIN    MRPRCNGDEL 

MRMMADMIN    MRPPSAVE 

MRMMADMIN    MRPPEXP 

MRMMVALNAPROVER MRPROCESS 

MRMMVALNAPROVER MRCONFIGR 

MRMMVALNAPROVER MRPRE 

MRMMVALNAPROVER MRIVADD 

MRMMVALNAPROVER MRIVDEL 

MRMMVALNAPROVER MRIVEXP 

MRMMVALNAPROVER MRIVNEWBD 

MRMMVALNAPROVER MRIVSAVE 

MRMMVALNAPROVER MRIVSBMT 

MRMMVALNAPROVER MRIVAPR 

MRMMVALNAPROVER MRIVRJCT 

MRMMVALNAPROVER MRIVEXE 

MRMMVALNAPROVER MRPDNEW 

MRMMVALNAPROVER MRPDDEL 

MRMMVALNAPROVER MRPDEXP 

MRMMVALNAPROVER MRPDSAVE 

MRMMVALNAPROVER MRPDEDIT 

MRMMVALNAPROVER MRPDCOPY 

MRMMVALNAPROVER MRPDSBMT 

MRMMVALNAPROVER MRPDAPR 

MRMMVALNAPROVER MRPDAPRRET 

MRMMVALNAPROVER MRPDRJCT 

MRMMVALNAPROVER MRMDLSETRL 

MRMMVALNAPROVER MRMDLSAVE 

MRMMVALNAPROVER MRMDLEXE 

MRMMVALNAPROVER MRMDLAPLF 

MRMMVALNAPROVER MRMDLRSTF 

MRMMVALNAPROVER MRPRPOLICY 

MRMMVALNAPROVER MRPPNEW 
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Role Code Function Code 

MRMMVALNAPROVER MRPRCNGDEL 

MRMMVALNAPROVER MRPPSAVE 

MRMMVALNAPROVER MRPPEXP 

MRMMVALNANALYST MRPROCESS 

MRMMVALNANALYST MRIVADD 

MRMMVALNANALYST MRIVDEL 

MRMMVALNANALYST MRIVEXP 

MRMMVALNANALYST MRIVNEWBD 

MRMMVALNANALYST MRIVSAVE 

MRMMVALNANALYST MRIVSBMT 

MRMMVALNANALYST MRIVEXE 

MRMMVALNANALYST MRPDNEW 

MRMMVALNANALYST MRPDDEL 

MRMMVALNANALYST MRPDEXP 

MRMMVALNANALYST MRPDSAVE 

MRMMVALNANALYST MRPDEDIT 

MRMMVALNANALYST MRPDCOPY 

MRMMVALNANALYST MRPDSBMT 

MRMMVALNANALYST MRPRPOLICY 

MRMMVALNANALYST MRPPNEW 

MRMMVALNANALYST MRPRCNGDEL 

MRMMVALNANALYST MRPPSAVE 

MRMMVALNANALYST MRPPEXP 

MRMMHISTSMLNAPROVER MRPROCESS 

MRMMHISTSMLNAPROVER MRCONFIGR 

MRMMHISTSMLNAPROVER MRPRE 

MRMMHISTSMLNAPROVER MRHSADD 

MRMMHISTSMLNAPROVER MRHSDEL 

MRMMHISTSMLNAPROVER MRHSEXP 

MRMMHISTSMLNAPROVER MRHSNEWBD 

MRMMHISTSMLNAPROVER MRHSSAVE 

MRMMHISTSMLNAPROVER MRHSSBMT 

MRMMHISTSMLNAPROVER MRHSAPR 

MRMMHISTSMLNAPROVER MRHSRJCT 

MRMMHISTSMLNAPROVER MRHSEXE 

MRMMHISTSMLNAPROVER MRHSRSFTCH 
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Role Code Function Code 

MRMMHISTSMLNAPROVER MRHSRSSAVE 

MRMMHISTSMLNAPROVER MRHSRSVAL 

MRMMHISTSMLNAPROVER MRHSSPEXE 

MRMMHISTSMLNAPROVER MRPDNEW 

MRMMHISTSMLNAPROVER MRPDDEL 

MRMMHISTSMLNAPROVER MRPDEXP 

MRMMHISTSMLNAPROVER MRPDSAVE 

MRMMHISTSMLNAPROVER MRPDEDIT 

MRMMHISTSMLNAPROVER MRPDCOPY 

MRMMHISTSMLNAPROVER MRPDSBMT 

MRMMHISTSMLNAPROVER MRPDAPR 

MRMMHISTSMLNAPROVER MRPDAPRRET 

MRMMHISTSMLNAPROVER MRPDRJCT 

MRMMHISTSMLNAPROVER MRMDLSETRL 

MRMMHISTSMLNAPROVER MRMDLSAVE 

MRMMHISTSMLNAPROVER MRMDLEXE 

MRMMHISTSMLNAPROVER MRMDLAPLF 

MRMMHISTSMLNAPROVER MRMDLRSTF 

MRMMHISTSMLNANALYST MRPROCESS 

MRMMHISTSMLNANALYST MRHSADD 

MRMMHISTSMLNANALYST MRHSDEL 

MRMMHISTSMLNANALYST MRHSEXP 

MRMMHISTSMLNANALYST MRHSNEWBD 

MRMMHISTSMLNANALYST MRHSSAVE 

MRMMHISTSMLNANALYST MRHSSBMT 

MRMMHISTSMLNANALYST MRHSEXE 

MRMMHISTSMLNANALYST MRHSRSFTCH 

MRMMHISTSMLNANALYST MRHSRSSAVE 

MRMMHISTSMLNANALYST MRHSRSVAL 

MRMMHISTSMLNANALYST MRHSSPEXE 

MRMMHISTSMLNANALYST MRPDNEW 

MRMMHISTSMLNANALYST MRPDDEL 

MRMMHISTSMLNANALYST MRPDEXP 

MRMMHISTSMLNANALYST MRPDSAVE 

MRMMHISTSMLNANALYST MRPDEDIT 

MRMMHISTSMLNANALYST MRPDCOPY 
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Role Code Function Code 

MRMMHISTSMLNANALYST MRPDSBMT 

MRMMMDLVALDNAPROVER MRPROCESS 

MRMMMDLVALDNAPROVER MRCONFIGR 

MRMMMDLVALDNAPROVER MRPRE 

MRMMMDLVALDNAPROVER MRMVADD 

MRMMMDLVALDNAPROVER MRMVDEL 

MRMMMDLVALDNAPROVER MRMVEXP 

MRMMMDLVALDNAPROVER MRMVNEWBD 

MRMMMDLVALDNAPROVER MRMVSAVE 

MRMMMDLVALDNAPROVER MRMVSBMT 

MRMMMDLVALDNAPROVER MRMVAPR 

MRMMMDLVALDNAPROVER MRMVRJCT 

MRMMMDLVALDNAPROVER MRMVEXE 

MRMMMDLVALDNAPROVER MRPDNEW 

MRMMMDLVALDNAPROVER MRPDDEL 

MRMMMDLVALDNAPROVER MRPDEXP 

MRMMMDLVALDNAPROVER MRPDSAVE 

MRMMMDLVALDNAPROVER MRPDEDIT 

MRMMMDLVALDNAPROVER MRPDCOPY 

MRMMMDLVALDNAPROVER MRPDSBMT 

MRMMMDLVALDNAPROVER MRPDAPR 

MRMMMDLVALDNAPROVER MRPDAPRRET 

MRMMMDLVALDNAPROVER MRPDRJCT 

MRMMMDLVALDNAPROVER MRMDLSETRL 

MRMMMDLVALDNAPROVER MRMDLSAVE 

MRMMMDLVALDNAPROVER MRMDLEXE 

MRMMMDLVALDNAPROVER MRMDLAPLF 

MRMMMDLVALDNAPROVER MRMDLRSTF 

MRMMMDLVALDNANALYST MRPROCESS 

MRMMMDLVALDNANALYST MRMVADD 

MRMMMDLVALDNANALYST MRMVDEL 

MRMMMDLVALDNANALYST MRMVEXP 

MRMMMDLVALDNANALYST MRMVNEWBD 

MRMMMDLVALDNANALYST MRMVSAVE 

MRMMMDLVALDNANALYST MRMVSBMT 

MRMMMDLVALDNANALYST MRMVEXE 
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Role Code Function Code 

MRMMMDLVALDNANALYST MRPDNEW 

MRMMMDLVALDNANALYST MRPDDEL 

MRMMMDLVALDNANALYST MRPDEXP 

MRMMMDLVALDNANALYST MRPDSAVE 

MRMMMDLVALDNANALYST MRPDEDIT 

MRMMMDLVALDNANALYST MRPDCOPY 

MRMMMDLVALDNANALYST MRPDSBMT 

MRMMMDLVALDNANALYST MRSSCOPY 

MRMMMDLVALDNANALYST MRSSDEL 

MRMMMDLVALDNANALYST MRSSEXP 

MRMMMDLVALDNANALYST MRSSNEW 

MRMMMDLVALDNANALYST MRSSSAVE 

MRMMMDLVALDNANALYST MRSSSBMT 

MRMMMDLVALDNAPROVER MRSSAPR 

MRMMMDLVALDNAPROVER MRSSCOPY 

MRMMMDLVALDNAPROVER MRSSDEL 

MRMMMDLVALDNAPROVER MRSSEXP 

MRMMMDLVALDNAPROVER MRSSNEW 

MRMMMDLVALDNAPROVER MRSSRJCT 

MRMMMDLVALDNAPROVER MRSSSAVE 

MRMMMDLVALDNAPROVER MRSSSBMT 

MRMMMNTCARLOANALYST MRHMADDMDL 

MRMMMNTCARLOANALYST MRHMADDRUL 

MRMMMNTCARLOANALYST MRHMDELMDL 

MRMMMNTCARLOANALYST MRHMDELRUL 

MRMMMNTCARLOANALYST MRHMEDTRUL 

MRMMMNTCARLOANALYST MRHMGENXML 

MRMMMNTCARLOANALYST MRMCSADD 

MRMMMNTCARLOANALYST MRMCSDEL 

MRMMMNTCARLOANALYST MRMCSEXE 

MRMMMNTCARLOANALYST MRMCSEXP 

MRMMMNTCARLOANALYST MRMCSNEWBD 

MRMMMNTCARLOANALYST MRMCSRET 

MRMMMNTCARLOANALYST MRMCSSAVE 

MRMMMNTCARLOANALYST MRMCSSBMT 

MRMMMNTCARLOANALYST MRSSCOPY 
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MRMMMNTCARLOANALYST MRSSDEL 

MRMMMNTCARLOANALYST MRSSEXP 

MRMMMNTCARLOANALYST MRSSNEW 

MRMMMNTCARLOANALYST MRSSSAVE 

MRMMMNTCARLOANALYST MRSSSBMT 

MRMMMNTCARLOAPROVER MRMCSADD 

MRMMMNTCARLOAPROVER MRMCSAPR 

MRMMMNTCARLOAPROVER MRMCSAPRET 

MRMMMNTCARLOAPROVER MRMCSDEL 

MRMMMNTCARLOAPROVER MRMCSEXE 

MRMMMNTCARLOAPROVER MRMCSEXP 

MRMMMNTCARLOAPROVER MRMCSNEWBD 

MRMMMNTCARLOAPROVER MRMCSRET 

MRMMMNTCARLOAPROVER MRMCSRJCT 

MRMMMNTCARLOAPROVER MRMCSSAVE 

MRMMMNTCARLOAPROVER MRMCSSBMT 

MRMMMNTCARLOAPROVER MRSSAPR 

MRMMMNTCARLOAPROVER MRSSCOPY 

MRMMMNTCARLOAPROVER MRSSDEL 

MRMMMNTCARLOAPROVER MRSSEXP 

MRMMMNTCARLOAPROVER MRSSNEW 

MRMMMNTCARLOAPROVER MRSSRJCT 

MRMMMNTCARLOAPROVER MRSSSAVE 

MRMMMNTCARLOAPROVER MRSSSBMT 

MRMMVALNANALYST MRSSCOPY 

MRMMVALNANALYST MRSSDEL 

MRMMVALNANALYST MRSSEXP 

MRMMVALNANALYST MRSSNEW 

MRMMVALNANALYST MRSSSAVE 

MRMMVALNANALYST MRSSSBMT 

MRMMVALNAPROVER MRSSAPR 

MRMMVALNAPROVER MRSSCOPY 

MRMMVALNAPROVER MRSSDEL 

MRMMVALNAPROVER MRSSEXP 

MRMMVALNAPROVER MRSSNEW 

MRMMVALNAPROVER MRSSRJCT 

MRMMVALNAPROVER MRSSSAVE 

MRMMVALNAPROVER MRSSSBMT 
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MRMMADMIN MRHMADDMDL 

MRMMADMIN MRHMADDRUL 

MRMMADMIN MRHMDELMDL 

MRMMADMIN MRHMDELRUL 

MRMMADMIN MRHMEDTRUL 

MRMMADMIN MRHMGENXML 

MRMMADMIN MRMCSADD 

MRMMADMIN MRMCSAPR 

MRMMADMIN MRMCSAPRET 

MRMMADMIN MRMCSDEL 

MRMMADMIN MRMCSEXE 

MRMMADMIN MRMCSEXP 

MRMMADMIN MRMCSNEWBD 

MRMMADMIN MRMCSRET 

MRMMADMIN MRMCSRJCT 

MRMMADMIN MRMCSSAVE 

MRMMADMIN MRMCSSBMT 

MRMMADMIN MRSSAPR 

MRMMADMIN MRSSCOPY 

MRMMADMIN MRSSDEL 

MRMMADMIN MRSSEXP 

MRMMADMIN MRSSNEW 

MRMMADMIN MRSSRJCT 

MRMMADMIN MRSSSAVE 

MRMMADMIN MRSSSBMT 

MRMMADMIN MRTECHADD 

MRMMHISTSMLNANALYST MRSSCOPY 

MRMMHISTSMLNANALYST MRSSDEL 

MRMMHISTSMLNANALYST MRSSEXP 

MRMMHISTSMLNANALYST MRSSNEW 

MRMMHISTSMLNANALYST MRSSSAVE 

MRMMHISTSMLNANALYST MRSSSBMT 

MRMMHISTSMLNAPROVER MRSSAPR 

MRMMHISTSMLNAPROVER MRSSCOPY 

MRMMHISTSMLNAPROVER MRSSDEL 

MRMMHISTSMLNAPROVER MRSSEXP 

MRMMHISTSMLNAPROVER MRSSNEW 

MRMMHISTSMLNAPROVER MRSSRJCT 
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MRMMHISTSMLNAPROVER MRSSSAVE 

MRMMHISTSMLNAPROVER MRSSSBMT 
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20 Appendix N: Migration for Excel Upload 

This appendix provides detailed instructions to migrate for excel upload. 

20.1.1 Prerequisites 

• Data model in ATOMIC schemas should be same on the source and target setups. 

• OFS AAI (platform) patch level version should be same on the source and target setups. 

• PL/SQL Developer to connect and query the database. 

• WinSCP to connect and access server file system. 

20.1.2 Migration for Excel Upload 

To migrate, follow these steps: 

1. Open PL/SQL Developer and logon to the source setup’s configuration (CONFIG) schema by 
entering the appropriate username and password. 

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.  

3. Open a new session in PL/SQL developer and logon to the target setup’s configuration (CONFIG) 
schema by entering the appropriate username and password.  

4. Insert the records from Step 1 above in to this table. 

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name with the 

target infodom name. 

 

NOTE If all the mappings can work out of the single target Infodom, 

update same Infodom value across all rows. If only few 

mappings will work out of the target infodom, update the 

infodom value for selective records. Excel upload mappings will 

work only if the target infodom has same data model entities as 

used in the mappings defined on source setup. 

 

6. Update V_CREATED_BY column with the name of any user present in the target setup that has 

appropriate roles to perform Excel Upload tasks. 

 

NOTE It is mandatory to update values for V_INFODOM and 

V_CREATED_BY columns. 

 

7. Open WinSCP and login a new session by entering the host name, port number, user name and 
password to access the source setup.  

8. Navigate to the folder referred as FTPSHARE. 

9. Copy the excel-entity mapping xml file(s) which are located in this folder according to their folder 
structure on to your desktop. For example: /ftpshare 

/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml 
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NOTE Actual file name of Excel Sheet is mentioned in the 

V_EXCEL_NAME column of EXCEL_MAPPING_MASTER table. 

 

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to their 
folder structure on to your desktop. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

 

NOTE Ignore this step if files are not present at the location. 

 

11. Login a new session in WinSCP by entering the host name, port number, user name and 
password to access the target setup.  

12. Copy the xml file(s) from Step3 to the below location in the target setup. For example: 
/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME.xml 

 

NOTE $TARGET_INFODOM_NAME should be target setup infodom in 

which you have uploaded the appropriate data model and the 

name should be same as the V_INFODOM column value 

updated in EXCEL_MAPPING_MASTER table. 

 

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

 

NOTE Ignore this step if files are not present at the location. 
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21 Appendix O: JDBC Jar Files 

The ojdbc<version>.jar file should be copied based on Database & Java version. Refer to the 

following table for details.  

 

Oracle Database version JDK/JRE Version supported JDBC Jar files specific to the 

release 

12.1 or 12cR1 JDK 8 ojdbc7.jar for JDK 8 

11.2 or 11gR2 JDK 8 supported in 11.2.0.3 and 
11.2.0.4   

ojdbc6.jar for JDK 8  
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22 Appendix P: Upgrading an Existing OFSAA 8.0.x Java 
7 Instance to Java 8 

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to 
Java 8. It consists of the following topics: 

• Prerequisites 

• Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 

• Web Application Server Configurations 

• OFSAA Generic Configurations 

• OFSAA Configurations for New Web Application Server Installation 

22.1 Prerequisites 

The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8: 

• Java 8 should be installed on the OFSAA server and Web Application Server. 

22.2 Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8 

To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps: 

1. Configure Web Application Server to Java 8. For more information, refer Web Application Server 
Configurations. 

2. Configure the OFSAA instance to Java 8. For more information, refer. OFSAA Generic 
Configurations. For a newly installed Web Application Server, refer OFSAA Configurations for 
New Web Application Server Installation. 

3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure Services 
section in Appendix D. 

4. Generate the application EAR/WAR file and redeploy the application onto your configured web 
application server. For more information on generating and deploying EAR / WAR file, refer 
Appendix C. 

22.3 Web Application Server Configurations 

This section describes the changes to be made in the Web Application Server. Following are the two 
options to perform Web Application Server Configurations which are listed as follows: 

• Upgrade the existing Web Application Server installation to Java 8 

• Install a new instance of the Web Application Server with Java 8  

This section consists of the following topics: 

• Oracle WebLogic Server Updates 

• Apache Tomcat Server Updates 

22.3.1 Oracle WebLogic Server Updates 

Perform the following configurations to upgrade the existing WebLogic server instance to Java 8: 
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1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver. 

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME 

properties to the new Java path and java.vm.version to the new Java version. For example, 

JAVA_HOME=/usr/java/jre1.8.0_45  

WLS_JAVA_HOME=/usr/java/jre1.8.0_45  

JAVAHOME=/usr/java/jre1.8.0_45  

java.vm.version=1.8.0_45 

3. Navigate to 
<WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin. 

Update SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the 

setDomainEnv.sh file to point to the new Java path. For example, 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45" 

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"  

JAVA_HOME="/usr/java/jre1.8.0_45" 

4. Clear the Application cache. Navigate to the following path and delete the files: 

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps: 

1. Install Oracle WebLogic Server 12.2.x on Java 8. 

2. Perform the configurations for the newly installed WebLogic server. For more information refer 
Configure Resource Reference in WebLogic Application Server. 

 

NOTE While creating WebLogic Domain, the Listen Port should be set 

same as that of the existing Domain. Note down the new 

Domain path to perform OFSAA Configurations. 

 

22.3.2 Apache Tomcat Server Updates 

Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java 
8: 

1. Login to the Apache Tomcat Server as a non-root user. 

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. 

For Example, 

JAVA_HOME=/usr/java/jre1.8.0_45 

3. Clear the Application cache. Navigate to the following path and delete the files: 

<Tomcat installation folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

If you wish to install a new instance of the Apache Tomcat Server, follow these steps: 

1. Install Apache Tomcat Server 8 with Java 8. 

2. Perform the configurations for the newly installed Tomcat server. For more information refer 
Configure Resource Reference in Tomcat Application Server. 
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NOTE Update the Connector Port in /apache-tomcat-

8.0.21/conf/server.xml file to that of the existing Tomcat 

instance.  

 

Note down the new deployment path to perform OFSAA Configurations. 

22.4 OFSAA Generic Configurations 

This section consists of the following topics: 

• User .profile Settings 

• Configurations for Java 8 

22.4.1 User .profile Settings 

Perform the following configurations: 

1. Login to the OFSAA Server as a non-root user. 

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For 

Example, 

PATH=/usr/java/jre1.8.0_45/jre  

JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_45/jre/lib/amd64/se

rver 

22.4.2 Configurations for Java 8 

1. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_ HOME/jdbc/lib to 

the following locations: 

▪ $FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

▪ $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

▪ $FIC_HOME/ficdb/lib/ 

▪ $FIC_HOME/ficapp/icc/lib/ 

▪ $FIC_HOME/ficapp/common/FICServer/lib/ 

▪ $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

▪ $FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

▪ $FIC_HOME/ficdb/etl/classes/ 

 

NOTE If ojdbc6.jar is already present in any of the aforementioned 

folders, you need to remove it. 

 

2. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_ HOME/jdbc/lib to 

the following locations: 
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▪ $FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

▪ $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

▪ $FIC_HOME/ficdb/lib/ 

▪ $FIC_HOME/ficapp/icc/lib/ 

▪ $FIC_HOME/ficapp/common/FICServer/lib/ 

▪ $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

▪ $FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

▪ $FIC_HOME/ficdb/etl/classes/ 

22.5 OFSAA Configurations for New Web Application Server 
Installation 

This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache 
Tomcat Server 8.0. Follow these steps: 

1. Modify the following parameters in the Configuration table present in the Config Schema with the 
new Domain Path in case of WebLogic or with the new deployment path in case of Tomcat: 

▪ DeFiHome 

▪ REV_IMG_PATH 

▪ EMBEDDED_JSP_JS_PATH 

2. Login to the OFSAA Server as a non-root user. 

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in 

the web.xml file with the new Domain path in case of WebLogic or with the new deployment path 

in case of Tomcat: 

▪ FIC_PHYSICAL_HOME_LOC 

▪ FIC_HOME 

▪ ICC_SERVLET_LOG_FILE 

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of 

WebLogic or with the new deployment path in case of Tomcat: 

▪ OFSAALogger.xml 

▪ MDBLogger.xml 

▪ RevLog4jConfig.xml 

▪ RFDLogger.xml 

▪ ExportLog4jConfig.xml 

▪ RFDLogger.xml 

▪ PR2Logger.xml 
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23 Appendix Q: Removing OFSAA 

This chapter includes the following sections: 

• Uninstalling OFSAA Installation 

• Uninstalling EAR Files in WebSphere 

• Uninstalling EAR Files in WebLogic 

• Uninstalling WAR Files in Tomcat 

23.1 Uninstalling OFSAA Installation 

This section will guide you through the necessary steps to uninstall the OFSAA 8.0 installation. 

Before you start the uninstall process, ensure that no open connections exist to the OFSAA Config and 
Atomic Schemas and Infrastructure services are brought down. 

To uninstall OFSAA: 

1. Log in to the system as non-root user. 

2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAA Configuration Schema when prompted as shown in the following 
figure. 

 
 

NOTE • Uninstallation does not remove the Infrastructure 

application from the Web Application Server. This has 

to be done manually. 

• The entries in the .profile file will have to be removed 

manually. 

• The files/ folders under the file system staging area 

(ftpshare) have to be deleted manually. 

• All the Database objects from Atomic Schemas have to 

be dropped manually. 
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23.2 Uninstalling EAR Files in WebSphere 

Following are the steps to uninstall any previously deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console 

Port>/ibm/console (https if SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights. 

3. Expand Applications > Application Types > WebSphere enterprise applications from the 
LHS. The Enterprise Applications window is displayed with all the deployed applications. 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop. 

5. Click Uninstall. The Uninstall Application window is displayed. 

 

6. Click OK to confirm. 

7. Click Save to save the master file configuration. 

23.3 Uninstalling EAR Files in WebLogic 

On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed 
application: 

1. Open the URL in the browser window: http://<ipaddress>:<admin server 

port>/console (https if SSL is enabled). The Login window of the WebLogic Server 

Administration Console is displayed. 

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of Deployments 
screen is displayed 
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4. Select the checkbox adjacent to the application to be uninstalled and click Stop> Force Stop 
Now. 

5. Click Yes in the confirmation dialog to stop the selected deployment. 

 

6. Select the checkbox adjacent to the application and click Delete to delete the selected 
deployment. 

7. Click Yes in the confirmation dialog to remove the selected deployment from the domain 
configuration. 

23.4 Uninstalling WAR Files in Tomcat 

On the machine that hosts Tomcat, perform the following steps to uninstall any previously deployed 
application: 

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf directory to 
avoid conflict during undeploy and re-deploy of the WAR file. 

Place comment <!-- --> in between the context path section. For 

example: 

<!-- 
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<Context path ="/pr2test" docBase="/home/perfuser/tomcat-

7.0.19/webapps/pr2test" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container" 

name="jdbc/PR2ATM" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST" 

maxTotal="100"  

maxIdle="30" 

maxWaitMillis="10000"/> 

</Context> 

--> 

2. Restart the Tomcat service by doing the following: 

▪ Login to the "Unix server" through a terminal emulator. 

▪ Navigate to $catalina_home/bin directory. 

▪ Stop the tomcat services using the command ./shutdown.sh 

▪ Start the tomcat services using the command ./startup.sh 

3. Open the URL in a browser window: http://<IP address>:<Tomcat server port>. (https if SSL is 
enabled). The Tomcat home window is displayed. 

4. Click the Manager App. The Connect to window is displayed. 

5. Login with the user credentials having admin rights. The Tomcat Web Application Manager 
window is displayed with the list of all applications deployed in Tomcat. 
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6. Click the Undeploy link against the deployed Infrastructure application. A confirmation message 
is displayed on the application /Infrastructure being uninstalled. 
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24 Appendix R: Enabling Data Redaction in OFSAA 

This section details about the configurations supported by OFSAAI for enabling the Oracle Advanced 
Security feature - Data Redaction in OFSAA applications. 

24.1 Data Redaction 

OFSAA is enhanced to enable masking of sensitive data and Personal Identification Information (PII) to 
adhere to Regulations and Privacy Policies. Oracle Data Redaction provides selective, on-the-fly 
redaction of sensitive data in database query results prior to display by applications so that 
unauthorized users cannot view the sensitive data. The stored data remains unaltered, while displayed 
data is transformed to a pattern that does not contain any identifiable information. 

24.1.1 Enabling Data Redaction in case of Upgrade 

This section details about the configurations required in case you want to enable Data Redaction in 
OFSAA applications after upgrade to OFSAA 8.0.8.0.0 version from a previous version. Additionally, 
these configurations are required in case you did not enable TDE during OFS MRMM 8.0.8.0.0 
installation and want to enable at a later point of time. 

Perform the following steps: 

1. Login as SYSDBA into the database. 

2. Execute the file  

$FIC_HOME/utility/data_security/scripts/create_data_sec_roles.sql only 

once per database (PDB in case of 12c). 

3. Execute the following sql statement to find out the list of atomic users from the table: 

select v_schema_name from aai_db_detail where V_DB_NAME <> 'CONFIG' AND 

V_DB_TYPE = 'ORACLE' 

4. Execute the file  

$FIC_HOME/utility/data_security/scripts/grant_data_sec_roles.sql for all 

atomic users found in the previous step. 

5. From the Configuration window in the System Configuration module, select the Allow Data 
Redaction checkbox. 

6. Run the Data Redaction utility. For more details on how to run the utility, see Data Redaction 
section under Data Security and Data Privacy chapter in OFS Analytical Applications 
Infrastructure Administration Guide 8.0.8.0.0. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAAI_Administration_Guide_8.0.6.0.0.pdf
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25 Appendix S:Enabling Right to be Forgotten 

This section details about the configurations required in case you want to enable Right to be Forgotten 
in OFSAA applications. 

25.1 Right to be Forgotten 

Right to be Forgotten is the task of removing PII (Personally Identifiable Information) of a Data Subject 
for the given Party. The financial institution can delete PII for those Data Subjects who have requested 
this Right to be Forgotten functionality. 

The Data Subjects may have made significant financial transactions, and/or financial information may be 
required for regulatory or compliance reporting. Deleting the complete record that consists of PII may 
lead to issues in data reconciliation. In OFSAA, the PII data will be replaced with randomized values 
and therefore, the complete Data Subject record is retained. As a result, financial information is 
retained; however, the associated Party PII is removed permanently.  

For details see the Right to Be Forgotten section, in Oracle Financial Services Data Foundation User 
Guide in the OHC Documentation Library.   

25.2 Configuring Right to be Forgotten During OFS MRMM 
Installation 

Follow the below steps to configure Right to be Forgotten: 

1. Ensure that you assign the role DATACONTROLLER  

2. Edit the task of the batch <Infodom_name>_RightToForget. By default the parameter is 

SYSADMN. Modify the user ID in the Metadata Value field to the above MRMM user ID. 

 

3. Add the party ID’s entries for right to forget  in the table FSI_PARTY_RIGHT_TO_FORGET 

4. Execute the batch <Infodom_name>_RightToForget 

https://docs.oracle.com/cd/E92917_01/homepage.htm
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26 Appendix T: Patching OFSAA Installation 

Oracle strongly recommends installing the latest available patch set so as to be up to date with the 
various releases of the OFSAA product. Refer http://support.oracle.com for more information on latest 
release. 

http://support.oracle.com/
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27 Appendix U: Configuring Work Manager in Web 
Application Servers 

Process modelling framework requires creation of Work Manager and mapping it to OFSAA instance. 
This configuration is required for WebSphere and WebLogic Web Application Server types. 

This section covers the following topics: 

• Configuring Work Manager in WebSphere Application Server 

• Configuring Work Manager in WebLogic Application Server 

27.1 Configuring Work Manager in WebSphere Application 
Server 

This section is applicable only when the Web Application Server type is WebSphere. 

This section covers the following topics: 

• Creating Work Manager 

• Mapping Work Manager to OFSAA WebSphere Instance 

27.1.1 Creating Work Manager  

1. Open the WebSphere admin console in the browser window: 
http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is 

enabled). The Login window is displayed. 

 

2. Login with the user id that has admin rights.  
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3. From the LHS menu, expand Resources > Asynchronous beans and select Work Managers. 

 

4. Select the required Scope from the drop-down list.  

For example, Node=whf00aqnNode01, Server=server1. 

5. Click New in the Preferences section. 

 

6. Enter the Name as ‘wm’ and JNDI name as ‘wm/WorkManager ‘ in the respective fields.  
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7. Enter the Thread pool properties. 

8. Click Apply. 

 

9. Click Save.  

 

After creating work manager successfully, you have to map it to OFSAA instance. 

27.1.2 Mapping Work Manager to OFSAA WebSphere Instance 

1. From the LHS menu, expand Applications > Application Types and select WebSphere 
enterprise applications. 
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2. Click OFSAAI instance hyperlink. 

 

3. Click Resource references link under References section. 
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4. Click Browse corresponding to the Work Manager Resource Reference. The available resources 
are displayed. 

 

5.  Select the newly created Work Manager (‘wm’) and click Apply. 
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6. Select the Work Manager (‘wm/WorkManager’) and click OK. 

 

7. Click Save. 

 

27.2 Configuring Work Manager in WebLogic Application Server 

This section is applicable only when the Web Application Server type is WebLogic. 

27.2.1 Creating Work Manager 

1. Open the WebLogic admin console in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 

enabled). The Welcome window is displayed. 
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2. Login with the user id that has admin rights.  

3. From the Domain Structure menu in the LHS, expand Environment and select Work Managers. 
The Summary of Work Managers window is displayed. 

 

4. Click New to create a new work manager component. 

 

5. Select Work Manager and click Next.  
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6. Enter the Name as ‘wm/WorkManager’. 

7. Click Next. 

 

8. Select the required deployment target and click Finish.  
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28 Appendix V: FAQs and Error Dictionary 

This section of the document consists of resolution to the frequently asked questions and error codes 
noticed during OFSAAI installation. 

• Frequently Asked Questions 

• Forms Framework FAQs 

• Error Dictionary 

OFSAAI installer performs all the pre-requisite validation check during installation. Any errors 
encountered in the process is displayed with an appropriate Error Code. You can refer to the Error 
Dictionary to find the exact cause and resolution to rectify the error. 

28.1 Frequently Asked Questions 

You can refer to the Frequently Asked Questions which has been developed with the interest to help 
you resolve some of the OFSAAI Installation and configuration issues. This intends to share the 
knowledge of problem resolution to a few of the known issues. This is not an official support document 
and just attempts to share the knowledge of problem resolution to a few of the known issues.  

This section includes the following topics: 

• OFSAAI FAQs 

• Application Pack 8.0.8.0.0 FAQs 

28.1.1 OFSAAI FAQs 

What are the different components that get installed during OFSAAI? 

The different components of OFSAAI are illustrated in "Components of OFSAAI". 

What are the different modes of OFSAAI installation? 

OFSAAI can be installed in two modes, Silent Mode, and GUI mode. 

Can the OFSAA Infrastructure components be installed on multi-tier? 

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By 
default, they will be installed on single-tier. However, OFSAA Infrastructure can be deployed within the 
n-Tier architecture where the Database, Web Server and Web Application Server is installed on 
separate tiers. 

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after 
OFSAA installation? 

JDK is not required during installation of OFSAA and only a run time is needed for details. 

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation? 

Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be 
uninstalled as the JRE is used by the OFSAA system to work. 

How do I know what is the Operating system, webservers and other software versions that 
OFSAA supports? 

Refer to OFSAA Technology Stack Matrices. 

What are the different files required to install OFSAAI? 

The following files are required: 
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• setup.sh. 

• envCheck.sh 

• preinstallcheck.sh 

• VerInfo.txt 

• OFSAAInfrastructure.bin 

• validatedXMLinputs.jar 

• MyResources_en_US.properties 

• log4j.xml 

• OFSAAI_PostInstallConfig.xml 

• OFSAAI_InstallConfig.xml 

• privileges_config_user.sql 

• privileges_atomic_user.sql 

Is OFSAAI license specific to Applications? 

No, OFSAAI license is not specific to any application. 

During installation, when one gets an error message, "Execute Permission denied", what is to be 
done? 

Please check whether all the files provided for OFSAAI installation has execute permissions.  

To give execute permissions, 

Navigate to the path OFSAAI_80800 and execute the command 

chmod 755 

"Graphical installers are not.." 

If error resembles "Graphical installers are not supported by the VM. The console mode will be used 
instead..." then check whether any of the X-windows software has been installed. 

Example: Hummingbird Exceed is started and configured to Graphical mode installation. 

 

NOTE Type 'xclock' from prompt and this should display clock in 

graphical mode. 

 

"No Java virtual machine could be…" 

If the error message reads "No Java virtual machine could be found from your PATH 
environment variable. You must install a VM prior to running this program", then 

• Check whether "java path" is set in PATH variable. See the "Prerequisite 
Information" section in this document. 

• Check whether sufficient temporary space is available. 

• Ensure that the movement of OFSAAI Installer text files to the target system 
is done in the Text mode so that setup.sh file does not contain control line 
feed characters (^M). 
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During the installation, what should one do if the error message shows 
"OracleDriver Files Not Found, Please Choose the Right Path To Continue"? 

Check whether the provided path for Oracle Driver files is correct and whether the 
user has permissions to access the files. 

During installation, what is to be done if the error always reads "User must 
have CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, 
CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema 
user created has the mentioned privileges? 

OFSAAI installer validates the database details provided during installation, so 
ensure: 

Whether the oracle schema user has the required set of privileges for successful 
installation. 

Whether the oracle schema user has been created with quota privileges on 
tablespace to create database objects. 

See “Prerequisite Information" section in this document. 

Installation of OFSAAI was completed successfully! What next? 

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 5, "Post Installation Configuration".  

What is to be done when OFSAAI Installation is unsuccessful? 

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 

Infrastructure installation directory. There is also another log file created in the path 
configured in Log4j.xml. If the logs of any of these reported, Warnings, Non Fatal 

Errors, Fatal Errors or/Exceptions, they should be brought to the notice of the 
OFSAAI Oracle Support Services. It is recommended not to proceed, until the 
reported problems are adequately addressed. 

How do I completely uninstall OFSAAI? 

OFSAAI can be completely uninstalled by performing the steps provided in 
Uninstalling OFSAA Infrastructure section in OFSAAI guide. 

Can OFSAAI config and atomic schemas be on different databases? 

OFSAAI requires both config and atomic schemas to be present on the same 
database instance. 

How do I grant privileges if a new information domain is created? 

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema. 

• Log into the database as sys and connect as sysdba user. 

• Execute the file privileges_config_user.sql available under $FIC_HOME 
directory 

• Enter the database schema for which you want to grant privileges. 

When should I run the MLS utility? 

See the Multiple Language Support (MLS) Utility section in OFS AAI Administration 
Guide available on OHC Documentation Library. 

Does OFSAAI support Oracle Linux versions other than 5.5? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 
and above. 

On the UNIX System terminal, error message shows "Insert New Media. Please 
insert Disk1 or type it's location"while executing ./setup.sh, what should be 
done? 

1. Login as root user on the Unix machine where OFSAAI is getting installed. 

2. Navigate to the path /etc/security/.  

3. Edit the file limits.conf to add/edit a row for the unix user installing 

OFSAA: 

<Unix User> soft nofile 9216 

4. After saving the changes, log in as unix user with which OFSAAI is getting 
installed and execute the command: 

ulimit -n 

The command should return the value 9216. 

How does one verify if the system environment is ready for OFSAAI 
installation? 

To verify the system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive file. 
This utility can also be obtained separately by contacting Oracle Support. 

See Verifying System Environment section for additional information.  

How does one know if the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check 
automatically on successful installation of the product. To rerun the post install 
verification at a later time, perform the following steps: 

1. Navigate to the path $FIC_HOME (Product Installation Directory). 

2. Execute the command: 

./piverify.sh 

What should one do if the installation in GUI mode is not invoked? 

There are set of configuration steps required to be performed during the installation 
in GUI mode. Verify whether the steps mentioned under Configuration for GUI Mode 
Installation section are done correctly.  

What should one do if there are any exceptions or errors in installation and 
how to proceed? 

1. Please backup the installation logs. 

2. Share the backup logs with Oracle Support Services. 

On Solaris 11 system, if one gets the following error message during OFSAAI 
installation, what should be done: 

"Error: OFSAAI-1108 

ORA-00604: error occurred at recursive SQL level 1 

ORA-01882: timezone region not found" 

Or 
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"Time zone cannot be set as null or 'localtime' " 

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set 
the environment variable TZ to a valid time zone region in the .profile file. For 
example,  

TZ=Asia/Calcutta 

export TZ 

What happens if the installation process is abruptly terminated or aborted? 
What should one do? 

If the installation process is abruptly terminated, then the installation process will be 
incomplete. To recover from this, follow the below steps: 

1. Drop the DB objects in the config schema created by OFSAAI installation. 

2. Open the .profile and remove the entries made by the OFSAAI installation 
which are made between the comment statements, #Beginning of entries by 
OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation. 

3. Delete the OFSAA install directory created by the OFSAAI installer. 

4. Perform the OFSAAI installation again.  

Does OFSAA support any other web server types, other than the ones stated 
in Tech Matrix and Installation Guide? 

No, all the supported softwares and versions are stated in the OFSAA Technology 
Stack Matrices. 

What should one do if the database connection from connection pool throws 
an error  

"java.sql.SQLRecoverableException: IO Error: Connection reset"? 

This happens while running several database intensive tasks in parallel. To correct 
this error, add the line securerandom.source=file:/dev/./urandom in the java.security 
configuration file available in $JAVA_HOME/jre/lib/security/ path. 

 

NOTE This needs to be configured on all the machines or VMs where 

the OFSAAI components are installed. 

 

If the issue is not resolved even with the above settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and 
updating them, contact your system Administrator. 

When I invoke setup.sh file from my install archive, it throws syntax errors/file 
not found error messages, what should I do? 

This could mostly happen: 

When installer was not unzipped rightly or corrupted during unzip. 

setup.sh file which resides within the install archive was not transferred in ASCII or 
text mode, which could have corrupted the file. 

To correct this, follow the steps: 

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed. 
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2. Unzip the installer using the command: 

unzip <OFSAAI_Installer>.zip 

3. The corrupted setup.sh file would have introduced certain ^M characters into 
the file. You can remove ^M characters from setup.sh file by following the 
below steps:  

a. Login to the server where the installer is copied.  

b. Navigate to the directory OFSAAI_80800.  

c. Open the setup.sh file in the vi editor using the command: vi 

setup.sh.  

d.  Inside vi editor in Esc mode, type: %s/^M//g 

 

NOTE To enter ^M, hold the CTRL key then press V and M in succesion. 

 

 
 

Save the setup.sh file by typing: wq!  

Does OFSAA support Oracle DB 11g Standard edition? 

The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise 
edition. So, OFSAAI will work with standard edition as well. 

We do not recommend standard edition because it will not scale and does not support partition pack, 
database security vault, or advanced analytics. 

What should I do if I get the following error message while executing ./startofsaai.sh file on the 
UNIX System terminal "./startofsaai.sh: /java: Execute permission denied? 

• Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where the 
startofsaai.sh fileis invoked. 

• Ensure the .profile where the environment/ path settings are made has been executed 
successfully. 

OFSAAI Login page does not come up, error message "Could not retrieve list of locales" is 
displayed. What should one do?  

This could be due to 2 reasons: 

• System is unable to resolve the hostname configured. 

• Conflict with the ports configured. 

To correct them, follow the below steps: 

1. Steps to replace the hostnames with IP address: 

a. Stop all the OFSAA services. See Stopping Infrastructure Services section on how to stop the 
services. 

b. Replace all the hostnames with the IP address in all the places mentioned in the document 
(Where to find port, IP address, HTTPS Configuration for OFSAAI 7.2 Installation (DOC ID 
1500479.1)). 

c. Restart all the OFSAAI services. For more information, refer Starting Infrastructure Services 
section. 
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2. Steps to correct the port number conflicts 

a. Stop all the OFSAA services. 

b. Refer to the port numbers stated in the document (Where to find port, IP address, HTTPS 
Configuration for OFSAAI 7.2 Installation (DOC ID 1500479.1)) and check on the discrepancy 
in the port numbers and correct them. 

c. Restart all the OFSAAI services. 

What should I do if the OFSAAI Application Server does not proceed even after providing the 
system password? 

Ensure that, the System Password provided when prompted is "password0". Also check whether the 
connection to the "configuration schema" can be established through SQLPlus. 

Although the OFSAAI installation has completed successfully, when OFSAAI servers are started, 
and the application URL is accessed, it gives an error message "the page cannot be found or 
displayed" or "Could not retrieve list of languages from Server. Please contact the system 
administrator". What should one do? 

Ensure OFSAAI servers have been started and are running successfully. For details on start up 
parameters options, see Starting Infrastructure Services section. 

For more details on the issue, refer on to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files. 

Is it necessary to provide the specified grants to the Oracle schema user before installation? If 
yes, can it be revoked after completion of installation? 

The "Oracle schema" user requires the necessary grants specified before, during, and after the 
installation process. Grants provided should never be revoked as the application makes use of these 
grants all the time. 

Can we have distributed OFSAAI Application Server for load balancing? 

OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on 
the various services and Information Domains, in other words, Load balancing could be achieved with 
distribution of services. 

Why do we need FTPSHARE? Why is it needed on all the layers? Can we have ftpshare on 
another machine other than the machines where OFSAAI is installed? 

FTPSHARE is a Metadata Repository directory. All the metadata related files used in Infrastructure are 
stored in the ftpshare directory. The FTPSHARE contains folders for each Information Domain, with 
each Information Domain folders holding Erwin, log, and scripts folder. The transfer of data among the 
Web, Application, and Database servers in Infrastructure takes place through FTP/SFTP. 

You need to configure FTP/SFTP and enable communication between the servers by providing App 
server's FTP/SFTP credentials to the Web server and DB server users. 

Yes, you can have FTPSHARE on another machine other than the machines where OFSAAI is 
installed. 

Is it mandatory to provide the FTP/SFTP password?  

Yes, OFSAAI needs credentials of the user who has complete permissions on ftpshare directory, and 
the user should be able to independently login to the unix server. 

What are the permissions required for FTPSHARE and when should I give them? 

It is recommended to provide permissions on FTPSHARE in case of installations done across different 
machines or VMs (multitier installation). 

In case of single tier installation, 770 permissions can be provided if the Unix users of OFSAAI and web 
server belong to the same Unix group. 
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Additionally, any new file that is created in the FTPSHARE folder of any installation layer should be 
granted specific/explicit permission. 

Port Change utility can be used to have the Port number modified, which are currently being used by 
the Infrastructure application. For more information, see Changing IP/ Hostname, Ports, Deployed Paths 
of the OFSAA Instance section in OFS Analytical Applications Infrastructure Administration User Guide 
in OTN. 

Are there any in-built system administration users within OFSAAI Application? 

The three in-built system administration users are provided to configure and setup OFSAAI. 

• SYSADMN  

• SYSAUTH 

• GUEST  

Does OFSAAI Application support both FTP and SFTP? 

OFSAAI supports both FTP and SFTP configuration. 

Is it necessary to enable the FTP/SFTP services to use the OFSAAI? 

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards using the OFSAAI. 

OFSAAI Configuration: Unable to save the server details? 

Ensure the input User ID, Password, and Share Name are correct. 

• Ensure FTP/SFTP services are enabled. 

• Have a test FTP/SFTP connection made and confirm if they are successful. 

During Information Domain creation, the message "Please create a database and then create the 
information domain" appears. What should be done? 

Information Domain is mapped to only one Database; and thus before the creation of Information 
Domain, at least one database details should exist. 

The message "ConnectToDatabase: FatalError, could not connect to the DB server" appears 
during startup of backend engine message server. What does one need to do? 

• Verify whether connection to the "Configuration Schema" can be established through SQL*Plus. 

• Verify "Configuration Schema" password is modified post installation. 

• Ensure Oracle Database Alias Name created for Oracle Instance and Oracle Service Name are 
same. 

• On a multi tier installation mode, ensure TNSNAME and SID are same in Application and 
Database Layers. 

Does OFSAAI Application support LDAP authentication? 

OFSAAI supports LDAP configuration and authentication. 

Does OFSAAI support multiple languages? 

Yes, OFSAAI supports multiple languages. 

Does OFSAAI provide any data back-up features? 

OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for 
back-up. 

What kind of security features does the OFSAAI provides? 

OFSAAI provides security at: 
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• Segment Level - Users can access only the segment they are mapped to. 

• Application Level - Users can perform an operation only if mapped to appropriate role and 
functions. 

Does OFSAAI have the ability to enforce periodic password change? 

OFSAAI provides configurable parameters to define number of days after which the user password 
would expire and then the user is forced to change the password after expiration period. 

What is the password policy followed in OFSAAI? 

OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters 
and alpha-numeric strings. 

Which version of Erwin Data Modeller does OFSAAI support? 

OFSAAI now supports ERwin version 9.2 and 9.5 generated xmls in addition to ERwin 4.1, ERwin 7.1, 
ERwin 7.3 and ERwin 9.0 formats. 

Does OFSAAI provide the mechanism to upload Business Data model? 

OFSAAI provides two mechanisms for business data model upload: 

• Easy to use GUI based Model upload mechanism to upload the Business Data Model through 
Data Model Management -->Data Model Maintenance--> Import Model. 

• OFSAAI also provides a model upload utility "upload.sh" for uploading the business data model 
through the command line parameter by executing this shell script file under the path 
<FIC_HOME>/ficapp/common/FICServer/bin. 

For more details, see Configuration for Model Upload Utility section of the OFS Analytical Applications 
Infrastructure User Guide available on OHC Documentation Library.  

The Business Data model undergoes changes; how does this incremental change get applied to 
the existing model? 

Modified data model can be uploaded into the system and OFSAAI has the ability to compare the 
changes within the data model with respect to the one already present in the system and enables 
propagation of incremental changes in a consistent manner. 

What are the different types of uploading a business data Model?  

OFSAAI supports uploading of business data model from client desktop and also by picking up the data 
model from the server location. 

Can the OFSAAI "Configuration Schema" password be modified post installation? 

The OFSAAI "Configuration Schema" password can be modified post installation. OFSAAI application 
stores the password in the database and few configuration files, thus any changes to the "Configuration 
Schema" password require updating those files. Contact Oracle Support Servies for more details. 

Can the OFSAAI "Atomic Schema" password be modified? 

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application stores the atomic 
schema password in the database and few configuration files, thus any change to the atomic schema 
password requires updating those files. 

To change the Atomic Schema password, follow the steps: 

1. Login to OFSAA. 

2. Navigate to System Configuration > Database Details window. Select the appropriate connection, 
provide the modified password and save. 

3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources 
window. Update the appropriate Source details. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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a. If you are using Apache as Web server: 

* Update the <Context> -> Resource tag details in server.xml file from the 

$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> will exist). 

b. If you are using WebSphere as Web server: 

i. * Login to the WebSphere Administration Console from the left side menu. 

ii. * Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

iii. * Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources need to be modified). 

c. If you are using WebLogic as Web server: 

i. * Login to the WebLogic Administration Console from the left side menu. 

ii. * Under Domain Structure list box, expand the appropriate Domain and navigate to 
Services > JDBC >Data Sources. A list of data sources will be populated on the right 
side. 

iii. * Select the appropriate Data Source and edit the connection details. (In this case, both 
Config and Atomic data sources need to be modified). 

4. Restart the OFSAAI services 

 

NOTE If the modified passwords are not updated, OFSAAI logs 

displays the message ORA-28000: the account is locked. 
 

Does the upload of Business Data model depend on Java Memory? 

Business data model upload through OFSAAI depends on the Java memory settings on the client and 
server machines. Java memory setting varies with the data model size and the available RAM. Contact 
Oracle Support Services for more details. 

Why do the Business Metadata Management screens (Business Processors screen) in User 
Interface, takes longer time to load? 

The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being 
updated/refreshed to cache metadata. This can be observed when you are starting startofsaai.sh 

and if any of the log file (for example: SMSService.log) in DynamicServices.xml is being continuously 
refreshed for longer time. 

By default, the Metadata Log file cache size is set to 1000. If in case the log is being updated beyond 
this limit, retrospectively the preceding entries are overwritten. For example, the 1001th entry is 
overwritten by deleting the first entry. This results in the application screen taking a longer time to load. 

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the 
currently logged count for the specific metadata. 

1. Generate the Log report by executing the below query in config schema. 

select count(1), t.metadata_name, m.dsn_id 

from metadata_master m, metadata_type_master t  

where m.metadata_type = t.metadata_type 

group by t.metadata_name, m.dsn_id  

2. The above query returns a list of codes with their respective metadata count. You can refer to 
"metadata_type_master" table to identify the metadata name. 
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3. View the log report to identify the metadata which is being updated/refreshed beyond the 
specified cache size limit. Accordingly increase the cache size limit in Dynamicservices.xml 
depending on the currently logged count for the specific metadata. 

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log 
is 1022, increase the limit to 2000 (approximately). 

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue. 

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere application 
server? 

The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere Install 
directory>/AppServer/deploytool/itp. For example,  

$JAVA_CMD \ 

-Xbootclasspath/a:$ejbd_bootpath \  

Xms256m -Xmx1024m \ 

What configurations should I ensure if my data model size is greater than 2GB? 

In order to upload data model of size greater than 2GB from Data Model Management -->Data Model 
Maintenance--> Import Model, you need to configure the required model size in struts.xml file available 
in the path $FIC_WEB_HOME/webroot/WEB-INF/classes. 

 

NOTE The size requirements have to be always specified in bytes. 

 

For example, if you need to configure for model size of 2.5GB, then you can approximately set the max 
size to 3GB (3221225472 bytes) as indicated below, in order to avoid size constraints during model 
upload. 

<constant name="struts.multipart.maxSize" value="3221225472"/> 

After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application 
onto your configured web application server. For more information on generating and deploying EAR / 
WAR file, see Configuring Web Application Servers. For more information on generating and deploying 
EAR / WAR file, refer Appendix C. 

What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the 
underlying Hierarchy? 

In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been 
changed. This can occur in hierarchy maintenance, where you have moved a member to another 
hierarchy branch, and that member was explicitly selected in the Filter and is now a child of a node 
which is already selected in the Filter. 

Please refer Support Note for the workaround. 

How do you turn off unused information domains (infodoms) from cache? 

Follow the below steps to turn off unused infodoms from cache: 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.  

2. In the DynamicServices.xml file, identify the section for <Service code="20">.  

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).  

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the 
application onto your configured web application server. For more information on generating and 
deploying EAR / WAR file, see Configuring Web Application Servers. 

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=515785812718831&amp%3Bid=1586342.1&_afrWindowMode=0&_adf.ctrl-state=4pqbe8e6n_45
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Restart the OFSAAI Services (APP and WEB). For more information, see Appendix D. 

 

NOTE This setting will cache the Infodom metadata only for the 

infodoms that get accessed upon user login. Infodoms which do 

not get accessed, will not be cached. 

 

Sample code is pasted below:  

<SERVICE CODE="20"  

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"  

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">  

<PARAMETERS>  

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />  

<PARAMETER NAME="BACKUP_XML" VALUE="1" />  

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />  

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />  

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />  

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />  

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />  

</PARAMETERS>  

</SERVICE> 

Can I install an Application Pack on an existing Atomic schema/ Information Domain created 
manually? 

No, you cannot install an Application Pack on existing Atomic schema/Information Domain created 
manually. Application Packs can be installed only on Atomic Schemas/Information Domain created 
using schema creator utility and/ or the Application Pack installer. 

When trying to view the model outputs in Model Outputs screen, I get "Exception ->Local 
Path/STAGE/Output file name (No such file or directory)". 

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server 
details screen. This folder needs to be created under the local path on every node ,in case of web 
application server clustering. 
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During OFSAA services startup, I get Exception in thread "main" java.lang.UnsatisfiedLinkError: 
net (Not a directory)? 

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a 
physical JRE installed. 

What is the optimized memory settings required for "New" model upload? 

The following table lists the optimized memory settings required for "New" model upload. 

 

Upload Options Size of Data Model XML File X_ARGS_APP ENV Variable in 

OFSAAI APP Layer 

Pick from Server 106 MB "-Xms1024m -Xmx1024m 

36 MB "-Xms2048m -Xmx2048m 

815 MB "-Xms4096m -Xmx4096m 

1243 MB "-Xms6144m -Xmx6144m 

Model Upload Utility 106 MB "-Xms1024m -Xmx1024m"-
Xms2048m -Xmx2048m 

336 MB "-Xms4096m -Xmx4096m 

815 MB "-Xms4096m -Xmx4096m 

1243 MB "-Xms6144m -Xmx6144m 

Save New Erwin File In Server 106 MB "-Xms1024m -Xmx1024m 

336 MB "-Xms2048m -Xmx2048m 

 "-Xms4096m -Xmx4096m 

 "-Xms6144m -Xmx6144m 

 

I did not enable OFS Inline Processing Engine Application license during the installation. 
However, I have enabled it post installation, using the Manage OFSAA 

Product License(s) in the Admin UI. Are there any other additional configurations that I need to 
do? 

Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide. 

I get an error when I try to build an Oracle OLAP cube. What should I do?  

Execute the below grant on the appropriate ATOMIC schema grant olap_user to &database_username 

How do you turn off unused Information Domains (Infodoms) from caching? 

Follow these steps to turn off unused infodoms from caching: 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

2. In the DynamicServices.xml file, identify the section for <Service code="20">.  

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).  

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the 
application onto your configured web application server. For more information on generating and 
deploying EAR / WAR file, refer Appendix C. 

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start OFSAA 
Infrastructure Services section. 
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NOTE This setting will cache the Infodom metadata only for the 

infodoms that get accessed upon user login. Infodoms which do 

not get accessed, will not be cached. 

 

Sample code is pasted below:  

<SERVICE CODE="20"  

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"  

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">  

<PARAMETERS>  

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />  

<PARAMETER NAME="BACKUP_XML" VALUE="1" />  

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />  

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />  

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />  

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />  

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />  

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />  

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />  

</PARAMETERS>  

</SERVICE> 

"While creating an Excel Mapping, after specifying the excel worksheet, the target table, and 
mapping each column in the worksheet to a target table, I click Save and nothing happens. But 
when I click Cancel, a message pops up informing me that all changes will be discarded", what 
is to be done. 

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the Desktop Requirements 
section of this manual. If not, use the qualified versions as mentioned. 

Can multiple OFSAA Infrastructure instances share the same Config Schema?  

No, only one OFSAA environment can be installed using one Config Schema.  

Can Atomic Schema be shared? 

Yes, it can be shared between two OFSAA instances. 
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While setting a firewall, which ports should be opened for communication between the Web 
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web Application 
Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly? 

The OFSAA Servlet port which is same as Web server port should be open. Also the web application 
port should be open. 

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where older 
versions of OFSAA is Installed? 

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use 
multi language support. 

Can I install already installed application in a different infodom? 

No, it is not possible to install the same application in two different infodoms. 

How can I configure the OFSAA application for High Availability? 

OFSAA can have active-passive high availability. For more details, refer Configuration for High 
Availability- Best Practices Guide. 

I want to configure OFSAA for High Availability that is weblogic cluster on which OFSAA.ear is 
deployed and cluster OFSAAI processes (such as Reveleus etc) are running. Is this a supported 
configuration? 

High Availability is available for WebLogic cluster and DB level as active-active, but is not available on 
the application side. OFSAA can have active-passive high   availability. For more details, refer 
Configuring OFSAA in Clustered Environment Guide. 

During OFSAA installation should I provide web application server's IP /Hostname and port or 
web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP 
Server are configured? 

In case the web server is configured, you should enter the Web Server IP Address/Hostname and Port 
details during OFSAA installation. Here the Servlet port should be same as the Web Server port. 

If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is 
required during the installation process. Here the Servlet port should be same as the Web application 
Server port. 

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.2.0.0 and higher versions? 

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the 
way agentservers are managed through AGENTSTARTUP.SH and AGENTSHUTDOWN.SH. 

What should I do when the message server process does not open and I get the following error 
message, "CI18NProvider::CI18NProvider, Error, unable to connect to the config database"? 

This error is displayed due to the following reasons: 

• The Config Schema password is already expired. 

• If the Config Schema password is going to expire soon and the message like "ORA-28002: the 
password will expire within 6 days" displays while connecting to Config Schema through SQL 
Plus. 

• The Config Schema password is modified. 

To resolve the error, re-set the config schema password to the old password. Else, if  the config schema 
password is modified to something else then follow the below steps: 

1. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

2. Shutdown the OFSAAI App service: cd $FIC_APP_ HOME/common/FICServer/bin 
./stopofsaai.sh 

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/configuring_ofsaa_in_clustered_environment_guide.pdf
http://docs.oracle.com/cd/E61555_01/books/configuring_ofsaa_in_clustered_environment_guide.pdf
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3. Shutdown the OFSAAI App service: cd $FIC_APP_ HOME/common/FICServer/bin 
./stopofsaai.sh 

4. Start the Infrastructure Server in foreground directly on the server or through XWindows software 
using the command: ./startofsaai.sh 

5. Enter System Password. 

6. Enter the new Config schema password. The service starts and initializes if it is able to 
successfully connect to the DB and generates the Reveleus.SEC file. 

7. Post successful startup of the service, if required, the Infrastructure server may be shut down and 
restarted in the background using nohup mode. 

What is the mechanism of Log File sizing and backup? 

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & 

<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml. 

The default size of the log files (MaxFileSize) is set to 5000kb and number of maximum backup log files 
(MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing these parameters to a 
higher value should depend on the server hardware configurations and may reduce the performance. 

To configure the Logs file size on OFSAA Application server, follow these steps: 

1. Navigate to $FIC_HOME/conf where OFSAA is installed. 

2. Edit the following parameters in the file RevLog4jConfig.xml 

▪ param name="file" : Enter the path where the Logs are to be generated. 

▪ param name="MaxFileSize" : Provide the required file size. 

▪ param name="MaxBackupIndex" : Provide the required number of backup files to be created. 

Example: 

<appendername="REVSERVERAPPENDER" 

class="org.apache.log4j.RollingFileAppender"> 

<param name="file" value="$FIC_ 

HOME/ficapp/common/FICServer/logs/RevAppserver.log"/> 

<param name="Append" value="true" /> 

<param name="MaxFileSize" value="5000kb" /> 

<param name="MaxBackupIndex" value="5" /> 

<layout class="org.apache.log4j.PatternLayout"> 

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/> 

</layout> 

</appender> 

To configure the Deployed area logs file, follow these steps: 

1. Navigate to <EAR/WAR Deploy area>/conf folder. 

2. Repeat step 2 from the above section. 

Can we modify the Log file path? 

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xm_file.The default log file 
path (file) is set by the installer. This can be configured to another path. 

Can I point the environment with HTTP enabled to HTTPS after installation and vice versa? 
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For more details, see the HTTPS section in the OFSAAI Administration Guide. 

What should I do if the sliced data model upload takes a long time to complete? 

If the metadata cache size is set to a lower value than the actual count of each metadata type 
(hierarchy, dataset, dimension etc), then it gets into performance degrade issues. We have to increase 
the cache size for each metadata type according to the count in the environment. 

Following are the parameters in DynamicServices.xml to be configured depends on the metadata count 
in your environment. 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/> 

Metadata count can be derived based on the following queries: 

select count(1) from metadata_master where metadata_version=0 --- for all metadata 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=1  --- for 
measure 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=2  --- for 
Dimension 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=3  --- for HCY 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=4  --- for 
DATASET 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=59  --- for BP's 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=54   --- for Alias 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=5  --- for 
CUBES 

select count(1) from metadata_master where metadata_version=0 and metadata_ type=856 --- for 
Derived Entity 

For LDAP authentication, which server connects with the LDAP server, the Application server 
(where ofsaai is installed), or Web Application server (where EAR is deployed)? 

For LDAP authentication, the Application server (ficapp) connects with the LDAP server. 

The LDAP server in the setup listens on secure protocol ldaps ( port 636). I have the root 
certificate of the LDAP server for SSL, and would like to know where to offload this certificate? 

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer. 

How to relocate FTPSHARE folder? 

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports, Deployed Paths 
of the OFSAA Instance section in the OFSAAI Admin Guide available on OTN. 

How do we identify the list of ports that are used by/configured in an OFSAA environment? 

https://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Navigate to $FIC_HOME directory on Target. 

The file PortsDef.log will be available in the $FIC_ HOME directory. It will contain the ports information. 

What should I do if I get the following error message, "Error while fetching open cursor value 
Status : FAIL"? 

This error occurs while executing envCheck.sh because the user does not have access to 
V$parameter. This error does not occur due to sysdba or non sysdba privileges provided they have 

access/grants to V$parameter. 

What should I do when an entity containing many attributes (>100 columns) is selected as 
Source entity and the Data Mapping (T2T definition) save operation takes longer than expected 
with the hourglass in the UI continuously rotating? 

The workaround is: 

1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg file. 

2. Modify the following entries: 

• [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/ 

• [SQLIA]./ETLExtractionServlet to [ALL]./ETLExtractionServlet 

3. Save the changes and restart the webserver. 

4. Resave the definition. 

What should I do if I get the following error message when I try to start the OLAP server: 

./olapdataserver: error while loading shared libraries: 

libessapinu.so: 

cannot open shared object file: No such file or directory 

FATAL ERROR :- OLAP DATA SERVER start up failed. 

This error occurs when OLAP component is not configured and OLAP feature in OFSAA is not used. 
However, this error can be ignored. 

What should I do if I get the error "FATAL ERROR-Problem with OFSAA Service" during 
OFS_AAAI_PACK installation? 

Increase the sleep counter (default value is 80) to a higher value in the following section of the 
OFS_AAAI_PACK/OFSAAIUpdate.sh file: 

if [ $count -eq 0 ] ; then 

sleep 80; 

count=` grep -i "FICServer Initialization Complete" 

$FIC_HOME/ficapp/common/FICServer/bin/nohup.out|wc -l ` 

fi 

if [[ $count -gt 0 ]] ; then 

echo OFSAA Service - OK 

else 

echo FATAL ERROR-Problem with OFSAA Service 

exit 1 

fi 
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How do I upgrade to Oracle Database 12c Release 1 or 2, if my previous database versions are 
Release 11.2.0.2+, 12.1.0.1 or 12.1.0.2?  

If you are upgrading the Database Server from the previous versions to the current versions mentioned 
in the following table: 

 

Sl. No. Source Database Version Destination Database Version 

1 11.2.0.2+ or 12.1.0.1 12c Release 1 (12.1.0.2)    

2 11.2.0.3+, 12.1.0.1 or 12.1.0.2 12c Release 2 (12.2.0.1)  

 

Perform the instructions mentioned in the following MOS documents: 

• Doc ID 2412630.1  

• Doc ID 2075401.1 

28.1.2 Application Pack 8.0.8.0.0 FAQs 

What is an Application pack? 

An Application Pack is a suite of products. For more information, refer section About Oracle Financial 
Services Analytical Applications (OFSAA) Applications Pack. 

Can I get a standalone installer for OFSAAI 8.0? 

No. AAI is part of every application pack and installs automatically. 

Is my environment compatible with OFSAA 8.0.8.0.0 Application Pack? 

Environment Check utility performs the task. It is part of install and can also be run separately.  

Does OFSAA 8.0.8 Application pack UPGRADE’s automatically existing environments? 

No.  Refer Point 5.  OFSAA 8.0.8 application pack has to be installed in a new environment and 
subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0.8.  Please note we 
will have migration path only from the previously released version of OFSAA products. 

Where can I download OFSAA 8.0.8 Application Pack? 

You can download the OFSAAI 8.0.8 Application Pack from Oracle Software Delivery Cloud (OSDC). 

What are the minimum system and software requirements for OFSAA 8.0.8 Application Pack? 

Refer installation guide section Hardware and Software Requirements. 

Is my environment compatible with OFSAA 8.0.8 Application Pack?  

Environment Check utility performs the task.  It is part of install and can also be run separately. 

Does OFSAA 8.0.8 Application Pack is supports all Operating systems? 

LINUX. Refer to Technology Matrix for the technology matrix that OFSAA suite products are/ will be 
qualified on. 

How can I install OFSAA 8.0.8 Application Pack? 

Refer to I&C guide published in OTN for the application pack installers. 

Does this installation require any Third party Software’s?  

Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide 
published in OTN lists the third party software that needs to be installed. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2412630.1
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2075401.1
https://edelivery.oracle.com/EPD/Search/handle_go
https://edelivery.oracle.com/EPD/Search/handle_go
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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What languages are supported during OFSAA 8.0.8 Application Pack installation? 

US English is the language supported. 

What mode of installations OFSAA Application Pack supports? [i.e., Silent , GUI] 

OFSAA Application Packs supports Silent Mode. 

Does this Application Pack validate all Pre-requisites required for this installation i.e., Memory,  
Disk Space etc.? 

Yes. The pre-requisite checks are done by the respective application pack installer.   

What happens if it aborts during installation of any application with in Application pack? 

Customer needs to restore the system and retrigger the installation 

Does this Application pack ‘Rolls Back’ if any of application installation fails due to errors? 

Rollback of installation is not supported. 

Does the Application pack installs all applications bundled? 

All application pack system files are installed but there is an option to enable the licensed products. 

How can I re-install any of the Application Pack? 

You can retrigger in case of failure. 

Does Application pack allow enabling / disabling any of the applications installed?  

Yes.  You cannot disable once the product is enabled in an environment. 

I have installed one application in a Application pack and can I install any of new applications 
within the Application pack later point of time? 

No, installation is not required.  Enabling the application is an option to use it later. 

How many OFSAA Infrastructures can be installed in a single server? 

There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations 
and separate associated database instances and separate Web Server installations on the same server 
as long as adequate memory is allocated for each instance and as long as each OFSAAI installation is 
installed using a separate UNIX user and profile. Care should be taken if running multiple OFSAAI 
installations on a single server. Adequate memory will be required for each installation as several 
OFSAAI processes (model upload, DEFQ services, etc) take significant amounts of memory. So it 
depends on your server memory. 

Is it possible to Install OFSAA 8.0 Application pack on any one of the existing 'Infodom' where 
another OFSAA 8.0 application is installed? 

Yes. However, the Behavioral Detection Application Pack and Compliance Regulatory Reporting 
Application pack are the exceptions. They need to be installed in a different INFODOM. 

Is there any option in Application pack for the user to select Infodom during installations? 

Yes. You can select or change the required infodom.  

Can I install all Application Packs in a ‘Single Infodom’? 

Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack 
are the exceptions. They need to be installed in a different INFODOM. 

Is it possible to install applications on different Infodom within the Application pack?  

Applications within application pack have to be installed in the same information domain in the same 
environment. 

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0? 
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You can install only one infodom during installation. But after installation, you can create multiple 
infodoms. 

Is the ‘Data Model’ bundled is Application pack Specific or Specific to individual application? 

A merged data model for all applications within the application pack is bundled and uploaded. 

Is it possible to install OFS Enterprise Modeling later? 

OFS Enterprise Modeling is a separate product and can be enabled as an option later from any 
application pack that bundles Enterprise Modeling. 

Does OFS Enterprise Modeling is required for all applications? 

This product is enabled depending on the applications that use the features of OFS Enterprise 
Modeling. 

Will Application pack creates sandbox automatically for the required applications? 

Yes, Sandbox creation is part of application install process. 

Are upgrade Kits available for individual applications or the complete Application Pack? 

Maintenance Level (ML) Release / Minor Release upgrades are available across all applications. 

Do we have upgrade Kits for individual applications or it’s a Application Pack Upgrade? 

ML/ IR releases / upgrades will be across Packs.  

Can I upgrade AAI only? 

Yes, you can upgrade AAI alone. 

Can I upgrade one application within the Application Pack?  

No. Not possible Upgrade is applied across packs. 

Is it possible to uninstall any Application from the Application pack? 

No, it is not possible to uninstall any Application from the Application Pack. 

Can I uninstall entire Application Pack? 

No, you cannot uninstall the Application Pack. 

Is it possible to uninstall only application and retain AAI in the installed environment? 

No, you cannot uninstall only the application and retain AAI in the installed environment. 

Does Application Pack contain all Language Packs supported? 

Language Packs are installed on top of 8.0.8 application pack. Releases are planned post the 8.0 
availability. 

Can I install an Application Pack over another Application Pack (that is same infodom or 
different infodom) 

Yes, you can install an Application Pack over another Application Pack in the same information domain 
or different information domain. But Behavioural Detection Application Pack and Compliance Regulatory 
Reporting Application Pack, Asset Liability Management Application Pack and Profitability Application 
Pack are the exceptions. They need to be installed in a different INFODOM. 

Can I use an existing manually created schema as information domain for application pack 
installation? 

No. Schemas required by OFSAA applications have to be created using Schema Creator Utility. 

Does OFSAA 8.0.8 support on WebLogic 10.3.6 with Oracle 12c? 
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Yes, OFSAA 8.0.8 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 
12c with some additional configurations. Refer the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional 
configurations 

 “HostName in input xml is not matching with the local hostname”? 

 One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP 
Addresses of the machine are present in the /etc/hosts file. 

What are the Java versions supported in OFS AAAI Application Pack version 8.0.8.0.0? 

OFS AAAI Application Pack supports Java 1.7.x and 1.8.x. 

Is this release of the OFS AAAI Application Pack version 8.0.8.0.0 supported on Java 8? 

Yes. To install this release of the OFS AAAI Application Pack version 8.0.8.0.0 on Java 8. For more 
information, refer to specific notes mentioned in the sections Installer and Installation Prerequisites, 
Configurations supported for Java 8, Configuring the Schema Creator Utility, SILENT Mode Installation. 

What should be done if you encounter the following "FATAL" exception in the installation log 
because of insufficient DB process value? 

[FATAL] - =====Exception==== 

java.sql.SQLRecoverableException: IO Error: Got minus one from a read call 

                at 

oracle.jdbc.driver.T4CConnection.logon(T4CConnection.java:419) 

                at 

oracle.jdbc.driver.PhysicalConnection.<init>(PhysicalConnection.java:536) 

                at 

oracle.jdbc.driver.T4CConnection.<init>(T4CConnection.java:228) 

                at 

oracle.jdbc.driver.T4CDriverExtension.getConnection(T4CDriverExtension.java:

32) 

                at 

oracle.jdbc.driver.OracleDriver.connect(OracleDriver.java:521) 

Contact the DBA team to increase the DB process/sessions value accordingly, which depends on 
the   number of database process running at that particular point of time. 

Can I upgrade the Oracle Database version from 11g to 12C on which OFSAA 8.0.8.0.0 version is 
installed? 

Yes, you can upgrade. When the DB Server was Oracle 11g, the ojdbc jar used was ojdbc6.jar. But, 
when the DB is upgraded to 12c, you need to upgrade the ojdbc6.jar to ojdbc7.jar. 

Copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to the following locations: 

$FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

$FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

$FIC_HOME/ficdb/lib/ 

$FIC_HOME/ficapp/icc/lib/ 

$FIC_HOME/ficapp/common/FICServer/lib/ 

$FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

What should I do when I get "[ERROR] - Error : APP Setup bin file failed." message during 
OFS_Application_PACK installation? 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655
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This is a generic error message that appears during application installation failure. You should check 
the installation log files for more information about what failed the installation. 

However, if the message is displayed and the log files are not generated, it could be that it is a temp 
directory issue. The resolution is that your UNIX administrator has to disable the NOEXEC option. The 
installers extract the installation files into the /tmp directory, and if NOEXEC is enabled, execution of 
binaries will not happen in the directory and the installation fails. Re-run the installer after the 
configuration is changed. For detailed information, see the support note at 
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1. 

 

28.1.3 Forms Framework FAQs 

What should I do when I have large volume of data to be exported? 

It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data. 

How do I export the columns added to the grid by Field Chooser option? 

Perform Grid Export operation to export the columns added to the grid by Field Chooser option. 

Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should I 
do? 

Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more than 50 and if it is a 
non-custom hierarchy. Hierarchy with more than 50 nodes is considered as large hierarchy and the data 
will be fetched dynamically when you expand the parent node. 

What is the difference between the two Searches available in the Hierarchy Browser window? 

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 search options 
available as highlighted in the following figure: 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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• DB Search (Top search container): It will search the required node in database and displays the 
result as shown below. This search is performed on full hierarchy nodes. 

• UI search (Below the hierarchy): This search will find the required node in the UI and will show in 
tree structure.  

 

NOTE In case hierarchy nodes are more than 50 and if it is a non-

custom hierarchy, then the UI search will not show the required 

node in tree structure, until all the nodes are expanded and 

loaded manually in the UI. 

 

What is a Custom Hierarchy? 

Custom hierarchies will be having the parameter configuration customQuery as shown below and the 
customized query will be taken from the HIERARCHY_FILTER_MASTER table. 

Configuration in xml: 

<CONTROL ID="1003" TYPE="41"> 

<CONTROLPROPS> 

 <EXTRAPARAMETERS> 

<PARAMETER NAME="customQuery" VALUE="Yes"/> 

</EXTRAPARAMETERS> 
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</CONTROLPROPS> 

 </CONTROL> 

For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit. 

So, even if the hierarchy nodes are more than 50, the UI search will show the required node in tree 
structure and ExpandAll and ExpandBranch images will be enabled. 

28.2 Error Dictionary 

This contents of this section has been created with the interest to help you resolve the installation 
issues if any. There is a compilation of all the possible errors that might arise during the installation 
process with the possible cause and the resolution to quickly fix the issue and proceed further with the 
installation. 

This section includes the following topics: 

• Accessing Error Dictionary 

• Error Code Dictionary 

28.2.1 Accessing Error Dictionary 

Instead of scrolling through the document to find the error code, you can use the pdf search 
functionality. In the "Find" dialog available in any of the Adobe Acrobat version that you are using to 
view the pdf document, follow the below instructions to quickly find the error resolution. 

1. With the Installation pdf open, press Ctrl+F or select Edit > Find. 

2. The Find dialog is displayed as indicated. 

3. Enter the error code that is displayed on screen during Infrastructure installation. 

4. Press Enter. The search results are displayed and highlighted as indicated below. 

 

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to 
find an answer to any other errors that you notice during installation. If you are not able to resolve the 
issue even after following the steps provided in resolution, you can contact support.oracle.com along 
with log files and appropriate screen shots. 

28.2.2 Error Code Dictionary 

28.2.2.1 Error code - OFSAAI-1001 

 

Cause 
Unix shell is not "korn" shell. 
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Resolution 
Change the shell type to "korn". Use chsh unix command to change SHELL type. 

Shell type can also be changed by specifying shell path for the Unix user in 
/etc/passwd file. 

Note: chsh command is not available in Solaris OS.Cause 

 

28.2.2.2 Error code - OFSAAI-1002 

 

Cause 
No proper arguments are available. 

Resolution 
Provide proper arguments. Invoke Setup.sh using either SILENT or GUI mode. 

Example: ./Setup.sh SILENT or ./Setup.sh GUI 

 

28.2.2.3 Error code - OFSAAI-1004  

 

Cause 
File .profile is not present in $HOME. 

Resolution 
Create .profile in $HOME, i.e. in the home directory of user. 

 

28.2.2.4 Error code - OFSAAI-1005 

 

Cause 
File OFSAAInfrastructure.bin is not present in current folder. 

Resolution 
Copy OFSAAInfrastructure.bin into installation kit directory. 

 

28.2.2.5 Error code - OFSAAI-1006 

 

Cause 
File CustReg.DAT is not present in current folder. 

Resolution 
Copy CustReg.DAT into installation kit directory. 

 

28.2.2.6 Error code - OFSAAI-1007 

 

Cause 
File OFSAAI_InstallConfig.xml is not present in current folder. 

Resolution 
Copy OFSAAI_InstallConfig.xml into installation kit directory. 
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28.2.2.7 Error code - OFSAAI-1008 

 

Cause 
File validateXMLInputs.jar is not present in current folder. 

Resolution 
Copy validateXMLInputs.jar into installation kit directory. 

 

28.2.2.8 Error code - OFSAAI-1009 

 

Cause 
File log4j.xml is not present in current folder. 

Resolution 
Copy log4j.xml into installation kit directory. 

 

28.2.2.9 Error code - OFSAAI-1010 

 

Cause 
Unknown error occurred. 

Resolution 
Make sure to provide proper argument (SILENT or GUI) to the Setup.sh file. 

 

28.2.2.10 Error code - OFSAAI-1011 

 

Cause 
XML validation failed. 

Resolution 
Check InfrastructurePreValidations.Log for more details. 

 

28.2.2.11 Error code - OFSAAI-1012 

 

Cause 
Property file with locale name does not exist. 

Resolution 
Copy MyResources_en_US.properties to the setup kit directory and keep 

en_US in LOCALE tag of OFSAAI_InstallConfig.xml 

 

28.2.2.12 Error code - OFSAAI-1013 

 

Cause 
File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml not 

found. 
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Resolution 
Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml to 

the setup kit directory. 

 

28.2.2.13 Error code - OFSAAI-1014 

 

Cause 
XML node value is blank. 

Resolution 
Make sure all node values except SMTPSERVER, PROXYHOST, PROXYPORT, 
PROXYUSERNAME, PROXYPASSWORD, NONPROXYHOST, or RAC_URL are not 
blank. 

 

28.2.2.14 Error code - OFSAAI-1015 

 

Cause 
XML is not well formed. 

Resolution 
Execute the command dos2unix OFSAAI_InstallConfig.xml to convert plain text 

file from DOS/MAC format to UNIX format. 

OR 

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the file through 

Internet Explorer for a quick way to check validity. If it is not getting opened, create new 
OFSAAI_InstallConfig.xml using the XML_Utility.jar. 

 

28.2.2.15 Error code - OFSAAI-1016 

 

Cause 
User installation directory contain blank spaces. 

Resolution 
Provide an installation path that does not contain spaces. Check the tag 
USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path should not 

contain any spaces. 

 

28.2.2.16 Error code - OFSAAI-1017 

 

Cause 
User installation directory is invalid. 

Resolution 
Provide a valid installation path. Check if you are able to create the directory mentioned in 
USER_INSTALL_DIR tag value of OFSAAI_InstallConfig.xml file. 
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OFSAAI Support Contact Details 

• Contact Infrastructure support at https://flexsupp.oracle.com if you have installed ERM and FCCM 
applications. 

• Raise an SR in https://support.oracle.com if you have any queries related to ERM/EPM 
applications. 

 

https://flexsupp.oracle.com/
https://support.oracle.com/
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Send Us Your Comments 

Oracle welcomes your comments and suggestions on the quality and usefulness of this publication. 
Your input is an important part of the information used for revision. 

• Did you find any errors? 

• Is the information clearly presented? 

• Do you need more information? If so, where? 

• Are the examples correct? Do you need more examples? 

• What features did you like most about this manual? 

If you find any errors or have any other suggestions for improvement, indicate the title and part number 
of the documentation along with the chapter/section/page number (if available) and contact the Oracle 
Support. 

Before sending us your comments, you might like to ensure that you have the latest version of the 
document wherein any of your concerns have already been addressed. You can access My Oracle 
Support site which has all the revised/recently released documents. 
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